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TRMM 3B42 V.7 จากข้อมลูดาวเทียม Tropical Rainfall Measuring Mission (TRMM) กบัข้อมูล
ฝนภาคพืน้ดินจ านวน 78 สถานี ของกรมอตุนุิยมวิทยา พืน้ท่ีภาคเหนือของประเทศไทย ในปี พ.ศ. 
2553 และ พ.ศ. 2554 โดยใช้วิ ธีการทางสถิติ  ไ ด้แก่  Bias, Root Mean Square Difference 
(RMSD) , Mean Absolute Deviation (MAD) , Probability of Detection (POD) , False Alarm 
Rate (FAR) และ Critical Success Index (CSI) ซึ่งมุ่งเน้นท่ี Bias เป็นส าคัญ และได้ศึกษา            
การเปรียบเทียบวิธีการประมาณค่าเชิงพืน้ท่ีของ Bias ท่ีดีท่ีสุด โดยเลือกใช้ 3 วิธี ได้แก่ Kriging, 
Inverse Distance Weighted (IDW) และ Spline แบบ Regularized 

ผลการศึกษาพบว่าปริมาณฝนจากผลิตภัณฑ์น า้ฝนมีค่าสูงกว่าฝนภาคพืน้ดินเป็นส่วน
ใหญ่ ซึ่งจะแตกต่างกันตามปริมาณและความแรงของฝนท่ีเกิดขึน้ในแต่ละปี ในปีท่ีมีปริมาณฝน
มาก ฝนจากผลิตภณัฑ์น า้ฝนจะมีคา่สงูกว่าฝนภาคพืน้ดิน นอกจากนีพ้บว่าดาวเทียม TRMM ยงัมี           
ความบกพร่องในการตรวจวัดปริมาณฝนขณะท่ีฝนตกหนักในช่วงฤดูฝน และในส่วน                             
การเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีพบว่าวิธี Kriging เป็นวิธีท่ีดีท่ีสดุ โดยมีคา่เฉล่ีย -7.29 
และ 8.37 มิลลิเมตร ในปี พ.ศ. 2553 และ 2554 ตามล าดบั โดยจ านวนครัง้ท่ีสุม่เลือกจดุตรวจสอบ
มีผลตอ่การหาวิธีท่ีดีท่ีสดุในการประมาณคา่ความผนัแปรเชิงพืน้ท่ีด้วยเชน่กนั 
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ABSTRACT 
 

This study aimed to analyze the comparison of daily rainfall between TRMM 

3B42 V. 7 products from Tropical Rainfall Measuring Mission ( TRMM)  satellite data 

and ground- based rainfall over the 78 stations from Thai Meteorological Department 

over the Northern Thailand in year of 2010 and 2011.  A set of statistics has been used 

in this study are Bias, Root Mean Square Difference (RMSD), Mean Absolute Deviation 

(MAD), Probability of Detection (POD), False Alarm Rate (FAR) and Critical Success 

Index (CSI). Focusing on a significant bias. The study compared the spatial estimation 

of bias by the three best methods include Kriging, Inverse Distance Weighted (IDW) 

and Spline (Regularized).  

The study results indicated that the satellite- based rainfall mostly tends to 

overestimate the ground-based rainfall, which seem to vary according to the amount and 

intensity of rainfall in each year. In a wet year, the satellite-based rainfall is greater than 

the ground- based rainfall.  Moreover, it was found that TRMM may underestimate of 

heavy rainfall events during rainy season.  The comparison of spatial interpolation 

method showed that Kriging is the best method, with an average of -7.29 and 8.37 mm. 

in year of 2553 and 2554 respectively.  The number of random checkpoints are to find 

the best method to estimate the spatial variation as well. 
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บทที่  1 
 

บทน า 
 
1.1  ที่มาและความส าคัญ 

ปริมาณฝน เป็นข้อมูลทางอุตุนิยมวิทยาท่ีมีความส าคัญ โดยฝนเป็นปัจจัยส าคัญใน            
การด ารงชีวิตของมนษุย์ พืน้ท่ีใดจะอดุมสมบรูณ์และสามารถท าการเพาะปลกูได้ผลดีล้วนขึน้อยู่กบั
ปริมาณฝนท่ีพืน้ท่ีนัน้ได้รับ และข้อมลูปริมาณฝนยงัจ าเป็นตอ่การจดัการแหลง่น า้ การพยากรณ์น า้ 
และการป้องกันภัยพิบตัิ ปริมาณฝนก่อให้เกิดผลกระทบได้เช่นกันหากมีมากหรือน้อยเกินไป เช่น 
การเกิดน า้ท่วมหรือดินถล่มในกรณีท่ีมีปริมาณฝนมาก กลับกันในกรณีท่ีมีปริมาณฝนน้อยเป็น
สาเหตทุ าให้เกิดความแห้งแล้งและขาดแคลนน า้ได้ 

ประเทศไทยอยู่ในเขตร้อนชืน้ใกล้เส้นศูนย์สูตรและอยู่ภายใต้อิทธิพลของลมมรสุม 
ประมาณกลางเดือนพฤษภาคมถึงประมาณกลางเดือนตุลาคมจะเข้าสู่ฤดูฝน โดยในฤดูหนาว
บริเวณประเทศไทยตอนบนปกติจะมีฝนน้อยและแห้งแล้ง ปริมาณฝนจะเพิ่มขึน้บ้างเม่ือเข้าสู่            
ฤดรู้อน พร้อมทัง้มีพายุฝนฟ้าคะนอง และปริมาณฝนจะเพิ่มมากขึน้เม่ือเข้าสู่ฤดฝูน โดยในเดือน
สิงหาคมหรือกันยายนจะมีปริมาณฝนมากท่ีสุด (สุจริต คณูธนกุลวงศ์ และคณะ, 2550, หน้า 4) 
ส าหรับการตรวจวดัปริมาณฝนภาคพืน้ดินของกรมอุตนุิยมวิทยาในประเทศไทยเป็นการตรวจวัด
ความสูงของฝนท่ีตกลงบนพืน้ท่ีด้วยเคร่ืองมือวัดปริมาณน า้ฝน (Rain Gauge) มีหน่วยเป็น
มิลลิเมตร หรือนิว้ เป็นต้น ซึ่งข้อมลูท่ีวดัได้จะเป็นปริมาณฝนท่ีตกลงสูพื่น้ดินโดยตรง แตป่ริมาณฝน
ท่ีได้เป็นข้อมลูของบริเวณท่ีท าการตรวจวดัเท่านัน้ จะน าไปใช้ในบริเวณท่ีไกลออกไปจากสถานีวดั
น า้ฝนไมไ่ด้ (สญัชยั เอ่ียมประเสริฐ, 2554) และเน่ืองด้วยดาวเทียมมีคณุลกัษณะท่ีครอบคลมุพืน้ท่ี
ในบริเวณกว้าง การท่ีจะศกึษาพายฝุนและสภาพภูมิอากาศในเขตร้อน ท าให้เกิดความร่วมมือกัน
ร ะ ห ว่ า ง  National Aeronautics Space Administration (NASA)  แ ล ะ  Japan Aerospace 
Exploration Agency (JAXA) เป็นท่ีมาของ Tropical Rainfall Measuring Mission (TRMM) โดย
ข้อมลูฝนท่ีตรวจวดัดาวเทียมนัน้ ข้อดีคือ มีความครอบคลมุเชิงพืน้ท่ี วดัการกระจายตวัของฝนได้ 
แตมี่ข้อจ ากดัคือ เป็นคา่ประมาณการโดยท่ีไม่ทราบว่าเม่ือฝนได้ตกลงมาในพืน้หนึ่งๆ จะมีปริมาณ
เทา่ไหร่ จงึมีความถกูต้องคอ่นข้างน้อย ส าหรับข้อมลูฝนภาคพืน้ดิน สจุริต คณูธนกลุวงศ์ และคณะ 
(2550) ได้อธิบายว่าข้อดีคือ ให้ค่าท่ีมีความถูกต้องค่อนข้างสูง สามารถเก็บและวิเคราะห์ข้อมูล
ในชว่งเวลานานได้ แตมี่ข้อจ ากดัคือ จ าเป็นต้องสร้างโครงขา่ยเคร่ืองมือวดัปริมาณฝนให้มีความ
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หนาแนน่มากขึน้ในการวดัการกระจายตวัของฝน ซึง่มีคา่ใช้จา่ยสงูและท าได้ยากในบางพืน้ท่ี อาจมี
ความคลาดเคล่ือนจากการวดัด้วยปัจจยัหลายอย่าง และมีความลา่ช้าในการได้รับข้อมลู 

ภาคเหนือมีลักษณะภูมิประเทศส่วนใหญ่เป็นเทือกเขาสูง และมีต้นน า้สายหลักท่ีไหล
รวมกันเป็นแม่น า้เจ้าพระยา ซึ่งปริมาณฝนเป็นปัจจยัหนึ่งท่ีมีความส าคญัทัง้ด้านการเกษตร และ
ด้านปริมาณน า้ท่ีมีในลุม่น า้แตล่ะสายท่ีจะไหลไปหล่อเลีย้งชีวิตผู้คนตอ่ไป ข้อมลูการวดัปริมาณฝน
ในพืน้ท่ีแตล่ะวนัจะเป็นแนวทางในการวางแผนจดัการน า้ให้มีประสิทธิภาพมากขึน้ได้  แตเ่น่ืองด้วย
ภาคเหนือมีเทือกเขาเป็นจ านวนมาก ซึ่งเป็นข้อจ ากดัในการติดตัง้สถานีวดัน า้ฝน จึงน าผลิตภณัฑ์
น า้ฝนจากข้อมูลดาวเทียมมาใช้เพ่ือเพิ่มประสิทธิภาพในข้อจ ากัดนี ้และได้น าโปรแกรมทาง
สารสนเทศภูมิศาสตร์มาใช้ในประมาณค่าเชิงพืน้ท่ีเพ่ือหาวิธีท่ีดีท่ีสุด ซึ่งมีความส าคัญต่อ                  
การเลือกใช้วิธีตา่งๆ ในการประมาณคา่เชิงพืน้ท่ีส าหรับบริเวณท่ีไมมี่สถานีวดัน า้ฝน  

การศึกษาครัง้นีจ้ึงมีวตัถุประสงค์เพ่ือเปรียบเทียบปริมาณฝนรายวนัระหว่างผลิตภัณฑ์
น า้ฝน TRMM 3B42 V.7 ท่ีได้จากข้อมูลดาวเทียม TRMM กับข้อมูลฝนภาคพืน้ดินท่ีได้จากสถานี
วดัน า้ฝนของกรมอตุนุิยมวิทยา พืน้ท่ีภาคเหนือของประเทศไทย โดยใช้วิธีการทางสถิติเพ่ือให้ทราบ
ความแตกต่างของปริมาณฝน และหาวิธีการประมาณค่าเชิงพืน้ท่ีท่ีดีท่ีสุดในการประมาณค่า 
ความคลาดเคล่ือน (Bias) เพ่ือเป็นแนวทางในการตดัสินใจต่อการน าผลิตภัณฑ์น า้ฝนไปใช้ และ
เป็นแนวทางในการเลือกใช้วิธีการประมาณคา่เชิงพืน้ท่ี เพ่ือจะน าไปใช้วิเคราะห์ข้อมลูเชิงพืน้ท่ีให้มี
ความถกูต้องและมีประสิทธิภาพในงานด้านการเกษตรและชลประทาน เป็นต้น  
 
1.2  วัตถุประสงค์ของการวิจัย 

1)  เพ่ือศึกษาความแตกต่างของปริมาณฝนรายวันระหว่างผลิตภัณฑ์น า้ฝน TRMM 
3B42 V.7 จากข้อมลูดาวเทียมกบัข้อมลูฝนภาคพืน้ดนิด้วยวิธีการทางสถิต ิ

2)  เพ่ือเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีของคา่ความคลาดเคล่ือน(Bias) ท่ีดีท่ีสดุ  
 
1.3  ความส าคัญของการวิจัย 
 ข้อมูลฝนภาคพืน้ดินของกรมอุตุนิยมวิทยาให้ค่าท่ีมีความถูกต้องค่อนข้างสูง ซึ่ง
ภาคเหนือมีเทือกเขาจ านวนมากท าให้มีสถานีวดัน า้ฝนคอ่นข้างน้อย จงึน าผลิตภณัฑ์น า้ฝน TRMM 
3B42 V.7 ท่ีมีความครอบคลมุเชิงพืน้ท่ีมากกว่ามาใช้ เพ่ือเพิ่มประสิทธิภาพในข้อจ ากดันี ้โดยถ้ามี
การเปรียบเทียบปริมาณฝนรายวันระหว่างผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ท่ีได้จากข้อมูล
ดาวเทียม TRMM กบัปริมาณฝนท่ีวดัจากสถานีตรวจวดัภาคพืน้ดินของกรมอุตนุิยมวิทยา จะท าให้
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ได้ข้อมูลเพ่ือเป็นแนวทางในการประยุกต์ใช้ในด้านการจัดการแหล่งน า้ การพยากรณ์น า้ และ             
การปอ้งกนัภยัพิบตั ิเป็นต้น 

 
1.4  ขอบเขตของการวิจัย 

1.4.1  ขอบเขตด้านพืน้ท่ี  
พืน้ท่ีภาคเหนือประกอบด้วย 9 จงัหวดั ได้แก่ เชียงราย นา่น พะเยา เชียงใหม ่แมฮ่อ่งสอน 

แพร่ ล าปาง ล าพนู และอตุรดติถ์ มีพืน้ท่ีประมาณ 93,691 ตารางกิโลเมตร โดยร้อยละ 70 ของพืน้ท่ี
เป็นเทือกเขา มีความสูง 500-2,000 เมตร จากระดบัน า้ทะเล ประกอบไปด้วยป่าไม้ซึ่งเป็นแหล่ง 
ต้นน า้ล าธาร มีปริมาณฝนเฉล่ีย 1,230 มิลลิเมตร/ปี   
 

 
 

ภาพ 1.1 แผนที่ขอบเขตพืน้ท่ีศึกษา 
 

1.4.2  ขอบเขตด้านเนือ้หาและเวลา 
การศกึษาครัง้นีเ้ป็นการเปรียบเทียบปริมาณฝนรายวนัระหว่างผลิตภัณฑ์น า้ฝน TRMM 

3B42 V.7 จากข้อมูลดาวเทียม TRMM กับข้อมูลฝนภาคพืน้ดินของกรมอุตุนิยมวิทยา ในพืน้ท่ี
ศกึษา 9 จงัหวดัภาคเหนือของประเทศไทย ในช่วงระยะเวลา 2 ปี คือ พ.ศ. 2553 และ พ.ศ. 2554 
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ด้วยวิธีการทางสถิติจ านวน 6 สมการ ได้แก่ Bias, Root Mean Square Difference (RMSD), 
Mean Absolute Deviation (MAD) , Probability of Detection (POD) , False Alarm Rate (FAR) 
และ Critical Success Index (CSI) ส าหรับการศกึษาการเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ี
ของ Bias ท่ีดีท่ีสดุ มีจ านวน 3 วิธี ได้แก่ Kriging, IDW และ Spline แบบ Regularized 

 
1.5  ข้อตกลงเบือ้งต้น 
 การศึกษาครัง้นีใ้ช้ผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 จากข้อมูลดาวเทียม TRMM                  
ท่ีดาวน์โหลดทางเว็บไซต์ http://disc.sci.gsfc.nasa.gov/gesNews/trmm_v7_multisat_precip
เพ่ือเก็บรวบรวมข้อมลูปริมาณฝนรายวนั 
 
1.6  นิยามศัพท์เฉพาะ 

การประมาณค่าเชิงพืน้ที่  หมายถึง การประมาณคา่ในจุดหรือพืน้ท่ีอ่ืนๆ ท่ียงัไม่ทราบ 
โดยใช้ข้อมลูจากจดุท่ีทราบคา่  

ฝนภาคพืน้ดิน หมายถึง การตรวจวดัปริมาณฝนในต าแหน่งท่ีมีการติดตัง้เคร่ืองมือวดั
น า้ฝนภาคพืน้ดินของกรมอตุนุิยมวิทยา โดยแบง่ออกเป็น 2 ชนิด คือ 1) เคร่ืองมือวดัปริมาณน า้ฝน
แบบธรรมดาหรือแบบไม่บันทึก (Non-recording Rain Gauge) จะตรวจวัดในเวลาประมาณ 
07.00 น. ของแต่ละวนั โดยท าการเทปริมาณฝนจากถังทรงกระบอกเล็กใส่แก้วตวง ซึ่งมีขีดแสดง
ขนาดการวดัขีดละ 0.1 มิลลิเมตร โดยหนึ่งแก้วตวงวดัปริมาณฝนได้ 10 มิลลิเมตร 2) เคร่ืองมือวดั
ปริมาณน า้ฝนแบบบนัทกึ (Recording Rain Gauge) จะท าการบนัทกึลกัษณะการตกของฝนลงบน
กระดาษกราฟ ปัจจุบนักรมอุตุนิยมวิทยาประเทศไทยใช้การบนัทึกกราฟฝนแบบรายวัน (Daily 
Rainfall) ตัง้แตเ่วลา 07.00 น. ถึง 07.00 น. ของวนัถดัไป 

ปริมาณฝนรายวัน หมายถึง คา่ของฝนในชว่ง 24 ชัว่โมง หนว่ยท่ีใช้คือมิลลิเมตร 
ผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 หมายถึง ข้อมลูประเภทราสเตอร์ท่ีมีความละเอียด

ขนาด 0.25° x 0.25° ท่ีได้มาจากข้อมูลดาวเทียม TRMM ครอบคลุมพืน้ท่ี 50 องศาเหนือ ถึง 50 
องศาใต้ ให้ข้อมลูปริมาณฝนรายวนั หรือในชว่ง 24 ชัว่โมง 

Tropical Rainfall Measuring Mission (TRMM) หมายถึง ดาวเทียมท่ีพัฒนาขึน้เพ่ือ
ชว่ยให้เข้าใจการกระจายและการผนัแปรของฝนในเขตร้อน โดยครอบคลมุพืน้ท่ีเขตร้อนและกึ่งเขต
ร้อนทัง้หมดของโลก โดยดาวเทียม TRMM นีมี้วงโคจรไม่สมัพนัธ์กับดวงอาทิตย์ ท่ีระดบัความสงู 
403 กิโลเมตร จะโคจรทัง้หมด 16 รอบในหนึ่งวัน มีอุปกรณ์ติดตัง้ทัง้แบบ Passive Microwave 
และ Active Microwave 
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1.7  สมมตฐิานของการวิจัย  
1)  ผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 จากข้อมูลดาวเทียม TRMM มีแนวโน้มให้ค่า

ปริมาณฝนมากกวา่ข้อมลูฝนภาคพืน้ดนิของกรมอตุนุิยมวิทยา 
2)  การประมาณคา่เชิงพืน้ท่ีด้วยวิธี Kriging เป็นวิธีท่ีดีท่ีสดุ 

 
1.8  กรอบแนวคิดการวิจัย 

การศึกษาวิจัยเร่ือง การเปรียบเทียบปริมาณฝนรายวันระหว่างผลิตภัณฑ์น า้ฝนจาก
ข้อมูลดาวเทียมกับข้อมูลฝนภาคพืน้ดิน พืน้ท่ีภาคเหนือของประเทศไทย มีกรอบแนวคิดใน
การศกึษา ดงัภาพ 1.2 
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ภาพ 1.2 กรอบแนวคิดการวิจัย

ข้อมลูปริมาณฝนรายวนัภาคพืน้ดนิ 

ข้อมลูปริมาณฝนรายวนัภาคพืน้ดนิ          
ท่ีคดัเลือกแล้ว 

อภิปรายผลการศกึษา 

ข้อมลูปริมาณฝนรายวนัจาก                
ผลิตภณัฑ์น า้ฝน 

ตรวจสอบและคดัเลือกข้อมลู 

เปรียบเทียบด้วยวิธีการทางสถิต ิได้แก่ 
1. Bias      4. Probability of Detection (POD)                                                                               
2. Root Mean Square Difference (RMSD) 5. False Alarm Rate (FAR)                                                    
3. Mean Absolute Deviation (MAD)  6. Critical Success Index (CSI) 

ผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 

สกดัข้อมลู ณ ต าแหนง่พิกดั               
สถานีวดัน า้ฝน 

เปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ี           
ของ Bias ได้แก่  
1. Kriging                                                                         

2. Inverse Distance Weighted (IDW)                        
3. Spline แบบ Regularized 



 
 

 
 

บทที่  2 
 

เอกสารและงานวิจัยที่เกี่ยวข้อง 
 

การศึกษาเร่ือง การเปรียบเทียบปริมาณฝนรายวนัระหว่างผลิตภัณฑ์น า้ฝนจากข้อมูล
ดาวเทียมกบัข้อมลูฝนภาคพืน้ดนิ พืน้ท่ีภาคเหนือของประเทศไทย ผู้วิจยัได้ท าการรวบรวมหลกัการ 
แนวคดิ ทฤษฎี เอกสารและงานวิจยัท่ีเก่ียวข้อง โดยมีรายละเอียดของประเดน็ตา่งๆ ดงันี ้

2.1  ลกัษณะทางกายภาพของภาคเหนือ 
2.2  ลกัษณะฝนในประเทศไทย 
2.3  การตรวจวดัข้อมลูฝนด้วยเคร่ืองวดัน า้ฝนภาคพืน้ดนิ 
2.4  ดาวเทียม Tropical Rainfall Measuring Mission (TRMM) 
2.5  ดาวเทียม TRMM และผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 
2.6  การประมาณคา่ข้อมลูเชิงพืน้ท่ี 
2.7  เอกสารและงานวิจยัท่ีเก่ียวข้อง 

 
2.1  ลักษณะทางกายภาพของภาคเหนือ 
 2.1.1  ที่ตัง้และอาณาเขต 
 ทิศเหนือ อยู่ท่ีละติจดู 20 องศา 27 ลิปดาเหนือ มีพรมแดนติดกบัพม่าและลาว 
ดนิแดนท่ีอยูเ่หนือสดุของภาคเหนือคือ อ าเภอแมส่าย จงัหวดัเชียงราย 
 ทิศใต้ อยู่ท่ีละติจูด 17 องศา 10 ลิปดาเหนือ ติดกับจงัหวดัสุโขทยัและจงัหวดั
พิษณโุลก ดนิแดนท่ีอยูใ่ต้สดุของภาคเหนือคือ อ าเภอพิชยั จงัหวดัอตุรดติถ์ 
 ทิศตะวนัออก อยู่ท่ีลองจิจูด 101 องศา 20 ลิปดาตะวนัออก มีพรมแดนติดกับ
ลาว ดนิแดนท่ีอยูต่ะวนัออกสดุของภาคเหนือคือ อ าเภอบอ่เกลือ จงัหวดันา่น 
 ทิศตะวนัตก อยูท่ี่ลองจิจดู 97 องศา 22 ลิปดาตะวนัออก มีพรมแดนตดิกบัพม่า 
ดนิแดนท่ีอยูต่ะวนัตกสดุของภาคเหนือคือ อ าเภอแมส่ะเรียง จงัหวดัแมฮ่อ่งสอน 
 2.1.2  ลักษณะภูมิประเทศ 
  1)  เทือกเขา มีความสูงตัง้แต่ 500-2,000 เมตร จากระดับน า้ทะเล มีพืน้ท่ี
ประมาณร้อยละ 70 ของพืน้ท่ีทัง้หมด บนเทือกเขาจะเต็มไปด้วยป่าไม้ซึ่งเป็นแหล่งต้นน า้ล าธาร 
บางบริเวณใช้ในการปลกูพืชไร่หรือพืชผกัผลไม้เมืองหนาวได้ เทือกเขาท่ีส าคญัในภาคเหนือ คือ
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  -  เทือกเขาแดนลาว กัน้เขตแดนไทยกับพม่าด้านทิศเหนือ วางตวัในแนวเฉียง
จากเหนือไปทางทิศตะวนัตกเฉียงใต้  
  -  เทือกเขาหลวงพระบาง กัน้เขตแดนไทยกบัลาว วางตวัจากทิศเหนือไปทิศใต้ 
  -  เทือกเขาถนนธงชยั เป็นเทือกเขาท่ีใหญ่และยาวท่ีสุดของภาคเหนือ วางตวั
จากทิศเหนือลงไปทิศใต้     
  -  เทือกเขาขนุตาล ตัง้อยูท่างทิศตะวนัออกของเทือกเขาถนนธงชยั วางตวัอยูใ่น
แนวเหนือใต้   
  -  เทือกเขาผีปันน า้ตะวันตก วางตวัอยู่ในแนวเหนือใต้ ตัง้อยู่ทางทิศตะวนัออก
ของเทือกเขาขนุตาล    
  -  เทือกเขาผีปันน า้ตะวนัออก วางตวัในแนวเหนือใต้ ตัง้อยู่ระหว่างเทือกเขาผี
ปันน า้ตะวนัตกกบัเทือกเขาเพชรบรูณ์ หรืออยูร่ะหวา่งแมน่ า้ยมและแมน่ า้นา่น    
  -  เทือกเขาเพชรบูรณ์ เป็นเทือกเขาท่ีอยู่ทางตะวันออกสุดของภาคเหนือ                        
กัน้พรมแดนระหวา่งไทยกบัลาว 
  2)  ท่ีราบ มีประมาณร้อยละ 10 ของภาค โดยท่ีเป็นท่ีราบระหว่างเทือกเขา            
เกิดจากรอยเล่ือนของแผ่นดินแล้วทรุดตวัลงต ่าจนกลายเป็นท่ีราบหรือแอ่งแผ่นดินระหว่างภูเขา 
ส่วนท่ีราบท่ีอยู่ระหว่างเทือกเขาสงูจะเป็นท่ีราบแคบๆ ในหบุเขา ท่ีราบในภาคเหนือจะมีแม่น า้ไหล
ผ่านดินส่วนใหญ่จึงเป็นดินตะกอน ดินเหนียว และดินร่วน พืน้ท่ีเหล่านีจ้ะอยู่ตามแนวฝ่ังแม่น า้              
ท าให้ดินอุดมสมบูรณ์ เพราะน า้จะกัดเซาะพาโคลนตมจากไหล่เขามาทับถมกันกลายเป็นแหล่ง
เพาะปลูกท่ีส าคญัในภาคเหนือ ท่ีราบในภาคเหนืออยู่สูงกว่าระดบัน า้ทะเลประมาณ 300 เมตร 
(986 ฟตุ) ท่ีราบท่ีส าคญั คือ  
  -  ท่ีราบลุ่มแม่น า้ปิง อยู่ระหว่างเทือกเขาถนนธงชยักับเทือกเขาขุนตาล น า้จะ
พาดินตะกอนไหลเข้ามาทับถมกันตามสองฝ่ังของแม่น า้ ท าให้ดินมีความอุดมสมบูรณ์มาก                   
เป็นแหลง่เพาะปลกูท่ีส าคญัของภาคเหนือ   
  -  ท่ีราบลุ่มแม่น า้วงั อยู่ระหว่างเทือกเขาขุนตาลกับเทือกเขาผีปันน า้ตะวันตก 
จดัเป็นท่ีราบอดุมสมบรูณ์อีกแหง่หนึง่ของภาคเหนือ        
  -  ท่ีราบลุ่มแม่น า้ยม อยู่ระหว่างเทือกเขาผีปันน า้ตะวนัตกกบัเทือกเขาผีปันน า้
ตะวนัออก แมน่ า้ยมไหลผา่นหบุเขาท าให้เกิดท่ีราบดนิตะกอนสองฝ่ังแมน่ า้     
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  -  ท่ีราบลุม่แมน่ า้นา่น อยูร่ะหวา่งเทือกเขาผีปันน า้ตะวนัออกกบัเทือกเขาหลวง
พระบาง แม่น า้น่านไหลลงแมน่ า้ปิงท่ีจงัหวดันครสวรรค์ สองฝ่ังของแม่น า้น่านเกิดท่ีราบดินตะกอน
ขึน้จนกลายเป็นเขตเกษตรกรรมท่ีส าคญัอีกแหง่หนึง่ของภาคเหนือ  
  -  ท่ีราบลุม่แมน่ า้ยวม เป็นท่ีราบลุม่แมน่ า้แคบๆ     
  -  ท่ีราบลุม่แมน่ า้อิง แมน่ า้กก อยูท่างตอนเหนือสดุของภาคเหนือ 

  -  ท่ีราบลุม่แมน่ า้เมย อยูแ่นวพรมแดนระหวา่งพมา่และไทย   
  3)  แอง่ ท่ีส าคญัในภาคเหนือคือ 
  -  แอง่แมแ่จม่ เป็นท่ีราบต ่าขนาดใหญ่       
  -  แอง่แมต๋ื่น เป็นท่ีราบอยูท่างใต้ของเทือกเขาถนนธงชยั    
  -  แอ่งพะเยา หรือกว๊านพะเยา เป็นแหล่งเก็บน า้ธรรมชาติ และแหล่งเพาะพนัธุ์
ปลาน า้จืดท่ีส าคญัของภาคเหนือ 
  -  แอ่งแม่งดั มีเข่ือนเก็บน า้เพ่ือการเกษตรและผลิตกระแสไฟฟ้า คือเข่ือนแม่งดั
สมบรูณ์ชล 
  -  แอง่ล าปาง เป็นท่ีราบท่ียาวและกว้างท่ีสุดแหง่หนึง่ มีเข่ือนก่ิวลม เข่ือนแจ้ห่ม                   
เพ่ือเก็บน า้ไว้ใช้ในการเกษตรและผลิตกระแสไฟฟ้า 
 2.1.3  สภาพภูมิอากาศ 
  1)  ฤดกูาล 
  -  ฤดรู้อน เร่ิมประมาณกลางเดือนมีนาคมถึงกลางเดือนพฤษภาคม อากาศจะ
ร้อนจดัในเดือนเมษายน 
  -  ฤดฝูน เร่ิมประมาณกลางเดือนพฤษภาคมถึงกลางเดือนตลุาคม เป็นช่วงท่ี
ได้รับอิทธิพลของลมมรสมุตะวนัตกเฉียงใต้พดัผา่นหอบไอน า้เข้าไปท าให้เกิดฝนตก 
  -  ฤดูหนาว เร่ิมประมาณกลางเดือนตุลาคมถึงกลางเดือนมีนาคม เน่ืองจาก
ได้รับอิทธิพลของลมมรสมุตะวนัออกเฉียงเหนือ พดัเอาความหนาวเย็นมาจากมองโกลเลีย 
  2)  ปริมาณฝน 
  ปริมาณฝนเฉล่ีย 1,230 มิลลิเมตร/ปี โดยมีวนัท่ีฝนตกปีละประมาณ 110 วนั 
เขตท่ีมีฝนตกน้อยมีปริมาณฝนเฉล่ีย 800-1,000 มิลลิเมตร/ปี ส่วนเขตท่ีฝนตกชุกจะมีปริมาณฝน
สงูสดุถึง 2,000 มิลลิเมตร/ปี   
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  3)  อณุหภมูิ        
  แตกต่างกันมากระหว่างฤดูร้อนกับฤดูหนาว ในช่วงฤดูหนาวประมาณเดือน
พฤศจิกายนถึงกุมภาพันธ์ อุณหภูมิต ่ามีค่าเฉล่ียประมาณ 18-19 องศาเซลเซียส ส่วนในฤดูร้อน
อณุหภมูิโดยเฉล่ียประมาณ 31-36 องศาเซลเซียส 
  4)  ความชืน้สมัพทัธ์   
  มีปริมาณสงูเน่ืองจากพืน้ท่ีเป็นท่ีสูงและมีป่าไม้จ านวนมาก บางครัง้อาจสูงถึง
ร้อยละ 100 โดยในช่วงท่ีลมมรสุมตะวนัตกเฉียงใต้พดัผ่านจะมีความชืน้สูงท่ีสุดประมาณร้อยละ 
80 และตอนบา่ยของแตล่ะวนัความชืน้สมัพทัธ์จะเพิ่มสงูขึน้เพราะพืน้ดินมีความชืน้สงู ส่วนในช่วง
ฤดลูมมรสุมตะวนัออกเฉียงเหนือพดัผ่านมีความชืน้สมัพทัธ์ประมาณร้อยละ 40 โดยในตอนเช้า
ความชืน้สมัพทัธ์ค่อนข้างสงู แตใ่นตอนบ่ายจะลดลง เน่ืองจากแสงแดดท าให้ปริมาณไอน า้ท่ีมีอยู่
ระเหยไปและพืน้ดนิแห้ง (ภาคเหนือ, 2554) 
 
2.2  ลักษณะฝนในประเทศไทย 
 ประเทศไทยอยู่ในเขตร้อนชืน้ใกล้เส้นศนูย์สูตร และอยู่ภายใต้อิทธิพลของลมมรสุมดงั
ภาพ 2.1 ท าให้มีฝนตกชกุ ฤดฝูนยาวนาน และมีความอดุมสมบรูณ์ในเร่ืองน า้ อีกทัง้พายหุมนุเขต
ร้อนท่ีเคล่ือนเข้าสู่ประเทศไทยส่วนใหญ่อ่อนก าลังลงจนเป็นเพียงพายุดีเปรสชั่นท่ีก่อให้เกิดฝน
มากกว่าท่ีจะก่อให้เกิดความเสียหาย เน่ืองจากทางด้านเหนือติดกับประเทศใกล้เคียงท่ีมีภูเขา
ล้อมรอบ ประเทศไทยจะสิน้สุดฤดรู้อนและเข้าสู่ฤดฝูนประมาณกลางเดือนพฤษภาคมเป็นต้นไป
จนถึงประมาณกลางเดือนตลุาคมจึงถือว่าสิน้สุดฤดฝูนและเข้าสู่ฤดหูนาว ซึ่งช่วงดงักล่าวจะมีลม
มรสมุตะวนัตกเฉียงใต้พดัพาความชืน้มาปกคลมุประเทศไทย (วิทย์ วรคปุต์, 2542 อ้างอิงใน สจุริต 
คณูธนกลุวงศ์ และคณะ, 2550, หน้า 4)  
 ทัว่ประเทศไทยมีปริมาณฝนรวมตลอดปีเฉล่ียประมาณ 1,580 มิลลิเมตร ซึง่เปล่ียนแปลง
ไปตามลกัษณะภูมิประเทศในแต่ละพืน้ท่ีและฤดูกาลมีผลต่อความผันแปร โดยปกติในฤดูหนาว
บริเวณตอนบนของประเทศไทยจะแห้งแล้งและมีฝนน้อย ปริมาณฝนจะเพิ่มขึน้บ้างเมื่อเข้าสู่ฤดรู้อน 
พร้อมทัง้มีพายฟุ้าคะนอง และเม่ือเข้าสู่ฤดูฝนปริมาณฝนจะเพิ่มขึน้มาก โดยในเดือนสิงหาคมหรือ
กนัยายนจะมีปริมาณฝนมากท่ีสุด ภาคใต้เกือบตลอดปีมีฝนชุกยกเว้นฤดรู้อนพืน้ท่ีบริเวณภาคใต้
ฝ่ังตะวนัตก ซึ่งเป็นด้านรับลมมรสุมตะวนัตกเฉียงใต้ในช่วงฤดฝูนจะมีปริมาณฝนมากกว่าภาคใต้
ฝ่ังตะวันออก โดยในเดือนกันยายนมีปริมาณฝนมากท่ีสุด (กรมอุตุนิยมวิทยา, 2548 อ้างอิงใน 
สจุริต คณูธนกลุวงศ์ และคณะ, 2550, หน้า 4)    
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ภาพ 2.1 ร่องมรสุมและทางเดนิพายุจรที่พัดผ่านประเทศไทย 
ที่มา: กรมอตุนุิยมวิทยา, ม.ป.ป. อ้างอิงใน สจุริต คณูธนกลุวงศ์ และคณะ, 2550, หน้า 4 
 

2.3  การตรวจวัดข้อมูลฝนด้วยเคร่ืองวัดน า้ฝนภาคพืน้ดนิ 
 สจุริต คณูธนกลุวงศ์ และคณะ (2550, หน้า 6-7) ได้อธิบายว่าเคร่ืองวดัน า้ฝนภาคพืน้ดิน 
(Rain Gauge) เป็นเคร่ืองมือการตรวจวดัท่ีมีการใช้งานกันมานานท่ีสุด และเป็นวิธีการพืน้ฐานท่ี
เรียบง่ายท่ีสดุ โดยจะท าการบนัทกึคา่ปริมาณฝนท่ีตกลงมาในภาชนะตอ่หนึง่หน่วยเวลาโดยตรง 
 2.3.1  ลักษณะและประเภทของเคร่ืองตรวจวัดข้อมูลฝนภาคพืน้ดนิ 
 เคร่ืองมือวดัน า้ฝนภาคพืน้ดนินี ้แบง่ได้เป็น 2 ชนิด คือ 
 1)  เคร่ืองวดัน า้ฝนแบบไมบ่นัทกึข้อมลูตอ่เน่ือง (Non-recording Rain Gauge) 
มีลักษณะเป็นกระบอกตวงใช้วัดปริมาณฝนท่ีตกลงมาในแต่ละครัง้เท่านัน้ ไม่สามารถวัดข้อมูล
ปริมาณฝนอย่างต่อเน่ืองได้ ข้อมูลฝนท่ีได้จึงเป็นปริมาตรฝนท่ีตกลงในภาชนะต่อช่วงเวลาท่ีมี              
การเก็บข้อมลู เคร่ืองวดัน า้ฝนแบบไม่อตัโนมตัิท่ีนิยมใช้ได้แก่ เคร่ืองวดัน า้ฝนมาตรฐานขนาด 8 นิว้ 
(Standard 8-inch Rain Gauge) ดงัภาพ 2.2 



12 

 

 

 
 

ภาพ 2.2 เคร่ืองวัดน า้ฝนมาตรฐานขนาด 8 นิว้ 
ที่มา: สถาบนัสง่เสริมการสอนวิทยาศาสตร์และเทคโนโลยี, ม.ป.ป. 
 

2)  เคร่ืองวัดน า้ฝนแบบบันทึกข้อมูลต่อเน่ือง  (Recording Rain Gauge) 
สามารถบนัทึกปริมาณฝนตามเวลาได้อย่างต่อเน่ือง โดยจะบนัทึกค่าปริมาณฝนท่ีตกลงมาใน
ภาชนะตอ่หนว่ยเวลาท่ีก าหนด ตวัอยา่งของเคร่ืองวดัน า้ฝนแบบบนัทกึตอ่เน่ืองท่ีนิยมใช้ในงานอทุก
วิทยามี 3 ชนิด ได้แก่ เคร่ืองวดัน า้ฝนแบบถ้วยกระดก (Tipping Bucket Rain Gauge) ดงัภาพ 2.3, 
เคร่ืองวัดน า้ฝนแบบชั่งน า้หนัก (Weighting Bucket Rain Gauge) ดังภาพ 2.4 และภาพ 2.5 
เคร่ืองวดัน า้ฝนแบบลกูลอย (Float Type Rain Gauge)  
 

 
 

ภาพ 2.3 เคร่ืองวัดน า้ฝนแบบถ้วยกระดก 
ที่มา: Cliff Mass, 2016 
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ภาพ 2.4 เคร่ืองวัดน า้ฝนแบบช่ังน า้หนัก 
ที่มา: ศนูย์อตุนุิยมวิทยาภาคเหนือ, ม.ป.ป. 
 

 
 

ภาพ 2.5 เคร่ืองวัดน า้ฝนแบบลูกลอย 
 

 2.3.2  ข้อมูลฝนจากเคร่ืองตรวจวัดข้อมูลฝนภาคพืน้ดนิ 
 การวัดข้อมูลฝนด้วยเคร่ืองวัดน า้ฝนภาคพืน้ดิน (Rain Gauge) สามารถวัด
ปริมาณฝนท่ีตกลงในต าแหน่งท่ีมีการติดตัง้เคร่ืองมือตรวจวดัในหนว่ยความลึกของน า้ฝนตอ่หนว่ย
เวลา เชน่ มิลลิเมตรตอ่ชัว่โมง หรือนิว้ตอ่ชัว่โมง เป็นต้น ซึง่อาจมีความคลาดเคล่ือนได้บ้างเน่ืองจาก
ผลของลม อุปกรณ์ท่ีไม่สมบูรณ์ หรือต าแหน่งการติดตัง้มีการบดบงัโดยต้นไม้หรืออาคาร เป็นต้น 
โดยข้อมูลท่ีวดัได้เป็นปริมาณฝนท่ีตกลงสู่พืน้โดยตรงจึงมีความถูกต้องค่อนข้างสูง เม่ือเทียบกับ
เคร่ืองตรวจวัดกลุ่มอ่ืนๆ นอกจากนีข้้อมูลจากสถานีตรวจวัดแบบอัตโนมัติยังมีความถ่ีใน                     
การตรวจวดัและเก็บข้อมลูสงู เชน่ สามารถเก็บบนัทกึข้อมลูฝนสะสมทกุ 15 นาที เป็นต้น  
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 อยา่งไรก็ดีหากต้องการข้อมลูฝนเชิงพืน้ท่ีหรือการกระจายของฝนจ าเป็นต้องใช้
ข้อมูลฝนจากสถานีตรวจวัดหลายๆ สถานีมาท าการวิเคราะห์และหาค่าเฉล่ียเชิงพืน้ท่ี (Spatial 
Interpolation) เพ่ือคาดคะเนปริมาณฝนในบริเวณท่ีไม่ได้มีการติดตัง้เคร่ืองตรวจวัด หรืออาจใช้ 
การก าหนดพืน้ท่ีโดยวิธีธีเอสเสนโพลีกอน (Thiessen Polygon) และใช้ค่าฝนท่ีวัดได้จากสถานี
ตรวจวดัในพืน้ท่ีย่อยแทนปริมาณฝนทัง้หมดท่ีตกในพืน้ท่ีดงักล่าว ด้วยเหตนีุค้วามหนาแน่นของ
สถานีวัดน า้ฝนจึงเป็นสิ่งส าคัญ แต่ค่าใช้จ่ายในการติดตัง้เก็บข้อมูลและการบ ารุงรักษาสถานี
จ านวนมากเหล่านีอ้าจไม่คุ้มค่า โดยเฉพาะในพืน้ท่ีท่ีเข้าถึงได้โดยยากหรือในบริเวณมหาสมุทร 
เคร่ืองมือวัดน า้ฝนภาคพืน้ดินนีย้งัคงใช้งานกันอย่างแพร่หลายในปัจจุบนั  เพ่ือหาข้อมูลปริมาณ
น า้ฝนในพืน้ท่ีขนาดเล็ก หรือใช้เพ่ือการปรับแก้คา่น า้ฝนจากเคร่ืองมือวดัอ่ืนๆ 
 
2.4  ดาวเทียม Tropical Rainfall Measuring Mission (TRMM) 

ดาวเทียมอุตุนิยมวิทยาท่ีช่ือว่า The Tropical Rainfall Measuring Mission (TRMM) 
เป็นโครงการความร่วมมือกนัระหวา่ง National Aeronautics Space Administration (NASA) และ
Japan Aerospace Exploration Agency (JAXA) เร่ิมใช้งานเม่ือวนัท่ี 27 พฤศจิกายน พ.ศ. 2540 
(Islam, M.N. and H. Uyeda, 2007 อ้างอิงใน ศรินทร์ทิพย์ แทนธานี, 2557)  

TRMM เป็นดาวเทียมท่ีมีวงโคจรไม่สัมพันธ์กับดวงอาทิตย์ (Non-sun-synchronous 
Orbit) ท่ีระดบัความสงู 403 กิโลเมตร ระนาบวงโคจรเอียง (Inclined Orbit) ท ามมุ 35 องศากบัเส้น
ศนูย์สูตรดงัภาพ 2.6 ใช้เวลา 92.5 นาทีส าหรับการโคจรรอบโลก 1 รอบ โคจรทัง้หมด 16 รอบใน
หนึ่ ง วัน  (National Aeronautics and Space Administration, 2012 อ้ า ง อิ ง ใน  ศ รินท ร์ทิพ ย์                      
แทนธานี, 2557) 

ดาวเ ทียม TRMM ติดตั ง้อุปกรณ์ทั ง้ แบบ Passive Microwave และแบบ Active 
Microwave ดงัภาพ 2.7 ใช้ในการศึกษาพายุฝนและสภาพภูมิอากาศในเขตร้อน ทัง้นีอุ้ปกรณ์ท่ี
ส าคญัของ TRMM มีอยู ่5 ชนิดคือ  
 1)  เคร่ือง PR (Precipitation Radar) ท างานท่ีช่วงคล่ืน 13.81 GHz มีความละเอียด              
4.3 กิโลเมตร  
 2)  เคร่ือง VIRS (Visible/Infrared Scanner) ท างานท่ีช่วงคล่ืน 0.60-12 ไมโครเมตร 
ความละเอียด 2.0 กิโลเมตร  
 3)  เคร่ือง TMI (TRMM Microwave Imager) มี 5 Band width ท างานท่ีชว่ง 10-90 GHz 
ความละเอียด 5-45 กิโลเมตร  
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ภาพ 2.6 ดาวเทียม TRMM 
ที่มา: National Aeronautics and Space Administration อ้างอิงใน ศรินทร์ทิพย์ แทนธานี, 2557 
 

 4)  เคร่ือง CERLS (Clouds and the Earths Radiant Energy System) ท างานท่ีช่วง 
0.3-50 ไมโครเมตร ความละเอียด ~ 25 กิโลเมตร  
 5)   เค ร่ือง  LIS (Lightning Imaging Sensor)  ท า งาน ท่ีช่ ว ง  0.774 ไม โคร เมตร                         
ความละเอียด 4 กิโลเมตร 
 ส าหรับอปุกรณ์ตรวจวดัฝนท่ีส าคญัท่ีสุดของ TRMM คือ เคร่ือง PR เน่ืองจากมีคา่ความ
ละเอียดและความถ่ีของการตรวจวดัสงูสุด รองลงมาคือ เคร่ือง TMI และ เคร่ือง VIRS ตามล าดบั                         
(ศรินทร์ทิพย์ แทนธานี, 2557) 
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ภาพ 2.7 ลักษณะวงโคจรและอุปกรณ์ส ารวจของดาวเทียม TRMM 
ที่มา: National Aeronautics and Space Administration อ้างอิงใน ศรินทร์ทิพย์ แทนธานี, 2557 
 

2.5  ดาวเทียม TRMM และผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 
จุดประสงค์ของอัลกอริทึม 3B42 คือการผลิต TRMM ท่ีปรับแก้แล้ว การผสานรวม

อินฟราเรด (IR) ของหยาดน า้ฟ้า และ root-mean-square (RMS) ของการประมาณคา่หยาดน า้ฟ้า
ท่ีผิดพลาด อลักอริทึมประกอบด้วยสองขัน้ตอนโดยมีทัง้การผสานและการสอบเทียบ ซึ่งสุดท้าย
แล้วจะได้ตารางกริดท่ีมีความละเอียดเป็นรายวัน และมีความละเอียดเชิงพืน้ท่ี 0.25° x 0.25° 
ครอบคลุมตั ง้ แ ต่  50 องศา เห นื อ  ถึ ง  50 องศา ใ ต้  (National Aeronautics and Space 
Administration, 2013) ซึ่งดาวเทียม TRMM ได้มีการพฒันาอลักอริทึมอย่างตอ่เน่ืองหลายเวอร์ชัน่ 
โดยในส่วนของผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ประกอบด้วยเซนเซอร์ท่ีใช้ ได้แก่ Advanced 
Microwave Scanning Radiometer, Advanced Microwave Sounding Unit- A, Advanced 
Microwave Sounding Unit- B, TRMM Precipitation Radar, Special Sensor Microwave 
Imager/Sounder, TRMM Microwave Imager, Visible และ  Infrared Spin Scan Radiometer 
(GMS Series), Visible และ Infrared Spin Scan Radiometer (METEOSAT Series) ซึง่ผลิตภณัฑ์
น า้ฝนนีมี้ความละเอียดทางราบเป็น 0.25° x 0.25° ความละเอียดทางดิ่งคือ พืน้ผิว ช่วงเวลาใน            
การบนัทึกข้อมูลเป็นรายวัน ครอบคลุมช่วงเวลาตัง้แต่วันท่ี 31 ธันวาคม พ.ศ. 2540 ถึงปัจจุบนั 
พารามิเตอร์ คือ อัตราการเกิดหยาดน า้ฟ้า (National Aeronautics and Space Administration, 
2015)  
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2.6  การประมาณค่าข้อมูลเชิงพืน้ท่ี 
 2.6.1  นิยามและความหมาย 
  สุเพชร จิรขจรกุล (2552, หน้า 154); Childs (2004, p. 32) อ้างอิงใน สญัชยั 
เอ่ียมประเสริฐ (2554) ได้อธิบายว่าการประมาณค่าข้อมูลเชิงพืน้ท่ีแบบประมาณค่าในช่วง 
(Interpolation) เป็นการประยุกต์วิเคราะห์ข้อมูลเชิงพืน้ท่ีท่ีมีค่าเลขประจ าพิกัด ได้แก่  Digital 
Number, Pixel Value และ Z Value เป็นต้น การประมาณค่าในช่วงจึงเป็นการคาดการณ์ค่าจุด
ข้อมลูพืน้ผิวจากข้อมลูตอ่เน่ืองของจดุท่ีมีคา่แตกตา่งกนัในแต่ละจดุ โดยอาศยัจดุข้อมลูท่ีทราบค่า
และมีการใช้ทฤษฎีทางคณิตศาสตร์เพ่ือสร้างความถูกต้อง ในโปรแกรมทางสารสนเทศภูมิศาสตร์ 
แบบจ าลองพืน้ท่ีผิวจงึเกิดจากการประมาณคา่พืน้ท่ีผิวจริงชว่ยสร้างรายละเอียดของพืน้ผิว โดยการ
เก็บตวัอยา่งท่ีมีความแตกตา่งกนับนพืน้ผิวท่ีต้องการแล้วจงึค านวณเพ่ือแทรกคา่ ด้วยการประมาณ
คา่ในชว่งลงไประหวา่งจดุตวัอยา่งเหลา่นัน้ 
 2.6.2  วิธีการประมาณค่าข้อมูลเชิงพืน้ท่ี 
  1)  Kriging  เป็นการประมาณคา่ท่ีคาดการณ์จากระยะทางหรือทิศทางระหว่าง
จดุตวัอยา่งแตล่ะจดุ ท างานหลายขัน้ตอนโดยผสมผสานการส ารวจวิเคราะห์คา่ทางสถิตขิองข้อมลู 
การท าแบบจ าลองเซมิแวริโอแกรม เพ่ือหาคา่วาเรียนซ์ในการประมาณคา่ข้อมลูในต าแหน่งท่ีไม่มี
ข้อมลู โดยหาคา่ความสมัพนัธ์เชิงพืน้ท่ีเพ่ืออธิบายการเปล่ียนแปลงท่ีเกิดขึน้บนพืน้ผิว และยงัมีสว่น
เสริมในการสร้างแบบจ าลอง Variogram เพ่ือตรวจดคูวามแปรปรวนของพืน้ท่ีผิวได้ วิธี Kriging จะ
เลือกสมการทางคณิตศาสตร์ท่ีเหมาะสมกับจุดตวัอย่างจากการวิเคราะห์ค่าทางสถิติของข้อมูล             
(สเุพชร จิรขจรกลุ, 2552, หน้า 159 อ้างอิงใน สญัชยั เอ่ียมประเสริฐ, 2554)  
  2)  Inverse Distance Weighted (IDW) เป็นการประมาณค่าข้อมูลเชิงพืน้ท่ี 
โดยอาศยัหลกัท่ีวา่ต าแหนง่ใกล้เคียงกนัย่อมมีความสมัพนัธ์กนั การประมาณคา่ให้กบัต าแหนง่ท่ีไม่
ทราบคา่จากผลรวมเชิงเส้นของค่าท่ีทราบจากนัน้ถ่วงน า้หนกัจุด และถกูจ ากัดด้วยระยะทางจาก
จดุท่ีไม่ทราบค่าไปยงัจุดท่ีทราบค่าจุดต่อไป ซึ่งอยู่บนสมมติฐานท่ีว่าจุดท่ียงัไม่ทราบคา่นัน้ ควรมี
อิทธิพลจากจดุตวัอย่างท่ีอยู่ใกล้มากกว่าจดุตวัอย่างท่ีอยู่ไกล โดยระดบัของอิทธิพลแปรผกผนักับ
ระยะทางระหว่างจุดซึ่งเพิ่มขึน้ตามค่าก าลัง การเลือกค่ายกก าลัง (Power) จะส่งผลอย่างมี
นยัส าคญัตอ่การประมาณคา่ ส าหรับคา่ยกก าลงัมีคา่มากจดุล้อมรอบคา่ท่ีไม่ทราบคา่ (Neighbor) 
ต าแหน่งท่ีอยู่ใกล้ท่ีสดุจะมีอิทธิพลมาก ซึ่งการเลือกจ านวนจดุท่ีล้อมรอบมากจะส่งผลท าให้พืน้ผิว
มีความราบเรียบน้อยลง (Johnston et al., 2001, p. 117; Apaydin et al., 2004, p. 34; Chang, 
2002, p. 251; Childs, 2004, p. 34; สุเพชร จิรขจรกุล, 2552, p. 157 อ้างอิงใน สัญชัย เอ่ียม
ประเสริฐ, 2554) 



18 

 

 

  3)  Spline เป็นการประมาณค่าโดยใช้สมการทางคณิตศาสตร์ในการก าหนด
ความโค้งโดยรวมอยา่งน้อยท่ีสดุของพืน้ผิว จะได้พืน้ผิวท่ีมีความกลมกลืน และสว่นโค้งของพืน้ผิวท่ี
พาดผ่านจุดตัวอย่าง สามารถก าหนดจ านวนของจุดตัวอย่างท่ีน ามาเป็นข้อมูลเข้าได้จากจุด
ตวัอย่างทัง้หมดท่ีมี วิธี Spline มีสองประเภทย่อย คือ แบบพืน้ผิวปกติ (Regularized) และแบบ
พืน้ผิวตึงตวั (Tension) ซึ่งทัง้สองประเภทจะมีตวัแปรในเร่ืองน า้หนัก (weight) วิธีการค้นหาจุด
ตวัอย่างจะใช้ร่วมกัน และจ านวนของจุดตวัอย่าง (Number of points) ทัง้สองวิธีมีตวัแปรท่ีใช้ใน
การก าหนดจุดตัวอย่างท่ีใช้ในการค านวณการแทรกค่าให้กับแต่ละจุดเหมือนกัน หากก าหนด
จ านวนจดุตวัอย่างมากขึน้ จดุท่ีเพิ่มขึน้เหล่านัน้จะมีอิทธิพลตามระยะทางท่ีเปล่ียนไป และพืน้ผิวท่ี
ได้จะมีความกลมกลืนขึน้  
  -  Regularized spline ผลท่ีได้จะมีความกลมกลืน มีความแปรปรวนพืน้ผิว
แบบค่อยเป็นค่อยไป แต่ค่าของพืน้ผิวท่ีได้อาจผิดไปจากช่วงค่าจริงของจุดตัวอย่างบ้าง หาก
ก าหนดคา่น า้หนกัมากพืน้ผิวก็จะกลมกลืนมากขึน้ โดยคา่ท่ีใส่เข้าไปต้องมากกว่าหรือเท่ากับศูนย์ 
ตวัอยา่งของคา่นีอ้าจใช้ 0, 0.001, 0.01, 0.1 และ 0.5 
  -  Tension spline จะท าการปรับระดบัพืน้ผิวท่ีสร้างขึน้ให้มีลกัษณะตรง ราบ 
แต่ยงัคงสอดคล้องกับลกัษณะของแบบจ าลองปรากฏการณ์นัน้ พืน้ผิวท่ีได้จะไม่กลมกลืนกันนกั 
แตค่า่ท่ีได้จะใกล้เคียงกบัชว่งคา่จริงของจดุตวัอย่าง หากให้น า้หนกัมากจะให้พืน้ผิวท่ีมีความหยาบ
สงู โดยคา่ท่ีใส่เข้าไปต้องมากกว่าหรือเท่ากบัศนูย์เช่นกัน ตวัอย่างของคา่นีอ้าจใช้ 0, 1, 5 และ 10 
(ศนูย์ความรู้กลาง กรมชลประทาน, ม.ป.ป.) 
  
2.7  เอกสารและงานวิจัยท่ีเก่ียวข้อง  

 สัญชัย เอ่ียมประเสริฐ (2554) ได้ศึกษาเก่ียวกับการเปรียบเทียบวิธีการประมาณค่า
ปริมาณน า้ฝนรายวัน ด้วยระบบสารสนเทศภูมิศาสตร์บริเวณพืน้ท่ีราบลุ่มน า้เจ้าพระยา โดยใช้
วิธีการประมาณค่าจ านวน 5 วิธีหลกั ได้แก่ Inverse Distance Weight, Radial Basis Functions, 
Kriging, Co-Kriging และสมการถดถอยเชิงเส้นของข้อมลูเรดาร์ (RADAR) 34 วิธียอ่ย เพ่ือทดสอบ
ความถูกต้องจากสถานีวัดน า้ฝนตัวอย่าง โดยใช้สถิติค่าเฉล่ียความคลาดเคล่ือนสัมบูรณ์                   
(Mean Absolute Error; MAE) และความแปรปรวนทางเดยีว (One-way ANOVA) พบวา่วิธีสมการ
ถดถอยเชิงเส้นของข้อมลูเรดาร์ให้ MAE น้อยท่ีสดุ เทา่กบั 5.81 มิลลิเมตร และการทดสอบสถิติราย
คู่ F-test ด้วยวิธี LSD มี MAE น้อยกว่าวิธี อ่ืนๆ อย่างมีนัยส าคัญทางสถิติ (p < 0.1) วิธีการ
ประมาณคา่ท่ีใช้คา่สถิตเิพียงอย่างเดียวพบวา่วิธี Kriging มี MAE น้อยท่ีสดุเทา่กบั 8.35 มิลลิเมตร 
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แต่การทดสอบสถิติรายคู่ F-test ด้วยวิธี LSD พบว่า MAE แตกต่างอย่างไม่มีนัยส าคญัทางสถิติ           
(p > 0.1) แสดงให้เห็นว่าการประยุกต์ใช้ข้อมูลเรดาร์ในการประมาณค่าปริมาณน า้ฝนรายวัน
ส าหรับพืน้ท่ีราบ จงึเป็นวิธีการท่ีเหมาะสมท่ีสดุ 

 สถิตย์ จันทร์ทิพย์ (2558) ได้ศึกษาเก่ียวกับการประยุกต์ใช้ข้อมูลฝนตรวจวัดด้วย
ดาวเทียมกับระบบปฏิบตัิการ เพ่ือการคาดการณ์น า้ท่วมในลุ่มน า้ชีและลุ่มน า้มูล โดยได้ศึกษา
ความเป็นไปได้ในการน าข้อมูลฝนตรวจวัดด้วยดาวเทียมมาประยุกต์ใช้ เพ่ือเพิ่มประสิทธิภาพ            
การท างานของระบบพยากรณ์น า้ท่วมในลุ่มน า้ลุ่มน า้ชี-มูล ให้มีความถูกต้องแม่นย ามากขึน้ ซึ่ง
พบว่าสามารถประยุกต์ใช้ข้อมูลฝนตรวจวัดด้วยดาวเทียม TRMM 3B42RT และ GSMaP                 
ความละเอียดขนาด 0.25° x 0.25° กับระบบพยากรณ์น า้ท่วมได้ โดย TRMM ให้ค่าปริมาณฝน
มากกวา่ GSMaP และข้อมลูฝนตรวจวดัด้วยดาวเทียมทัง้ 2 ชดุมีแนวโน้มให้คา่ปริมาณฝนมากกว่า
คา่ปริมาณฝนตรวจวดัจริงจากสถานีภาคพืน้ดิน ดงันัน้การน าข้อมลูไปใช้จงึต้องมีความระมดัระวงั
ในการปรับแก้คา่ฝนตรวจวดัด้วยดาวเทียม 

 Chokngamwong and Chiu (2008) ได้ศึกษาเก่ียวกับปริมาณฝนรายวันของประเทศ
ไทย และเปรียบเทียบด้วยผลิตภณัฑ์ TRMM เพ่ือศกึษาปริมาณฝนและตรวจสอบลกัษณะเชิงพืน้ท่ี
และเชิงเวลาของปริมาณฝนในประเทศไทย ซึ่งได้เปรียบเทียบกระบวนการของ TRMM V.5 และ 
V.6 กับข้อมูลมาตรวัดปริมาณฝนในประเทศไทย ผลการศึกษาพบว่าข้อมูลมาตรวัดปริมาณฝน
แสดงให้เห็นสองฤดกูาลท่ีแตกตา่งกนัคือ ในฤดฝูนจะเร่ิมต้นในเดือนพฤษภาคมแล้วฝนเคล่ือนตวั
จากตะวนัออกเฉียงใต้ไปตะวนัตกเฉียงเหนือ ปริมาณฝนสงูสดุเกิดขึน้ในเดือนสิงหาคมในภาคเหนือ
และภาคตะวนัออกเฉียงเหนือ เดือนกนัยายนในภาคกลางและตะวนัออก และเดือนพฤศจิกายนใน
ภาคใต้ ส่วนการเปรียบเทียบปริมาณฝนจาก TRMM V.5 และ V.6  กับข้อมูลมาตรวดัปริมาณฝน 
พบว่าฮิสโตแกรมของ V.6 มีคา่ใกล้เคียงกบัข้อมลูมาตรวดัปริมาณฝนในประเทศไทยมากกว่า V.5 
ในแง่ของสดัส่วนฝนและอตัราฝนตามเง่ือนไข ยงัพบอีกว่าผลิตภัณฑ์น า้ฝนจากดาวเทียมทัง้สอง
เวอร์ชัน่มีความบกพร่องในการตรวจวดัขณะฝนตกหนกั 

 Promasakha na Sakolnakhon (2013) ได้ศึกษาเก่ียวกับการเปรียบเทียบฝนจาก
ดาวเทียม GSMaP กับข้อมูลปริมาณฝนภาคพืน้ดิน บริเวณประเทศไทย โดยศึกษาสถิติ ท่ีใช้ใน           
การประเมินผลของปริมาณฝนจากดาวเทียมทั่วประเทศไทยในช่วงปี 2000-2010 จากข้อมูล
ดาวเทียม GSMaP_MVK (TRMM / TMI, Aqua / AMSR-E, ADEOS-II / AMSR, DMSP / SSMI) 
และปริมาณฝนท่ีได้จากสถานีอุตุนิยมวิทยาในประเทศไทย ผลการศึกษาพบว่าการประเมิน            
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ความถูกต้องนัน้ GSMaP_MVK ท างานได้ดีขึน้ในทุกฤดูกาลซึ่งอยู่ภายใต้การสังเกตรูปแบบ
ปริมาณฝนท่ีมีปริมาณฝนเล็กน้อย จึงแสดงให้เห็นว่าการตรวจสอบสถิติท่ีชีไ้ปท่ี POD (Probability 
Of Detection) และ TS (Threat Score) พบว่าการประเมินปริมาณฝนรายวนัจาก GSMaP_MVK 
มีประสิทธิภาพอยา่งสมบรูณ์ในฤดฝูน และยงัคอ่นข้างด้อยในชว่งฤดรู้อน ต้องค านงึถึงปริมาณฝนท่ี
จะค านวณในการตรวจสอบ ดงันัน้กระบวนการของ GSMaP_MVK ถือว่ามีประสิทธิภาพดีในการ
ประมาณการปริมาณฝนในพืน้ท่ี 

 Shukla et al. (2014) ได้ศึกษาเก่ียวกับการประมาณค่าและตรวจสอบการกระจายของ
ปริมาณฝนรายเดือนจากฐานข้อมูลดาวเทียม บริเวณลุ่มน า้คงคาตอนบน เพ่ือประเมินความ
น่าเช่ือถือของ Tropical Rainfall Measuring Mission (TRMM) 3B43 V.7 และวิเคราะห์ข้อมูล
ปริมาณฝนรายเดือนท่ีได้รับจาก TRMM 3B43 V.7 ผลการศกึษาพบว่าเม่ือเปรียบเทียบปริมาณฝน
รายเดือนระหว่าง TRMM กับข้อมูลท่ีวัดได้จากสถานีมีความสัมพันธ์กัน โดย Correlation 
Coefficient (r) เทา่กบั 0.99 Average Percentage Error (Avg.%Error) สงูสดุเทา่กบัร้อยละ 6.16 
แสดงให้เห็นถึงความสอดคล้องโดยรวมท่ีดีมาก 

 Veerakachen et al. (2014) ได้ศกึษาเก่ียวกับการประเมินประสิทธิภาพการท างานของ
ดาวเทียม GSMaP บริเวณลุ่มแม่น า้เจ้าพระยา ประเทศไทย เพ่ือประเมินประสิทธิภาพการท างาน
ในแง่ของการตรวจสอบปริมาณฝน โดยประมาณคา่ตาม Root Mean Square Error (RMSE) ของ 
GSMaP_NRT และ GSMaP_MVK ผลการศกึษาพบว่าปริมาณฝนรายวนัทัง้ GSMaP_NRT (Near 
Real Time) และ GSMaP_MVK (Moving Vector with Kalman filter) ท างานได้ดีในฤดูฝน โดย
ประสิทธิภาพการท างานของ GSMaP_NRT ถือว่าดีแต่ไม่เพียงพอส าหรับใช้งานในการตรวจสอบ
ปริมาณฝนใกล้ระยะเวลาจริง ขณะท่ี GSMaP_MVK เหมาะส าหรับศึกษาการเปล่ียนแปลง
ภมูิอากาศ



 
 

 

บทที่  3 
 

วิธีด าเนินการวิจัย 
 

งานวิจัยนีเ้ป็นการศึกษาการเปรียบเทียบปริมาณฝนรายวันระหว่างผลิตภัณฑ์น า้ฝน 
TRMM 3B42 V.7 จากข้อมูลดาวเทียม TRMM กับข้อมูลฝนภาคพืน้ดินของกรมอุตุนิยมวิทยา               
ในพืน้ท่ี 9 จงัหวดัภาคเหนือ ได้แก่ เชียงราย เชียงใหม่ นา่น พะเยา แพร่ แมฮ่อ่งสอน ล าปาง ล าพนู 
และอตุรดิตถ์ เพ่ือให้บรรลตุามวตัปุระสงค์ได้ก าหนดวิธีด าเนินการวิจยั โดยมีรายละเอียดแบง่เป็น 
4 สว่น ดงันี ้

3.1  เคร่ืองมือท่ีใช้ในการวิจยั    
3.2  ข้อมลูและแหลง่ข้อมลู 
3.3  การเก็บรวบรวมข้อมลู 
3.4  การวิเคราะห์ข้อมลู  

 
3.1  เคร่ืองมือที่ใช้ในการวิจัย    
 1)  คอมพิวเตอร์สว่นบคุคล Intel(R) Core(TM) i7-6500U CPU @ 2.50GHz RAM 4 GB 
 2)  โปรแกรมทางสารสนเทศภมูิศาสตร์ 
 3)  โปรแกรม Spreadsheet 
 
3.2  ข้อมูลและแหล่งข้อมูล 
 
ตาราง 3.1 ข้อมูลและแหล่งข้อมูลท่ีใช้ในการวิจัย 
 

ล าดบั ข้อมลู แหลง่ข้อมลู ชว่งปี พ.ศ. รายละเอียด 
1 
 
 

2 

ฝ น ร า ย วั น
ภาคพืน้ดนิ 
 
พิกดัสถานีวดั
น า้ฝน 

ศู น ย์ อุ ตุ นิ ย ม วิ ท ย า
ภาคเหนือ 
 
กรมอตุนุิยมวิทยา 

2553-2554 
 
 
- 

จั ง ห วั ด  ช่ ว ง เ ว ล า                     
ช่ือสถานี รหัสสถานี และ
ปริมาณฝนรายวนั 
จงัหวดั ช่ือสถานี รหสัสถานี 
และพิกัดทางภูมิศาสตร์ 
(ละตจิดู ลองจิจดู) 
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ตาราง 3.1 (ต่อ) 
 

ล าดบั ข้อมลู แหลง่ข้อมลู ชว่งปี พ.ศ. รายละเอียด 
3 ผ ลิ ต ภั ณ ฑ์

น า้ฝน TRMM 
3B42 V.7 

http: / /disc.sci.gsfc.na 
sa.gov/gesNews/ trmm 
_v7_multisat_precip 

2553-2554 ค ว า ม ล ะ เ อี ย ด ข น า ด 
0.25°x0.25° และปริมาณ
ฝนรายวนั 

 
3.3  การเก็บรวบรวมข้อมูล 
 ผู้วิจยัได้ท าการเก็บรวบรวมข้อมูลท่ีใช้ในการศึกษา ได้แก่ ข้อมูลฝนรายวันภาคพืน้ดิน 
พิกดัสถานีวดัน า้ฝน และผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 
 3.3.1  ฝนรายวันภาคพืน้ดนิ 
 1)  รวบรวมข้อมลูฝนรายวนัภาคพืน้ดนิของกรมอตุนุิยมวิทยา ในพืน้ท่ี 9 จงัหวดั 
ภาคเหนือ โดยใช้ช่วงระยะเวลา 2 ปี คือ พ.ศ. 2553 และ พ.ศ. 2554 ซึ่งข้อมูลจะประกอบด้วย 
จงัหวดั ชว่งเวลา ช่ือสถานี รหสัสถานี และปริมาณฝนรายวนั 
 2)  ตรวจสอบข้อมลูปริมาณฝนรายวนัภาคพืน้ดิน โดยสถานีวดัน า้ฝนท่ีมีข้อมลู
ตรวจวดัไมค่รบทัง้ 2 ปี หรือ 730 วนั จะไมน่ ามาใช้ 
 3)  คดัเลือกข้อมลูท่ีจะใช้ในการศกึษา โดยพล็อตกราฟปริมาณฝนสะสมรายปี
ของแต่ละสถานีจากปริมาณฝนรายวันภาคพืน้ดินท่ีตรวจสอบข้อมูลแล้ว ซึ่งท าทัง้ 2 ปี จากนัน้
พิจารณาเพ่ือตัดสถานีวัดน า้ฝนท่ีมีความผิดปกติออกจากการวิเคราะห์ โดยถ้าในปีใดปีหนึ่งมี 
ความผิดปกตจิะตดัสถานีวดัน า้ฝนนัน้ออกทัง้ 2 ปี ซึง่ใช้เกณฑ์ ดงันี ้ 
 -  เดือนพฤษภาคมยงัไม่มีปริมาณฝน โดยกรมอตุนุิยมวิทยา (ม.ป.ป.) อธิบาย
ว่าประมาณกลางเดือนพฤษภาคม มรสมุตะวนัตกเฉียงใต้ท่ีพดัปกคลมุและร่องความกดอากาศต ่า
ท่ีพาดผ่านประเทศไทยจะท าให้มีฝนชกุทัว่ไป ฤดฝูนจึงเร่ิมต้นในช่วงนี ้ดงันัน้เดือนพฤษภาคมควร
จะมีปริมาณฝน 
 -  ปริมาณฝนสะสมจนถึงเดือนธันวาคม แตกต่างจากสถานีวัดน า้ฝนท่ีอยู่
ใกล้เคียงประมาณ 400 มิลลิเมตร ขึน้ไป ซึ่งการพิจารณาสถานีวดัน า้ฝนท่ีอยู่ใกล้เคียงจะท าโดย 
Buffer เป็นระยะ 20 กิโลเมตร ด้วยโปรแกรมทางสารสนเทศภูมิศาสตร์ จากนัน้ดวู่าสถานีวดัน า้ฝน
อะไรบ้างท่ีอยูใ่นระยะ 20 กิโลเมตร จากสถานีวดัน า้ฝนท่ีมีความผิดปกต ิ   
 -  ปริมาณฝนสะสมจนถึงเดือนธันวาคมต ่ากว่า 500 มิลลิเมตร หรือมากกว่า
2,500 มิลลิเมตร ซึ่งปริมาณฝนท่ีก าหนดจะท าโดยดูภาพรวมของฝนในแต่ละปี และพิจารณา
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ร่วมกบัสถานีวดัน า้ฝนท่ีอยู่ใกล้เคียง กรมอตุนุิยมวิทยา (ม.ป.ป.) ได้อธิบายว่าพืน้ท่ีท่ีมีปริมาณฝน
ต ่าสว่นใหญ่อยู่ด้านหลงัเขา ได้แก่ พืน้ท่ีบริเวณตอนกลางของภาคเหนือ บริเวณล าพนู ล าปาง แพร่ 
เป็นต้น 
 4)  จดัข้อมูลปริมาณฝนรายวนัภาคพืน้ดินท่ีใช้ในการศึกษาให้อยู่ในรูปแบบท่ี
เหมาะสม เพ่ือน าไปใช้ในการวิเคราะห์ข้อมลูตอ่ไป 
 3.3.2  พกัิดสถานีวัดน า้ฝน  
 1)  รวบรวมข้อมลูพิกดัสถานีวดัน า้ฝนของกรมอตุนุิยมวิทยา ในพืน้ท่ี 9 จงัหวดั 
ภาคเหนือ โดยแต่ละสถานีวัดน า้ฝนจะประกอบด้วย จังหวัด ช่ือสถานี รหัสสถานี และพิกัดทาง
ภมูิศาสตร์ ซึง่เป็นแบบละตจิดู (Latitude) และลองจิจดู (Longitude) 
 2)  เลือกสถานีวัดน า้ฝนท่ีจะใช้ในการศึกษา ซึ่งได้คัดเลือกแล้วจากข้อมูล
ปริมาณฝนรายวันภาคพืน้ดิน จากนัน้จัดรูปแบบข้อมูลพิกัดสถานีวัดน า้ฝน โดยน าละติจูดและ
ลองจิจดูท่ีอยูใ่นรูปแบบองศา ลิปดา พิลิปดา แปลงให้อยูใ่นรูปแบบองศาทศนิยม  
 3)  น าเข้าสู่โปรแกรมทางสารสนเทศภูมิศาสตร์ เพ่ือน าต าแหน่งพิกัดสถานีวดั
น า้ฝนไปสกัดข้อมูลปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ต่อไป โดยไปท่ี             
File > Add Data > Add XY Data > เลือกไฟล์พิกัดสถานีวดัน า้ฝน จากนัน้ตรง X Field: เลือกให้
เป็นลองจิจดู และ Y Field: เลือกให้เป็นละติจูด และคลิก Edit ปรับแก้ระบบพิกัด ซึ่งในงานวิจยันี ้
จะใช้ระบบพิกัดแบบภูมิศาสตร์ (Geographic Coordinate Systems) โดยเลือก  Geographic 
Coordinate Systems > World > WGS 1984 > OK เม่ือเสร็จแล้วจะปรากฏดงัภาพ 3.1 ซึ่งข้อมลู
ท่ีน าเข้าจะเป็นแบบจดุ และมีหนว่ยเป็นองศา 
 3.3.3  ผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 
 1)  ดาวน์โหลดผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ท่ีมีความละเอียดขนาด 
0.25° x 0.25° ซึ่งได้มาจากข้อมูลดาวเทียม TRMM ทางเว็บไซต์ท่ีให้บริการโดย Goddard Earth 
Sciences Data and Information Services Center (GES DISC) ของ National Aeronautics and 
Space Administration (NASA)  โดยไป ท่ี  http: / /disc.sci.gsfc.nasa.gov/gesNews/ trmm_ 
v7_multisat_precip 

 2)  เลือกลิงค์ http://mirador.gsfc.nasa.gov/cgi-bin/mirador/presentNavi 
gation.pl?tree=project&dataset=TRMM_3B42_daily. 007&project=TRMM&dataGroup= 
Gridded&version=007 โดยผู้ วิจัยต้องการดาวน์โหลดผลิตภัณฑ์น า้ฝนท่ีจัดเรียงไว้ในรูปแบบ
ปฏิทินดังภาพ 3.2 ในช่วงระยะเวลา 2 ปี คือ พ.ศ. 2553 (2010) และ พ.ศ. 2554 (2011) ซึ่ง
ผลิตภณัฑ์น า้ฝนนีเ้ป็นไฟล์นามสกลุ NetCDF (Network Common Data Form) หรือ .nc 
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ภาพ 3.1 การน าพกัิดสถานีวัดน า้ฝนเข้าสู่โปรแกรมทางสารสนเทศภูมิศาสตร์ 
 

 
 
ภาพ 3.2 การดาวน์โหลดผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ที่จัดเรียงไว้ในรูปแบบปฏิทนิ 



25 
 

 

 3)  แปลงผลิตภณัฑ์น า้ฝนท่ีเป็นไฟล์นามสกลุ .nc ให้เป็น .tif ด้วยโปรแกรมทาง
สารสนเทศภูมิศาสตร์ทัง้ 2 ปี โดยใช้ Model Builder ดังภาพ 3.3 เพ่ือช่วยลดระยะเวลาใน                   
การท างาน ซึ่ง Iterate เป็นค าสัง่วนซ า้ ส่วน Multidimention > Make NetCDF Raster Layer เป็น
การน าเข้าผลิตภณัฑ์น า้ฝนท่ีเป็นไฟล์นามสกลุ .nc ดงัภาพ 3.4 และ Data Management Tools > 
Raster > Raster Dataset > Copy Raster เป็นการคัดลอกข้อมูลไฟล์ท่ีน าเข้าเพ่ือแปลงเป็น
นามสกลุ .tif  
 4)  สกดัข้อมลูปริมาณฝนรายวนัจากผลิตภณัฑ์น า้ฝนท่ีแปลงไฟล์เป็นนามสกลุ 
.tif แล้ว ณ ต าแหน่งพิกัดสถานีวัดน า้ฝนท่ีใช้ในการศึกษาทัง้ 2 ปี ด้วยโปรแกรมทางสารสนเทศ
ภูมิศาสตร์ โดยใช้เคร่ืงมือใน ArcToolbox ไปท่ี Spatial Analyst Tools > Extraction > Extract 
Multi Values to Points ดงัภาพ 3.5 โดยต าแหน่งพิกดัสถานีวดัน า้ฝนท่ีน าเข้าจะเป็นชัน้ข้อมลูแบบ
จดุ ซึง่ผู้วิจยัได้น าเข้าข้อมลูจดุ 12 ชัน้ข้อมลู (12 เดือน) ในการสกดัปริมาณฝนรายวนัแตล่ะเดือนใน 
1 ปี พร้อมทัง้น าเข้าผลิตภณัฑ์น า้ฝนท่ีเป็น .tif ตัง้แตว่นัแรกจนถึงวนัสดุท้ายของแตล่ะเดือน โดยจะ
ท าให้ได้ปริมาณฝนรายวนัตัง้แตว่นัแรกจนถึงวนัสดุท้ายของแตล่ะเดือนตามต าแหน่งพิกดัสถานีวดั
น า้ฝนท่ีใช้ในการศกึษา  
 5)  จดัข้อมลูปริมาณฝนรายวนัจากผลิตภณัฑ์น า้ฝนให้อยูใ่นรูปแบบท่ีเหมาะสม 
เพ่ือน าไปใช้ในการวิเคราะห์ข้อมลูตอ่ไป  
 
3.4  การวิเคราะห์ข้อมูล     
 3.4.1  การเปรียบเทียบข้อมลูปริมาณฝนรายวนัจากผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 
กบัฝนภาคพืน้ดนิของกรมอตุนุิยมวิทยาด้วยวิธีการทางสถิติจ านวน 6 สมการ ดงันี ้ 
 1)  ตรวจสอบความนา่เช่ือถือของข้อมลู จะใช้วิธีการทางสถิตจิ านวน 3 สมการ 
ได้แก่ Bias, RMSD และ MAD ดงันี ้ 
 Bias        =  ............ (สมการท่ี 3.1) 
     
 RMSD    =       ............ (สมการท่ี 3.2) 
 
  MAD      =  ............ (สมการท่ี 3.3) 
 
ซึง่ Bias คือ คา่ความคลาดเคล่ือนเฉล่ีย, RMSD คือ คา่รากท่ีสองของความแตกตา่งก าลงัสองเฉล่ีย 
และ MAD คือ คา่ความคลาดเคล่ือนท่ีแท้จริงเฉล่ีย มีหนว่ยเป็นมิลลิเมตร 
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ตวัแปร ได้แก่ xi           คือ  คา่ปริมาณฝนจากผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 (มิลลิเมตร) 
               TGi         คือ  คา่ปริมาณฝนภาคพืน้ดนิ (มิลลิเมตร) 
      n    คือ  จ านวนตวัอยา่ง 
 2)  ตรวจสอบคณุภาพของผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 จะใช้วิธีการทาง
สถิตจิ านวน 3 สมการ ได้แก่ POD, FAR และ CSI ดงันี ้
 POD    =     A/(A+B)     ………………………….(สมการท่ี 3.4) 
 FAR     =    C/(A+C)  .....................................(สมการท่ี 3.5) 
 CSI      =     A/(A+B+C)   ………………………….(สมการท่ี 3.6) 
ซึ่ง POD คือ ความน่าจะเป็นของการตรวจพบ, FAR คือ อตัราการแจ้งเตือนท่ีผิดพลาด และ CSI        
คือ ดชันีความส าเร็จ โดยผลิตภณัฑ์น า้ฝนท่ีมีคณุภาพสงูจะมี POD = 1, FAR = 0 และ CSI = 1 

ตวัแปร ได้แก่ A     คือ  ฝนรายวนัตรวจวดัด้วยดาวเทียม ท่ีประมาณการวา่มีฝนถกูต้อง 
          B     คือ  กรมอตุนุิยมวิทยาระบวุา่มีฝน แตด่าวเทียมระบวุา่ไมมี่ฝน 
                C     คือ  ดาวเทียมประมาณการไมถ่กูต้อง ระบวุา่มีฝน แตไ่มมี่ฝนเกิดขึน้ 
 3.4.2  การเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีของ Bias ท่ีดีท่ีสดุ  
 1)  เปรียบเทียบการประมาณค่าเชิงพืน้ท่ีจ านวน 3 วิธี ได้แก่ Kriging, IDW 
และ Spline แบบ Regularized 
 2)  ใช้ Bias ดงัสมการท่ี 3.1 ท่ีค านวณจากปริมาณฝนสะสมรายปี พ.ศ. 2553 
และ พ.ศ. 2554 
 3)  น าต าแหน่งพิกดัสถานีวดัน า้ฝนท่ีใช้ในการศกึษา พร้อมทัง้เพิ่มตาราง Bias            
ท่ีค านวณได้ทัง้ 2 ปี โดยท าแตล่ะปีแยกกนั แล้วน าเข้าสู่โปรแกรมทางสารสนเทศภูมิศาสตร์ ซึ่งจะ
สุ่มเลือกเป็นจุดตรวจสอบร้อยละ 30 ท่ีเหลืออีกร้อยละ 70 จะน าไปประมาณค่าเชิงพืน้ท่ีทัง้ 3 วิธี 
โดยทัง้ 2 ปี จดุตรวจสอบร้อยละ 30 และท่ีเหลืออีกร้อยละ 70 เป็นจดุเดียวกนั 
 4)  สุม่เลือกจดุตรวจสอบเป็นจ านวน 30 ครัง้ โดยใช้ Python ซึง่ผู้วิจยัได้ใช้โค้ด 
SelectRandomByPercent ท่ีให้ระบรุ้อยละท่ีต้องการสุม่เลือกตามต าแหนง่พิกดัสถานีวดัน า้ฝนท่ีมี 
โดยในงานวิจยันีก็้คือร้อยละ 30 และเม่ือรันโค้ดแต่ละครัง้จะท าให้ทราบว่ามีจดุตรวจสอบตรงจดุ
ไหนบ้าง เพ่ือจะน าไปสกดั Bias ตอ่ไป และท่ีเหลืออีกร้อยละ 70 ก็คือจดุท่ีจะน าไปประมาณคา่เชิง
พืน้ท่ีตอ่ไป 
 5)  น าต าแหน่งพิกัดสถานีวัดน า้ฝนท่ีเหลือร้อยละ 70 จากการสุ่มเลือก                    
จดุตรวจสอบแตล่ะครัง้ไปประมาณคา่เชิงพืน้ท่ีทัง้ 3 วิธี ดงันี ้
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ภาพ 3.3 การแปลงผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 โดยใช้ Model Builder 
 

 
 

ภาพ 3.4 ตัวอย่างผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ที่น าเข้า 
 

 
 

ภาพ 3.5 การสกัดข้อมูลปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 
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 -  Kriging ดงัภาพ 3.6 
เปิดเคร่ืองมือใน ArcToolbox > Spatial Analyst Tools > Interpolation > Kriging  

 Input point features ให้ก าหนดชัน้ข้อมลูจดุท่ีต้องการประมาณคา่ 
 Z value field ให้ก าหนดฟิลด์ท่ีต้องการประมาณคา่ 
 Output surface raster ให้ก าหนดช่ือและท่ีเก็บผลลพัธ์ 
 Output cell size (optional) ให้ก าหนดขนาดเซลล์ผลลพัธ์ 

 -  IDW ดงัภาพ 3.7 
เปิดเคร่ืองมือใน ArcToolbox > Spatial Analyst Tools > Interpolation > IDW 

 Input point features ให้ก าหนดชัน้ข้อมลูจดุท่ีต้องการประมาณคา่ 
 Z value field ให้ก าหนดฟิลด์ท่ีต้องการประมาณคา่ 
 Output raster ให้ก าหนดช่ือและท่ีเก็บผลลพัธ์ 
 Output cell size (optional) ให้ก าหนดขนาดเซลล์ผลลพัธ์ 
 Power (optional) คือ ตวัยกก าลงัของสมการ 

 -  Spline ในงานวิจยันีจ้ะใช้แบบ Regularized ดงัภาพ 3.8 
เปิดเคร่ืองมือใน ArcToolbox > Spatial Analyst Tools > Interpolation > Spline 

 Input point features ให้ก าหนดชัน้ข้อมลูจดุท่ีต้องการประมาณคา่ 
 Z value field ให้ก าหนดฟิลด์ท่ีต้องการประมาณคา่ 
 Output raster ให้ก าหนดช่ือและท่ีเก็บผลลพัธ์ 
 Output cell size (optional) ให้ก าหนดขนาดเซลล์ผลลพัธ์ 
 Spline type (optional) ให้ก าหนดรูปแบบ Spline โดยในงานวิจัยนี ้

เลือกแบบ Regularized 
ในงานวิจยันีไ้ด้ก าหนดขนาดเซลล์ผลลพัธ์เป็น 0.05 ทัง้ 3 วิธี ส าหรับสว่นอ่ืนๆ ก าหนดคา่ตามระบบ 
และได้ก าหนดขอบเขตผลลพัธ์การประมาณค่าเชิงพืน้ท่ีให้มีขอบเขตตามพืน้ท่ีศึกษา โดยคลิกท่ี 
Environments ปรับคา่ตรง Processing Extent และ Raster Analysis เม่ือเสร็จให้คลิก OK                   
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ภาพ 3.6 ตัวอย่างการก าหนดข้อมูลในการประมาณค่าเชิงพืน้ท่ีด้วยวิธี Kriging  
 

 
 

ภาพ 3.7 ตัวอย่างการก าหนดข้อมูลในการประมาณค่าเชิงพืน้ท่ีด้วยวิธี IDW 
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ภาพ 3.8 ตัวอย่างการก าหนดข้อมูลในการประมาณค่าเชิงพืน้ท่ีด้วยวิธี Spline 
 

ดังภาพ 3.9 ได้น า Bias จากปริมาณฝนสะสมรายปี พ.ศ. 2554 ท่ีมีหน่วยเป็นมิลลิเมตร ตาม
ต าแหนง่สถานีวดัน า้ฝนท่ีเหลือร้อยละ 70 และเป็นจดุตรวจสอบท่ีสุม่เลือกครัง้เดียวกนั ไปประมาณ
ค่าเชิงพืน้ท่ีทัง้ 3 วิธี (a) Kriging, (b) IDW และ (c) Spline แบบ Regularized ซึ่งจะท าให้เห็นว่า
จากต าแหน่งสถานีวดัน า้ฝนท่ีเป็นชัน้ข้อมูลจุด เม่ือน าไปประมาณค่าเชิงพืน้ท่ีแล้วจะท าให้ได้ชัน้
ข้อมลูท่ีเป็นราสเตอร์ โดยในแตล่ะวิธีก็มีลกัษณะท่ีแตกตา่งกนัไป 
 6)  น าจดุตรวจสอบในแตล่ะครัง้ท่ีสุม่เลือกเป็นจ านวน 30 ครัง้ ซึง่เป็นชัน้ข้อมลู
จดุไปสกดั Bias หลงัจากได้น าต าแหน่งสถานีวดัน า้ฝนท่ีเหลือร้อยละ 70 ในครัง้นัน้ๆ ไปประมาณ
คา่เชิงพืน้ท่ีทัง้ 3 วิธีแล้ว โดยการสกดั Bias ใช้เคร่ืงมือใน ArcToolbox ไปท่ี Spatial Analyst Tools 
> Extraction > Extract Multi Values to Points 
 7)  หาความต่างของ Bias โดยน า Bias ท่ีสกัดออกมาลบด้วย Bias เดิมท่ี
ค านวณไว้อยูแ่ล้วจากจดุตรวจสอบแตล่ะจดุ  
 8)  น าผลลัพธ์ของ Bias ท่ีหาความต่างแล้วจากการสุ่มเลือกจุดตรวจสอบ
จ านวน 30 ครัง้ มาหาคา่เฉล่ียในการประมาณคา่เชิงพืน้ท่ีทัง้ 3 วิธี เพ่ือเปรียบเทียบหาวิธีท่ีดีท่ีสดุ  
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(a)    
 

 
 
 
 
 
 
 
(b)   

 
 
 
 
 
 
 
 
(c)    

 
 
 
 
 
 
 
 
 

ภาพ 3.9 ตัวอย่างการน าต าแหน่งสถานีวัดน า้ฝนที่เหลือร้อยละ 70 จากการสุ่มเลือกจุด  
               ตรวจสอบครัง้เดียวกัน ไปประมาณค่าเชิงพืน้ที่ทัง้ 3 วิธี ได้แก่ (a) Kriging, (b)  
               IDW และ (c) Spline แบบ Regularized 
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ภาพ 3.10 การปรับแก้ค่าฝนจาก Bias ของข้อมูลปริมาณฝนจากผลิตภัณฑ์น า้ฝน TRMM  
               3B42 V.7 กับฝนภาคพืน้ดนิ 
 

 3.4.3  การปรับแก้ค่าฝนจาก Bias ของข้อมูลปริมาณฝนจากผลิตภัณฑ์น า้ฝน TRMM 
3B42 V.7 กบัฝนภาคพืน้ดนิ 

 1)  รวมชัน้ข้อมูลผลิตภัณฑ์น า้ฝน ซึ่งเป็นข้อมูลประเภทราสเตอร์ท่ีเป็นฝน
รายวนัให้เป็นฝนสะสมรายเดือนของปี พ.ศ. 2553 และ พ.ศ. 2554 ด้วยโปรแกรมทางสารสนเทศ
ภูมิศาสตร์ โดยใช้เคร่ืงมือใน ArcToolbox ไปท่ี Spatial Analyst Tools > Map Algebra > Raster 
Calculator ดงัภาพ 3.11 ท าการรวมตัง้แตว่นัแรกจนถึงวนัสดุท้ายของเดือนโดยใช้เคร่ืองหมายบวก 
ซึ่งเดือนท่ีจะน ามาวิเคราะห์คือเดือนท่ีพบว่ามีค่า Bias สงู เพียงหนึ่งเดือน โดยพิจารณาควบคู่กัน
ทัง้ 2 ปี  
 2)  น าชัน้ข้อมูลผลิตภัณฑ์น า้ฝนท่ีรวมป็นฝนสะสมรายเดือนแล้วมาตัดเอา
เฉพาะขอบเขตพืน้ท่ีคึกษา โดยใช้เคร่ืงมือใน ArcToolbox ไปท่ี Data Management Tools > 
Raster > Raster Processing > Clip ดงัภาพ 3.12 จะท าให้ได้ผลิตภณัฑ์น า้ฝนก่อนปรับแก้ 
 3)  น าต าแหน่งพิกดัสถานีวดัน า้ฝนท่ีใช้ในการศกึษา พร้อมทัง้เพิ่มตาราง Bias            
ดงัสมการท่ี 1 ท่ีค านวณโดยใช้ปริมาณฝนสะสมรายเดือนของเดือนท่ีจะน ามาวิเคราะห์ในแต่ละ
สถานีทัง้ 2 ปี โดยท าแตล่ะปีแยกกนั แล้วน าเข้าสูโ่ปรแกรมทางสารสนเทศภมูิศาสตร์ 
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ภาพ 3.11 การรวมชัน้ข้อมูลผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ให้เป็นฝนสะสมรายเดือน 

 

 
 

ภาพ 3.12 การตัดเอาเฉพาะขอบเขตพืน้ท่ีคึกษาของชัน้ข้อมูลผลิตภัณฑ์น า้ฝน TRMM  
                 3B42 V.7  

 

 4)  สุ่มเลือกต าแหน่งพิกดัสถานีวดัน า้ฝน โดยใช้ Python ในการสุ่มเลือก ซึ่งทัง้ 
2 ปี ต้องเป็นต าแหน่งเดียวกัน โดยให้เป็นจุดตรวจสอบร้อยละ 30 และท่ีเหลืออีกร้อยละ 70 ซึ่งมี 
Bias ท่ีค านวณไว้อยู่จะน าไปประมาณค่าเชิงพืน้ท่ีด้วยวิธีท่ีดีท่ีสุดจากการวิเคราะห์ข้อมลูในหวัข้อ 
3.4.2 โดยก าหนดขนาดเซลล์ผลลพัธ์เป็น 0.25  
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 5)  น าชัน้ข้อมูลผลิตภัณฑ์น า้ฝนท่ีรวมเป็นฝนสะสมรายเดือนแล้วลบด้วยชัน้
ข้อมลูต าแหนง่พิกดัสถานีวดัน า้ฝนท่ีเหลือร้อยละ 70 หลงัจากน าไปประมาณคา่เชิงพืน้ท่ีด้วยวิธีท่ีดี
ท่ีสดุแล้ว ซึ่งเป็นข้อมลูประเภทราสเตอร์เช่นเดียวกัน ด้วยโปรแกรมทางสารสนเทศภูมิศาสตร์ โดย
ใช้ เค ร่ืง มือใน ArcToolbox ไปท่ี  Spatial Analyst Tools > Map Algebra > Raster Calculator             
จะท าให้ได้ผลิตภณัฑ์น า้ฝนหลงัปรับแก้  
 6)  น าจุดตรวจสอบร้อยละ 30 ซึ่งเป็นชัน้ข้อมูลแบบจุดไปสกัดปริมาณฝน
สะสมรายเดือนจากผลิตภัณฑ์น า้ฝนหลังปรับแก้ โดยใช้เคร่ืงมือใน ArcToolbox ไปท่ี Spatial 
Analyst Tools > Extraction > Extract Multi Values to Points 
 7)  หา Bias ระหว่างผลิตภัณฑ์น า้ฝนหลงัปรับแก้กับจุดตรวจสอบร้อยละ 30 
โดยน าปริมาณฝนสะสมรายเดือนจากผลิตภัณฑ์น า้ฝนหลงัปรับแก้ท่ีสกัดออกมาลบด้วยปริมาณ
ฝนภาคพืน้ดนิสะสมรายเดือนของจดุตรวจสอบร้อยละ 30 แตล่ะจดุ 
 
 



 
 

 
 

บทที่  4 
 

ผลการวิจัย 
 

การเปรียบเทียบปริมาณฝนรายวนัระหว่างผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 จากข้อมลู
ดาวเทียม TRMM กับข้อมูลฝนภาคพืน้ดินของกรมอุตนุิยมวิทยา ในพืน้ท่ี 9 จงัหวดัภาคเหนือของ
ประเทศไทย เพ่ือศกึษาความแตกตา่งของฝนจากผลิตภณัฑ์น า้ฝนกบัฝนภาคพืน้ดิน และหาวิธีการ
ประมาณคา่เชิงพืน้ท่ีของ Bias ท่ีดีท่ีสดุ มีผลการวิจยัโดยแบง่การวิเคราะห์ข้อมลูเป็น 4 สว่น ดงันี ้

4.1  การตรวจสอบและคดัเลือกข้อมลูท่ีใช้ในการศกึษา 
4.2  การเปรียบเทียบข้อมลูปริมาณฝนรายวนัจากผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 กบั                

ฝนภาคพืน้ดนิของกรมอตุนุิยมวิทยาด้วยวิธีการทางสถิต ิ
4.3  การเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีของ Bias ท่ีดีท่ีสดุ 
4.4  การปรับแก้ค่าฝนจาก Bias ของข้อมูลปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝน 

TRMM 3B42 V.7 กบัฝนภาคพืน้ดนิ 
 
4.1  การตรวจสอบและคัดเลือกข้อมูลที่ใช้ในการศึกษา 
 เม่ือตรวจสอบข้อมลูปริมาณฝนรายวนัภาคพืน้ดนิ พบวา่สถานีวดัน า้ฝนท่ีมีข้อมลูตรวจวดั
ครบทัง้ 2 ปี มีจ านวน 88 สถานี และเม่ือคดัเลือกข้อมูลดงัภาพ 4.1 ได้แสดงสถานีวดัน า้ฝนท่ีพบ
ความผิดปกติอย่างเด่นชดั โดยผู้วิจยัเลือกปริมาณฝนรายวนัภาคพืน้ดินในปี พ.ศ. 2553 มาแสดง
เพียงบางสถานี ด้วยการพล็อตกราฟปริมาณฝนสะสมรายปีของแตล่ะสถานีจากปริมาณฝนรายวนั
ภาคพืน้ดิน ซึ่งท าทัง้ 2 ปี จากนัน้พิจารณาตามเกณฑ์ในหัวข้อ 3.3.1 เพ่ือตดัสถานีวัดน า้ฝนท่ีมี
ความผิดปกติออกจากการวิเคราะห์ โดย (a) สถานีสวนป่าดอยช้าง อ าเภอเมือง จงัหวดัเชียงราย          
ท่ีพบว่ามีปริมาณฝนสะสมจนถึงเดือนธันวาคมมากถึง 4,292.4 มิลลิเมตร โดยสถานีใกล้เคียงมี
ปริมาณฝนต ่ากว่า 2,000 มิลลิเมตร, (b) ส านกังานเกษตร อ าเภอน า้ปาด จงัหวดัอุตรดิตถ์ พบว่า
เดือนพฤษภาคมก็ยงัไมมี่ปริมาณฝน และ (c) สถานีอ าเภอเชียงกลาง จงัหวดัน่าน พบว่ามีปริมาณ
ฝนสะสมจนถึงเดือนธันวาคมห่างจากสถานีใกล้เคียงเป็นปริมาณมาก ซึง่สว่นใหญ่มีปริมาณฝนอยู่
ท่ี 1,500 มิลลิเมตร 
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(a) 

 

 

 

 

 

(b) 

 

 

 

 

 

(c) 

 
 

 
 

 
 
 

 
ภาพ 4.1 ตัวอย่างสถานีวัดน า้ฝนที่พบความผิดปกต ิ(a) สถานีสวนป่าดอยช้าง อ าเภอเมือง  
            จังหวัดเชียงราย, (b) ส านักงานเกษตร อ าเภอน า้ปาด จังหวัดอุตรดติถ์ และ (c)  
            สถานีอ าเภอเชียงกลาง จังหวัดน่าน 
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 ผลการศึกษาดังภาพ 4.2 พบว่าสถานีวัดน า้ฝนท่ีถูกตัดออกมีจ านวน 10 สถานี โดย
แบง่เป็นแม่ฮ่องสอน 1 สถานี, เชียงราย 1 สถานี, เชียงใหม่ 1 สถานี, แพร่ 3 สถานี, น่าน 2 สถานี 
และอุตรดิตถ์ 2 สถานี ดงันัน้จึงเหลือสถานีวดัน า้ฝนท่ีใช้ในการศึกษาจ านวน 78 สถานี ซึ่งพบว่า             
ส่วนใหญ่มีการกระจายตวัอยู่ในบริเวณท่ีราบ และเป็นการกระจายตวัท่ีมีความหนาแน่นต ่า ตาราง 
4.1 แสดงให้เห็นว่าเชียงใหม่มีสถานีวดัน า้ฝนมากท่ีสดุจ านวน 16 สถานี และน้อยท่ีสดุ 3 สถานีใน
ล าพนู ตามล าดบั เป็นท่ีน่าสงัเกตว่ามีหลายพืน้ท่ีท่ียงัไม่มีสถานีวดัน า้ฝนติดตัง้อยู่ เช่น ตอนเหนือ
ของล าปาง และด้านทิศตะวนัออกของพะเยา ซึ่งครอบคลุมพืน้ท่ีอุทยานแห่งชาติดอยภูนาง และ
บริเวณเทือกเขาสูงหรือพืน้ท่ีป่าพบว่าไม่มีสถานีวัดน า้ฝน เน่ืองมาจากปัญหากระแสไฟฟ้าท่ีเข้า             
ไม่ถึง และการดแูลรักษาท่ียากล าบาก ท าให้ไม่คุ้มกบัคา่ใช้จ่ายท่ีเสียไป ซึ่งถือว่าเป็นข้อจ ากดัทาง
พืน้ท่ีท่ีส าคญั 
 
ตาราง 4.1 จ านวนสถานีวัดน า้ฝนที่ใช้ในการศึกษาของแต่ละจังหวัด 
 

ล าดบั จงัหวดั จ านวนสถานี 
1 เชียงใหม ่ 16 
2 ล าปาง 14 
3 เชียงราย 13 
4 นา่น 10 
5 อตุรดติถ์ 7 
6 พะเยา 6 
7 แพร่ 5 
8 แมฮ่อ่งสอน 4 
9 ล าพนู 3 
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ภาพ 4.2 แผนที่ต าแหน่งสถานีวัดน า้ฝนในพืน้ที่ 9 จังหวัดภาคเหนือ ท่ีใช้ในการศึกษาและท่ีถูกตัดออก 
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4.2  การเปรียบเทียบข้อมูลปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 กับ
ฝนภาคพืน้ดนิของกรมอุตุนิยมวิทยาด้วยวิธีการทางสถติิ 
 4.2.1  ตรวจสอบความน่าเช่ือถือของข้อมูล 
 1)  ตรวจสอบโดยใช้ปริมาณฝนรายวนั  
 ดงัแสดงในภาพ 4.3 ปริมาณฝนรายวนัภาคพืน้ดิน (TMD ซ้ายของเคร่ืองหมาย
บวก) และปริมาณฝนจากผลิตภณัฑ์น า้ฝน (TRMM ขวาของเคร่ืองหมายบวก) เฉล่ียเป็นระยะเวลา 
1 ปี (a) พ.ศ. 2553 และ (b) พ.ศ. 2554 ณ สถานีวดัน า้ฝน (เคร่ืองหมายบวก) พบว่าส่วนใหญ่ปี 
พ.ศ. 2554 มีปริมาณฝนสูงกว่า และปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝนมีค่าสูงกว่าฝน
ภาคพืน้ดนิทัง้ 2 ปี  
 การค านวณในสว่นนีไ้ด้จ าแนกเป็นรายจงัหวดัตามจ านวนสถานีวดัน า้ฝนท่ีมีใน
จงัหวดันัน้ๆ พบว่าปี พ.ศ. 2553 Bias, RMSD และ MAD คา่ต ่าสดุเท่ากับ 0.07, 10.89 และ 4.41 
มิลลิเมตร ตามล าดบั และคา่สงูสดุเท่ากบั 0.41, 14.24 และ 6.08 มิลลิเมตร ตามล าดบั ดงัตาราง 
4.2 โดยค่าต ่าสุดหมายถึงปริมาณฝนจากผลิตภัณฑ์น า้ฝนกับฝนภาคพืน้ดินมีความคลาดเคล่ือน
กันต ่าท่ีสุดในล าปาง, เชียงใหม่ และล าพูน ตามล าดับ ตรงกันข้ามกับค่าสูงสุดจะหมายถึงมี 
ความคลาดเคล่ือนกนัสงูท่ีสดุในล าพนู, เชียงราย และพะเยา ตามล าดบั เช่นเดียวกบัปี พ.ศ. 2554 
ffnknknknknk 
ตาราง 4.2 Bias, RMSD และ MAD (มิลลิเมตร) ของ 9 จังหวัดภาคเหนือ ปี พ.ศ. 2553  
 

 
รวม แม่ฮ่องสอน เชียงราย พะเยา เชียงใหม่ ล าปาง ล าพนู แพร่ น่าน อตุรดติถ์ 

Bias 0.22 0.36 0.12 0.36 0.28 0.07 0.41 0.18 0.20 0.34 
RMSD 12.19 11.22 14.24 13.58 10.89 11.30 10.94 11.13 12.85 12.85 
MAD 5.19 4.75 6.05 6.08 4.84 4.78 4.41 4.42 5.57 5.06 

 
ตาราง 4.3 Bias, RMSD และ MAD (มิลลิเมตร) ของ 9 จังหวัดภาคเหนือ ปี พ.ศ. 2554  
 

 
รวม แม่ฮ่องสอน เชียงราย พะเยา เชียงใหม่ ล าปาง ล าพนู แพร่ น่าน อตุรดติถ์ 

Bias 0.48 0.20 0.27 0.23 0.35 0.89 1.14 0.18 0.23 1.03 
RMSD 13.63 13.09 13.70 14.84 12.22 13.10 12.39 14.97 15.22 14.37 
MAD 6.24 6.29 6.19 6.85 5.80 5.94 5.71 6.41 6.98 6.48 
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(a) 
 

 
 
 
 
 
 
 
 
 
 
 
(b)  

 
 
 
 
 
 
 

 
 
 
 
 

 

ภาพ 4.3 ปริมาณฝนรายวันเฉล่ีย (มิลลิเมตร) โดย TMD (ซ้ายของเคร่ืองหมายบวก) และ    
        TRMM (ขวาของเคร่ืองหมายบวก) ณ สถานีวัดน า้ฝน (เคร่ืองหมายบวก) ใน 

              พืน้ท่ี 9 จังหวัดภาคเหนือ (a) พ.ศ. 2553 และ (b) พ.ศ. 2554  
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ตาราง 4.3 พบว่าค่าต ่าสุดเท่ากับ 0.18, 12.22 และ 5.71 มิลลิเมตร ตามล าดับ แสดงว่ามี  
ความคลาดเคล่ือนกันต ่าท่ีสดุในแพร่, เชียงใหม่ และล าพนู ตามล าดบั ส่วนคา่สงูสดุเท่ากบั 1.14, 
15.22 และ 6.98 มิลลิเมตร ตามล าดบั แสดงว่ามีความคลาดเคล่ือนกนัสงูท่ีสุดในล าพนู และน่าน 
(มีคา่ RMSD กบั MAD สงูท่ีสดุ) ตามล าดบั 
 2)  ตรวจสอบโดยใช้ปริมาณฝนสะสมรายเดือน 
 ในแต่ละเดือนดงัภาพ 4.4 พบว่าปี พ.ศ. 2553 ปริมาณฝนภาคพืน้ดิน (TG) 
และปริมาณฝนจากผลิตภัณฑ์น า้ฝน (TRMM 3B42 V.7) สูงสุดอยู่ในเดือนสิงหาคมเช่นเดียวกัน 
โดยท่ีฝนภาคพืน้ดินตรวจวดัได้สงูกวา่ ซึ่งเส้นกราฟทัง้สองมีลกัษณะใกล้เคียงกนั โดยมีหลายเดือน
ท่ีฝนจากผลิตภณัฑ์น า้ฝนจะมีปริมาณฝนสงูกว่าฝนภาคพืน้ดิน เช่นเดียวกบัปี พ.ศ. 2554 ฝนจาก
ผลิตภัณฑ์น า้ฝนจะมีปริมาณฝนสูงกว่าฝนภาคพืน้ดินอยู่หลายเดือน ซึ่งพบว่ามีความต่างของ
ปริมาณฝนคอ่นข้างมาก เช่น เดือนมิถนุายนและกนัยายน เป็นต้น โดยฝนภาคพืน้ดินมีปริมาณฝน
สงูสดุอยูใ่นเดือนสิงหาคม สว่นฝนจากผลิตภณัฑ์น า้ฝนอยูใ่นเดือนกนัยายน  
 ผลค านวณดงัตาราง 4.4 พบว่าปี พ.ศ. 2553 Bias, RMSD และ MAD เท่ากับ  
-0.19, 7.77 และ 1.18 มิลลิเมตร ตามล าดบั เป็นคา่ต ่าสดุ แสดงวา่มีความคลาดเคล่ือนกนัต ่าท่ีสดุ
ในเดือนมกราคม และพฤศจิกายน (มีคา่ RMSD กบั MAD ต ่าท่ีสดุ) ตามล าดบั และคา่สงูสดุเทา่กบั  
29.90, 116.34 และ 91.33 มิลลิเมตร ตามล าดบั แสดงว่ามีความคลาดเคล่ือนกนัสงูท่ีสุดในเดือน
กรกฎาคม และสิงหาคม (มีค่า RMSD กับ MAD สูงท่ีสุด) ตามล าดบั โดยจะสังเกตเห็นว่า Bias             
มีทัง้ค่าบวกและลบ ซึ่งค่าลบหมายถึงปริมาณฝนจากผลิตภัณฑ์น า้ฝนมีค่าต ่ากว่าฝนภาคพืน้ดิน
ได้แก่ มกราคม, กมุภาพนัธ์, มีนาคม, สิงหาคม, พฤศจิกายน และธนัวาคม สว่นคา่บวกจะหมายถึง
ปริมาณฝนจากผลิตภณัฑ์น า้ฝนมีคา่สงูกว่าฝนภาคพืน้ดิน เช่นเดียวกบัปี พ.ศ. 2554 Bias, RMSD 
และ MAD มีค่าต ่าสุดเท่ากับ -0.91, 3.49 และ 1.41 มิลลิเมตร ตามล าดับ แสดงว่ามีความ
คลาดเคล่ือนกันต ่าท่ีสุดในเดือนธันวาคมทัง้หมด และมีค่า 59.38, 110.49 และ 89.35 มิลลิเมตร 
ตามล าดบั เป็นคา่สงูสดุ แสดงว่ามีความคลาดเคล่ือนกนัสงูท่ีสุดในเดือนกันยายนทัง้หมด โดยใน
เดือนท่ี Bias มีคา่ลบ ได้แก่ มกราคม, สิงหาคม, ตลุาคม, พฤศจิกายน และธนัวาคม 
 3)  ตรวจสอบโดยใช้ปริมาณฝนสะสมรายปี 
 ภาพ 4.5 แสดงให้เห็นความเก่ียวข้องกันระหว่างสองตวัแปร คือปริมาณฝน
ภาคพืน้ดิน (TG) และปริมาณฝนจากผลิตภัณฑ์น า้ฝน (TRMM 3B42 V.7) พบว่าแผนภาพการ
กระจายทัง้ 2 ปี มีแนวเส้นตรงและการเกาะกลุม่ของจดุรอบๆ แนวเส้นตรงตา่งกนั โดยปี พ.ศ. 2553 
กลุม่ของจดุจะเอียงสงูขึน้ทางด้านขวามากกว่าปี พ.ศ. 2554 กลา่วคือ คา่ตวัแปร TRMM 3B42 V.7 
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ของจดุโดยส่วนใหญ่จะเพิ่มขึน้ตามคา่ตวัแปร TG ท่ีเพิ่มขึน้ หมายความว่าปริมาณฝนภาคพืน้ดนิท่ี
สงูมกัจะมีปริมาณฝนจากผลิตภัณฑ์น า้ฝนท่ีสงูด้วย และเม่ือด ูR หรือคา่สหสมัพนัธ์ พบว่าปี พ.ศ. 
2553 ตวัแปร TG และ TRMM 3B42 V.7 มีความสมัพนัธ์กนัมากกวา่ปี พ.ศ. 2554 
  

(a) 
 
 
 
 
 
 
 
 

 

(b) 
 

 
 
 
 
 
 
 
 

 
 

ภาพ 4.4 ปริมาณฝนสะสมรายเดือน (มิลลิเมตร) เฉล่ียทัง้ 78 สถานี (a) พ.ศ. 2553 และ  
              (b) พ.ศ. 2554 
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ตาราง 4.4 Bias, RMSD และ MAD (มิลลิเมตร) เฉล่ียทัง้ 78 สถานี ในปี พ.ศ. 2553 และ   
               พ.ศ. 2554   
               

เดือน Bias RMSD MAD 
2553 2554 2553 2554 2553 2554 

มกราคม -0.19 -4.15 22.27 10.44 17.81 6.76 
กมุภาพนัธ์ -2.00 11.24 14.03 16.87 2.18 11.52 
มีนาคม -1.10 3.11 17.30 33.18 11.65 23.61 
เมษายน 11.14 32.09 25.38 59.39 18.96 48.12 
พฤษภาคม 15.37 20.60 52.70 75.48 40.33 59.42 
มิถนุายน 11.19 49.53 55.83 82.88 44.63 65.54 
กรกฎาคม 29.90 33.90 91.78 90.67 74.39 74.70 
สิงหาคม -21.45 -2.59 116.34 104.79 91.33 87.99 
กนัยายน 28.76 59.38 85.46 110.49 67.73 89.35 
ตลุาคม 18.91 -24.36 55.03 61.74 43.82 46.38 

พฤศจิกายน -1.16 -1.00 7.77 10.88 1.18 7.21 
ธนัวาคม -8.96 -0.91 18.97 3.49 12.94 1.41 

 
 เม่ือท าการค านวณ Bias ดงัแสดงในภาพ 4.6 พบวา่คา่กระจายตวัเชิงพืน้ท่ีของ 
Bias มีทัง้ค่าบวกและลบ ซึ่งส่วนใหญ่จะพบว่าเป็นค่าบวกโดยมีจ านวน 50 และ 55 สถานี ในปี 
พ.ศ. 2553 และ พ.ศ. 2554 ตามล าดบั ในปี พ.ศ. 2553 พบว่า Bias คา่ลบมีคา่เข้าใกล้ศนูย์อยู่ใน
ในช่วง 0-200 มิลลิเมตร จ านวน 16 สถานี ซึ่งมากกว่าปี พ.ศ. 2554 แสดงถึงปริมาณฝนจาก
ผลิตภณัฑ์น า้ฝนมีคา่ต ่ากวา่ฝนภาคพืน้ดนิ และยงัพบวา่ปี พ.ศ. 2554 มี Bias คา่บวกท่ีสงูกวา่ 600 
มิลลิเมตร ถึง 10 สถานี ซึ่งมากกว่าปี พ.ศ. 2553 ถึง 5 สถานี โดยอยู่ในเขตลุ่มน า้วงัของล าปาง 
และลุ่มน า้สาขาของล าน า้น่านในอุตรดิตถ์ เป็นต้น ส่วนการค านวณ RMSD ดงัแสดงในภาพ 4.7
พบวา่ในชว่งท่ีมีสถานีวดัน า้ฝนมากท่ีสดุ ได้แก่ 150-300 และ 300-450 มิลลิเมตร โดยมีจ านวน 30 
และ 28 สถานี ในปี พ.ศ. 2553 และ พ.ศ. 2554 ตามล าดบั ซึ่งในปี พ.ศ. 2553 พบว่า RMSD มีคา่
เข้าใกล้ศูนย์อยู่ในช่วง 0-150 มิลลิเมตร จ านวน 19 สถานี ซึ่งมากกว่าปี พ.ศ. 2554 แสดงถึง
ปริมาณฝนจากผลิตภณัฑ์น า้ฝนกบัฝนภาคพืน้ดินมีความคลาดเคล่ือนกันต ่า และยงัพบว่าปี พ.ศ. 
2554 มี RMSD ท่ีสูงกว่า 450 มิลลิเมตร ถึง 13 สถานี ซึ่งมีจ านวนมากกว่าปี พ.ศ. 2553 อยู่               
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4 สถานี โดยส่วนใหญ่ท่ีพบจะมีการกระจายตวัเชิงพืน้ท่ีอยู่ในล าปางบริเวณลุ่มน า้วงั เป็นต้น และ
ภาพ 4.8 เป็นการค านวณ MAD ซึ่งผลการศึกษาท่ีพบมีลกัษณะเช่นเดียวกับการค านวณ RMSD 
โดยมีการกระจายตวัเชิงพืน้ท่ีในช่วงท่ีก าหนดตามพืน้ท่ีต่างๆ และจ านวนสถานีวดัน า้ฝนในแตล่ะ
ชว่งเหมือนกนักบัการค านวณ RMSD ทกุประการ 

 

(a) 
 
 
 
 
 
 
 
 
 
 

(b)  
 
 

 
 
 
 
 
 
 

 
 

ภาพ 4.5 ปริมาณฝนสะสมรายปี (มิลลิเมตร) ทัง้ 78 สถานี (a) พ.ศ. 2553 และ                  
                    (b) พ.ศ. 2554  
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ภาพ 4.6 แผนที่ Bias จากปริมาณฝนสะสมรายปี (มิลลิเมตร) ในพืน้ที่ 9 จังหวัด 
                   ภาคเหนือ (a) พ.ศ. 2553 และ (b) พ.ศ. 2554  
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ภาพ 4.7 แผนที่ RMSD จากปริมาณฝนสะสมรายปี (มิลลิเมตร) ในพืน้ที่ 9 จังหวัด 
                  ภาคเหนือ (a) พ.ศ. 2553 และ (b) พ.ศ. 2554  
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ภาพ 4.8 แผนที่ MAD จากปริมาณฝนสะสมรายปี (มิลลิเมตร) ในพืน้ที่ 9 จังหวัด 
                   ภาคเหนือ (a) พ.ศ. 2553 และ (b) พ.ศ. 2554  
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 4.2.2  ตรวจสอบคุณภาพของผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 
 การค านวณทางสถิติในส่วนนีไ้ด้แบง่เป็นกลุ่มช่วงเดือน ดงัตาราง 4.5 พบว่าปี 
พ.ศ. 2553 POD, FAR และ CSI ของผลิตภัณฑ์น า้ฝนท่ีมีคณุภาพสงูท่ีสุดเท่ากับ 0.95, 0.04 และ
0.92 ตามล าดบั ส่วนท่ีมีคณุภาพต ่าท่ีสุดเท่ากับ 0.86, 0.34 และ 0.59 ตามล าดบั ส าหรับปี พ.ศ. 
2554 ท่ีมีคณุภาพสงูท่ีสดุเท่ากบั 0.97, 0.04 และ 0.93 ตามล าดบั และท่ีมีคณุภาพต ่าท่ีสดุเท่ากับ 
0.81, 0.35 และ 0.56 ตามล าดบั แสดงให้เห็นว่าทัง้ 2 ปี ผลิตภณัฑ์น า้ฝนมีคณุภาพสงูท่ีสดุในช่วง
เดือนธันวาคม-กุมภาพนัธ์ และมีคณุภาพต ่าท่ีสุดในช่วงเดือนมิถุนายน-สิงหาคมอีกเช่นเดียวกัน 
โดย FAR และ CSI แทบไมต่า่งกนั  
 
4.3  การเปรียบเทียบวิธีการประมาณค่าเชิงพืน้ท่ีของ Bias ที่ดีที่สุด 
 ปริมาณฝนจากสถานีตรวจวดัภาคพืน้ดินของกรมอุตนุิยมวิทยา จะท าให้ทราบปริมาณ
ฝนในพืน้ท่ีท่ีมีสถานีวดัน า้ฝนเท่านัน้ แตใ่นพืน้ท่ีท่ีไม่มีสถานีวดัน า้ฝนก็ไม่อาจทราบปริมาณฝนได้ 
ซึ่งการประยุกต์ใช้ข้อมูลปริมาณฝนจากดาวเทียมในบริเวณท่ีไม่มีสถานีวัดน า้ฝน จะท าให้ทราบ
ปริมาณฝนในพืน้ท่ีนัน้ๆ ได้ และเน่ืองด้วยโปรแกรมทางสารสนเทศภูมิศาสตร์จะมีเคร่ืองมือใน            
การประมาณคา่เชิงพืน้ท่ี ซึง่เป็นกระบวนการในการใช้ข้อมลูจดุท่ีทราบคา่ไปประมาณคา่ในจุดหรือ
พืน้ท่ีอ่ืนๆ ท่ียงัไมท่ราบคา่ ผู้วิจยัจงึน า Bias ท่ีค านวณได้ระหว่างปริมาณฝนจากผลิตภณัฑ์น า้ฝนท่ี
ได้จากดาวเทียมกบัฝนภาคพืน้ดิน ณ ต าแหน่งพิกดัสถานีวดัน า้ฝน ไปประมาณคา่เชิงพืน้ท่ีจ านวน 
3 วิธี โดยผู้วิจยัต้องการทราบวา่การประมาณคา่เชิงพืน้ท่ีของ Bias มีวิธีไหนท่ีดีท่ีสดุ 
 
ตาราง 4.5 POD, FAR และ CSI ของผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 ในปี พ.ศ. 2553  
               และ พ.ศ. 2554   
              

พ.ศ. 2553 รวม ธ.ค.-ก.พ. มี.ค.-พ.ค. มิ.ย.-ส.ค. ก.ย.-พ.ย. 
POD 0.90 0.95 0.91 0.86 0.88 
FAR 0.19 0.04 0.19 0.34 0.20 
CSI 0.75 0.92 0.76 0.59 0.74 

พ.ศ. 2554 รวม ธ.ค.-ก.พ. มี.ค.-พ.ค. มิ.ย.-ส.ค. ก.ย.-พ.ย. 
POD 0.88 0.97 0.86 0.81 0.87 
FAR 0.22 0.04 0.30 0.35 0.18 
CSI 0.71 0.93 0.63 0.56 0.74 
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 ตามท่ีได้คัดเลือกข้อมูลไปแล้วนัน้ ท าให้ได้ต าแหน่งสถานีวัดน า้ฝนท่ีใช้ในการศึกษา
จ านวน 78 สถานี จะสุ่มเลือกเป็นจุดตรวจสอบ 30% (23 สถานี) และท่ีเหลืออีก 70% (55 สถานี) 
น าไปประมาณค่าเชิงพืน้ท่ีทัง้ 3 วิธี จากนัน้น าจุดตรวจสอบไปสกัด Bias ออกมาตามขัน้ตอนใน
หวัข้อ 3.4.2 โดยผลลพัธ์จากการหาความตา่ง Bias ท่ีสกดัออกมาด้วยจดุตรวจสอบท่ีท าการสุ่มทัง้ 
30 ครัง้ กบั Bias เดิมของจดุตรวจสอบดงัภาพ 4.9 ยิ่งคา่อยู่ใกล้บริเวณเส้นประแสดงว่าวิธีนัน้ๆ ดี 
พบวา่ทัง้ 2 ปี วิธี Kriging กบั IDW มี Bias ท่ีเกาะกลุม่เส้นประมากกวา่ Spline  
 ตาราง 4.6 เ ม่ือน าผลลัพธ์ของ Bias ท่ีหาความต่างแล้วมาหาค่าเฉล่ียโดยค านึง
เคร่ืองหมาย จากนัน้พิจารณาควบคู่กันทัง้ 2 ปี พบว่าวิธี Kriging มีค่า Bias ต ่าท่ีสุด ดังนัน้                 
การประมาณค่าเชิงพืน้ท่ี ด้วยวิธี Kriging จึงเป็นวิธี ท่ีดี ท่ีสุด รองลงมาคือ Spline และ IDW 
ตามล าดบั และจะเห็นว่า พ.ศ. 2553 วิธี Kriging เป็นวิธีเดียวท่ี Bias เป็นค่าลบ ซึ่งเม่ือผู้ วิจัยได้
ทดลองหาค่าเฉล่ียจากการสุ่ม 10 ครัง้ จะพบว่าวิธี Spline ดีท่ีสุด และถ้าสุ่ม 20 ครัง้ จะพบว่าวิธี 
Kriging เป็นวิธีท่ีดีท่ีสดุ จงึเป็นไปได้วา่จ านวนครัง้ท่ีสุม่มีผลตอ่การหาวิธีท่ีดีท่ีสดุในการประมาณคา่
เชิงพืน้ท่ี 
 
4.4  การปรับแก้ค่าฝนจาก Bias ของข้อมูลปริมาณฝนรายวันจากผลิตภัณฑ์น า้ฝน TRMM 
3B42 V.7 กับฝนภาคพืน้ดนิ 
 ผู้วิจยัได้น าผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 ท่ีได้มาจากข้อมลูดาวเทียม TRMM มาใช้
ในการศกึษาข้อมลูปริมาณฝน แตก่ารจะน าปริมาณฝนจากผลิตภัณฑ์น า้ฝนไปใช้โดยตรง อาจท า
ให้ผลลพัธ์ท่ีได้ไม่มีประสิทธิภาพเท่าท่ีควร เน่ืองจากดาวเทียมมีคณุลกัษณะท่ีครอบคลมุเชิงพืน้ท่ี
ท าให้ทราบปริมาณฝนในพืน้ท่ีท่ีไม่มีสถานีวัดน า้ฝนก็จริง แต่ปริมาณฝนท่ีได้นัน้ เกิดจาก                     
การประมาณค่าก่อนท่ีจะตกลงสู่พืน้ท่ีหนึ่งๆ โดยตรง จึงต้องมีการปรับแก้ค่าฝนของผลิตภัณฑ์
น า้ฝน TRMM 3B42 V.7 นีก้่อน โดยท าการหา Bias จากนัน้น าไปประมาณคา่เชิงพืน้ท่ีตามขัน้ตอน
ในหวัข้อ 3.4.3  
 จากผลการศึกษาในหัวข้อ 4.3 ท าให้ทราบแล้วว่าการประมาณค่าเชิงพืน้ท่ีด้วยวิธี  
Kriging เป็นวิธีท่ีดีท่ีสุด และจากตาราง 4.4 พบว่าในเดือนกันยายนมี Bias สูงสุดเกือบทัง้ 2 ปี 
ดงันัน้ผู้ วิจัยจึงตดัสินใจน าปริมาณฝนสะสมของเดือนกันยายนมาปรับแก้ค่าฝนของผลิตภัณฑ์
น า้ฝน TRMM 3B42 V.7 โดยใช้วิธี Kriging ในการประมาณค่าเชิงพืน้ท่ี ซึ่งกันยายนเป็นเดือนท่ี
มรสมุตะวนัตกเฉียงใต้มีก าลงัแรง รวมทัง้มีพายโุซนร้อนเคล่ือนท่ีเข้ามาทางตะวนัออกของอินโดจีน 
สง่ผลให้คา่ฝนท่ีตรวจวดัได้ในเดือนนีมี้ความส าคญัตอ่การคาดการณ์น า้ทว่ม 
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ตาราง 4.6 ค่าเฉล่ียจากการหาความต่างของ Bias (มิลลิเมตร) ในปี พ.ศ. 2553 และ  
               พ.ศ. 2554   
               

วิธีการประมาณคา่เชิงพืน้ผิว คา่เฉล่ีย 
พ.ศ. 2553 พ.ศ. 2554 

Kriging -7.92 8.37 
IDW 12.66 34.05 

Spline 4.12 32.11 

 

(a) 
 
 
 
 
 
 

 

(b)        
 
 
 

 
 
 
 

 
 
ภาพ 4.9 ความต่างของ Bias ที่สกัดออกมา กับ Bias เดมิของจุดตรวจสอบ (มิลลิเมตร)   
           จากการประมาณค่าเชิงพืน้ท่ีด้วยวิธีต่างๆ (a) พ.ศ. 2553 และ (b) พ.ศ. 2554 
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 ผลลพัธ์ของการปรับแก้ค่าฝนของผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 ในเดือนกันยายน 
ด้วยวิธี Kriging ดงัภาพ 4.10 พบว่าปริมาณฝนสะสมจะอยู่ในช่วง 100-450 มิลลิเมตร โดยในปี 
พ.ศ. 2553 ก่อนปรับแก้ปริมาณฝนท่ีสงูสว่นใหญ่อยูเ่ชียงรายในบริเวณลุม่น า้กกและลุม่น า้โขง และ
ปริมาณฝนท่ีต ่าอยูใ่นล าปางและแพร่เป็นสว่นใหญ่ สว่นหลงัปรับแก้ปริมาณฝนท่ีสงูและต ่ายงัอยู่ใน
บริเวณเดียวกบัก่อนปรับแก้ ส าหรับปี พ.ศ. 2554 ก่อนปรับแก้ปริมาณฝนท่ีสงูอยู่ทางทิศตะวนัออก
ของภาคเป็นส่วนใหญ่ เช่น อตุรดิตถ์และน่าน ซึ่งอยู่ในบริเวณลุ่มน า้น่าน และปริมาณฝนท่ีต ่าส่วน
ใหญ่อยูบ่ริเวณแมฮ่อ่งสอน สว่นหลงัปรับแก้ปริมาณท่ีสงูอยูท่างตอนบนของภาคแตก็่ยงัมีในบริเวณ
อุตรดิตถ์ด้วย และปริมาณฝนท่ีต ่าอยู่ทางตอนใต้ของแม่ฮ่องสอนและเชียงใหม่เป็นส่วนใหญ่                
จะสงัเกตเห็นว่าลกัษณะของช่องกริดระหว่างก่อนปรับแก้และหลงัปรับแก้จะไม่เหมือนเดิม จะมี
บางส่วนหายไป และบางส่วนเพิ่มเข้ามา โดยท่ีก่อนปรับแก้ปี พ.ศ. 2553 จะเหมือนกบัก่อนปรับแก้
ปี พ.ศ. 2554 ซึง่หลงัปรับแก้ก็เป็นลกัษณะเชน่นีท้ัง้ 2 ปี  
 เม่ือน าจดุตรวจสอบร้อยละ 30 ต าแหนง่เดียวกนัจ านวน 23 สถานีทัง้ 2 ปี ไปสกดัปริมาณ
ฝนสะสมเดือนกันยายนจากผลิตภัณฑ์น า้ฝนหลงัปรับแก้ เพ่ือหาความต่างกับปริมาณฝนสะสม
เดือนกันยายนภาคพืน้ดินของจุดตรวจสอบนัน้ๆ พบปัญหาท่ีเกิดขึน้คือ มีจุดตรวจสอบจ านวน               
2 สถานีท่ีไม่มีปริมาณฝนจากผลิตภัณฑ์น า้ฝนนี ้เน่ืองจากอยู่นอกขอบเขตช่องกริด ผู้ วิจัยจึงตดั               
2 สถานีนัน้ทิง้ ท าให้เหลือจุดตรวจสอบท่ีใช้ในครัง้นีจ้ านวน 21 สถานี โดยก่อนอ่ืนผู้ วิจยัจะแสดง 
Bias ของผลิตภัณฑ์น า้ฝนก่อนปรับแก้ก่อน เพ่ือให้เห็นความแตกต่างกับผลิตภัณฑ์น า้ฝนหลัง
ปรับแก้ ดงัภาพ 4.11 พบว่าคา่กระจายตวัเชิงพืน้ท่ีของ Bias มีทัง้คา่บวกและลบ ซึ่งส่วนใหญ่เป็น
คา่บวกโดยมีจ านวน 14 และ 17 สถานี ในปี พ.ศ. 2553 และ พ.ศ. 2554 ตามล าดบั โดยในปี พ.ศ. 
2553 พบวา่ Bias คา่ลบมีคา่เข้าใกล้ศนูย์อยู่ในในช่วง 0-50 มิลลิเมตร จ านวน 3 สถานี ซึง่มากกว่า
ปี พ.ศ. 2554 แสดงถึงปริมาณฝนจากผลิตภณัฑ์น า้ฝนก่อนปรับแก้มีค่าต ่ากว่าฝนภาคพืน้ดินของ
จุดตรวจสอบ และพบว่าปี พ.ศ. 2554 มี Bias ค่าบวกท่ีสูงกว่า 100 มิลลิเมตร ถึง 7 สถานี ซึ่ง
มากกว่าปี พ.ศ. 2553 อยู่ 3 สถานี โดยส่วนใหญ่อยู่ในอุตรดิตถ์บริเวณลุ่มน า้น่าน เม่ือน า Bias             
ทัง้ 2 ปี ท่ีค านวณได้มาหาค่าเฉล่ียโดยไม่ค านึงเคร่ืองหมาย พบว่าเท่ากับ 67.97 และ 95.12 
มิลลิเมตร ในปี พ.ศ. 2553 และ พ.ศ. 2554 ตามล าดบั และภาพ 4.12  Bias ของผลิตภณัฑ์น า้ฝน
หลงัปรับแก้ พบว่าคา่กระจายตวัเชิงพืน้ท่ีของ Bias มีทัง้คา่บวกและลบเช่นกนั ซึ่งในปี พ.ศ. 2553 
จะพบวา่เป็นคา่บวกมากกวา่โดยมีจ านวน 13 สถานี และปี พ.ศ. 2554 จะพบวา่เป็นคา่ลบมากกว่า
มีจ านวน 11 สถานี โดยในปี พ.ศ. 2554 พบว่า Bias ค่าลบมีค่าเข้าใกล้ศูนย์อยู่ในในช่วง 0-50 
มิลลิเมตร จ านวน 7 สถานี ซึ่งมากกว่าปี พ.ศ. 2553 แสดงถึงปริมาณฝนจากผลิตภณัฑ์น า้ฝนหลงั
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ปรับแก้มีคา่ต ่ากว่าฝนภาคพืน้ดินของจดุตรวจสอบ และยงัพบวา่ปี พ.ศ. 2553 มี Bias คา่บวกท่ีสงู
กว่า 100 มิลลิเมตร 4 สถานี ซึ่งถือว่าไม่แตกต่างกับปี พ.ศ. 2554 มากนกั เน่ืองจากปี พ.ศ. 2554  
ก็มีอยู่ 3 สถานี โดย Bias ค่าบวกท่ีสูงกว่า 100 มิลลิเมตรนี ้ปี พ.ศ. 2553 อยู่ในแม่ฮ่องสอน, 
เชียงรายบริเวณลุ่มน า้โขง, น่าน  และแพร่บริเวณลุ่มน า้ยม ส่วนปี พ.ศ. 2554 อยู่บริเวณลุ่มน า้โขง
ในเชียงรายกบัพะเยา และล าปางบริเวณลุ่มน า้วงั โดยเม่ือหาคา่เฉล่ีย Bias ท่ีไม่ค านึงเคร่ืองหมาย
พบวา่เทา่กบั 54.02 และ 64.18 มิลลิเมตร ในปี พ.ศ. 2553 และ พ.ศ. 2554 ตามล าดบั 
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ภาพ 4.10 ผลลัพธ์ของการปรับแก้ค่าฝนของผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 (a) ก่อนปรับแก้ และ (b) หลังปรับแก้ ในปี พ.ศ. 2553, 
              ผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 (c) ก่อนปรับแก้ และ (d) หลังปรับแก้ ในปี พ.ศ. 2554 
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ภาพ 4.11 แผนที่ Bias จากปริมาณฝนสะสมเดือนกันยายน (มิลลิเมตร) ระหว่างผลิตภัณฑ์ 
           น า้ฝนก่อนปรับแก้กับจุดตรวจสอบ 21 สถานี ในพืน้ท่ี 9 จังหวัดภาคเหนือ (a)  

              พ.ศ. 2553 และ (b) พ.ศ. 2554  
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ภาพ 4.12 แผนที่ Bias จากปริมาณฝนสะสมเดือนกันยายน (มิลลิเมตร) ระหว่างผลิตภัณฑ์ 
           น า้ฝนหลังปรับแก้กับจุดตรวจสอบ 21 สถานี ในพืน้ท่ี 9 จังหวัดภาคเหนือ (a)  

              พ.ศ. 2553 และ (b) พ.ศ. 2554



 
 

 

บทที่  5 
 

บทสรุป 
 

การศกึษาเปรียบเทียบปริมาณฝนรายวนัระหวา่งผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 จาก
ข้อมลูดาวเทียม TRMM กบัข้อมลูฝนภาคพืน้ดนิของกรมอตุนุิยมวิทยา ในพืน้ท่ี 9 จงัหวดัภาคเหนือ
ของประเทศไทย โดยใช้วิธีการทางสถิติ และเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีของ Bias ท่ีดี
ท่ีสุด ซึ่งการศึกษาในครัง้นีผู้้ วิจยัมุ่งเน้นท่ี Bias เป็นส าคญั เน่ืองจากจะท าให้ทราบว่าปริมาณฝน
ระหว่างผลิตภัณฑ์น า้ฝนกับฝนภาคพืน้ดินมีความแตกต่างกันอย่างไร เพ่ือเป็นประโยชน์ใน               
การตดัสินใจตอ่การน าผลิตภณัฑ์น า้ฝนนีไ้ปใช้   
 
5.1  สรุปผลการวิจัย  
 จากการเปรียบเทียบข้อมลูปริมาณฝนรายวนัด้วยวิธีการทางสถิติทัง้หมด 6 สมการ ได้แก่ 
Bias, RMSD และ MAD ในการตรวจสอบความน่าเช่ือถือของข้อมูล กับ POD, FAR และ CSI              
ในการตรวจสอบคุณภาพของผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 รวมทัง้เปรียบเทียบวิธีการ
ประมาณค่าเชิงพืน้ท่ีจ านวน 3 วิ ธี  ได้แก่ Kriging, IDW และ Spline แบบ Regularized ด้วย
เคร่ืองมือท่ีมีในโปรแกรมทางสารสนเทศภมูิศาสตร์ เพ่ือหาวิธีท่ีดีท่ีสดุ สามารถสรุปผลการวิจยัตาม
วตัถปุระสงค์ได้ ดงันี ้ 
 

5.1.1  ศึกษาความแตกต่างของปริมาณฝนรายวันระหว่างผลิตภัณฑ์น า้ฝนจาก
ข้อมูลดาวเทียมกับข้อมูลฝนภาคพืน้ดนิด้วยวิธีการทางสถติ ิ 
 1)  ตรวจสอบความนา่เช่ือถือของข้อมลู 
 เม่ือตรวจสอบโดยใช้ปริมาณฝนรายวนั พบวา่สว่นใหญ่ปี พ.ศ. 2554 มีปริมาณฝนสงูกว่า
ปี พ.ศ. 2553 และปริมาณฝนจากผลิตภัณฑ์น า้ฝนมีค่าสูงกว่าฝนภาคพืน้ดินทัง้ 2 ปี โดยพบว่าปี 
พ.ศ. 2553 มีค่าต ่าสุดและค่าสูงสุดจากผลค านวณ Bias, RMSD และ MAD ต ่ากว่าปี พ.ศ. 2554 
แสดงให้เห็นวา่ปี พ.ศ. 2553 ข้อมลูมีความนา่เช่ือถือมากกวา่  
 เม่ือตรวจสอบโดยใช้ปริมาณฝนสะสมรายเดือน พบว่าปริมาณฝนสูงสุดของผลิตภัณฑ์
น า้ฝนและฝนภาคพืน้ดินในปี พ.ศ. 2553 อยู่ในเดือนสิงหาคม ส่วนปี พ.ศ. 2554 ของผลิตภัณฑ์
น า้ฝนอยู่ในเดือนกันยายน และฝนภาคพืน้ดินอยู่ในเดือนสิงหาคม โดยทัง้ 2 ปี มีหลายเดือนท่ีฝน
จากผลิตภณัฑ์น า้ฝนจะตรวจวดัปริมาณฝนได้สงูกวา่ฝนภาคพืน้ดิน ซึง่ปี พ.ศ. 2554 จะมีความตา่ง
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ของปริมาณฝนค่อนข้างมากกว่า ผลค านวณพบว่าทัง้ 2 ปี Bias, RMSD และ MAD มีค่าต ่าอยู่
ในชว่งเดือนท่ีมีปริมาณฝนน้อยหรือฤดหูนาว และมีคา่สงูอยูใ่นช่วงเดือนท่ีมีปริมาณฝนมากหรือฤดู
ฝน แสดงให้เห็นวา่ข้อมลูในชว่งเดือนท่ีมีปริมาณฝนน้อยหรือฤดหูนาวมีความนา่เช่ือถือมากกว่า  
 เม่ือตรวจสอบโดยใช้ปริมาณฝนสะสมรายปี พบว่าปี พ.ศ. 2553 มีความสัมพันธ์กัน
ระหวา่งปริมาณฝนจากผลิตภณัฑ์น า้ฝนและฝนภาคพืน้ดินมากกวา่ปี พ.ศ. 2554 ในแตล่ะต าแหน่ง
สถานีวดัน า้ฝนจากการค านวณ Bias พบวา่เป็นคา่บวกโดยสว่นใหญ่ โดยปี พ.ศ. 2553 พบวา่ Bias 
คา่ลบมีคา่เข้าใกล้ศนูย์มากกวา่ปี พ.ศ. 2554 และในปี พ.ศ. 2554 พบว่ามี Bias คา่บวกท่ีมากกวา่ 
600 มิลลิเมตร มากกว่าปี พ.ศ. 2553 ส่วนการค านวณ RMSD และ MAD ผลการศึกษาท่ีพบมี
ลกัษณะเชน่เดียวกนัทกุประการ โดยปี พ.ศ. 2553 มีคา่เข้าใกล้ศนูย์มากกว่าปี พ.ศ. 2554 และในปี 
พ.ศ. 2554 พบว่ามีคา่ท่ีสงูกว่า 450 มิลลิเมตร มากกว่าปี พ.ศ. 2553 แสดงให้เห็นว่าปี พ.ศ. 2553 
ข้อมลูมีความนา่เช่ือถือมากกวา่ 
 2)  ตรวจสอบคณุภาพของผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 
 การค านวณ POD, FAR และ CSI ทัง้ 2 ปี คา่ของ FAR และ CSI แทบไมต่า่งกนั กลา่วคือ
ทัง้ 2 ปี ดาวเทียม TRMM มีอตัราการแจ้งเตือนท่ีผิดพลาดและดชันีความส าเร็จไม่ตา่งกนันกั และ
พบว่าผลิตภัณฑ์น า้ฝนมีคณุภาพสงูท่ีสดุในช่วงเดือนธันวาคม-กุมภาพนัธ์ และมีคณุภาพต ่าท่ีสดุ
ในชว่งเดือนมิถนุายน-สิงหาคมอีกเช่นเดียวกนั แสดงให้เห็นวา่ผลิตภณฑ์น า้ฝนมีคณุภาพสงูในช่วง
ท่ีมีปริมาณฝนน้อยหรือฤดหูนาว 

5.1.2  เปรียบเทียบวิธีการประมาณค่าเชิงพืน้ท่ีของ Bias ที่ดีที่สุด  
เม่ือท าการสุม่จดุตรวจสอบ 30 ครัง้ จากนัน้พิจารณาคา่เฉล่ีย Bias โดยค านงึเคร่ืองหมาย

ควบคู่กันทัง้ 2 ปี พบว่าการประมาณค่าเชิงพืน้ท่ีด้วยวิธี Kriging เป็นวิธีท่ีดีท่ีสุด และเม่ือสุ่ม 10 
ครัง้ จะพบว่าวิธี Spline ดีท่ีสดุ ถ้าเพิ่มจ านวนครัง้ท่ีสุ่มอีกเป็นจ านวน 20 ครัง้ จะพบว่าวิธี Kriging 
เป็นวิธีท่ีดีท่ีสุด แสดงให้เห็นว่าจ านวนครัง้ท่ีสุ่มมีผลต่อการหาวิธีท่ีดีท่ีสุดในการประมาณค่าเชิง
พืน้ท่ีด้วยเชน่กนั เน่ืองจากการสุม่เพียงครัง้เดียว จะท าให้ได้คา่สถิตท่ีิยงัไมน่ิ่งพอจะน ามาสรุปได้ 
 

จากการศกึษาตามวตัถปุระสงค์ทัง้ 2 ข้อ ท าให้ผู้วิจยัได้ศกึษาการปรับแก้คา่ฝนจาก Bias 
ในเดือนกันยายนระหว่างผลิตภัณฑ์น า้ฝน TRMM 3B42 V.7 กับฝนภาคพืน้ดินเพิ่มเติมด้วย 
เน่ืองจากการน าผลิตภัณฑ์น า้ฝนไปใช้โดยตรงอาจท าให้ได้ผลลพัธ์ท่ีไม่มีประสิทธิภาพเท่าท่ีควร 
โดยต้องการทราบว่าผลิตภณัฑ์น า้ฝนก่อนปรับแก้และหลงัปรับแก้จะมีคา่ฝนเป็นอย่างไร ซึ่งพบว่า
ในปี พ.ศ. 2553 ส่วนใหญ่ปริมาณฝนท่ีสูงและต ่าของก่อนปรับแก้และหลังปรับแก้อยู่ในบริเวณ
เดียวกนั ส าหรับปี พ.ศ. 2554 ปริมาณฝนท่ีสงูของหลงัปรับแก้มีมากขึน้กวา่ก่อนปรับแก้หลาย 
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บริเวณ และปริมาณฝนท่ีต ่ายังอยู่ในบริเวณเดียวกัน โดยจะสังเกตเห็นว่าลักษณะช่องกริดก่อน
ปรับแก้จะเหมือนกันทัง้ 2 ปี ซึ่งหลงัปรับแก้ก็เป็นลกัษณะเช่นนี ้เม่ือหา Bias ระหว่างปริมาณฝน
สะสมเดือนกนัยายนจากผลิตภณัฑ์น า้ฝนหลงัปรับแก้กบัฝนภาคพืน้ดินของแตล่ะต าแหนง่สถานีวดั
น า้ฝนท่ีใช้เป็นจุดตรวจสอบ พบว่าในปี พ.ศ. 2553 เป็น Bias ค่าบวกมากกว่า และปี พ.ศ. 2554 
เป็น Bias คา่ลบมากกวา่ โดยปี พ.ศ. 2554 Bias คา่ลบมีคา่เข้าใกล้ศนูย์มากกวา่ปี พ.ศ. 2553 และ
ยังพบว่า Bias ค่าบวกท่ีสูงกว่า 100 มิลลิเมตร ของทัง้  2 ปี ไม่แตกต่างกันนัก จากนัน้เ ม่ือ
เปรียบเทียบ Bias ของผลิตภัณฑ์น า้ฝนระหว่างก่อนปรับแก้และหลงัปรับแก้กับจุดตรวจสอบ 21 
สถานี จะพบว่าในปี พ.ศ. 2553 ท่ีเป็นค่าลบยงัมี 1 สถานี ในเชียงใหม่ และค่าบวกมี 1 สถานี ใน
แพร่ ท่ีทัง้ก่อนปรับแก้และหลงัปรับแก้ Bias ยงัสงูกวา่ 100 มิลลิเมตร เชน่เดมิ ส าหรับปี พ.ศ. 2554 
ก็เช่นกนัคา่ลบยงัมี 1 สถานี ในเชียงใหม่ และคา่บวกมีในเชียงราย, พะเยา และล าปาง จงัหวดัละ  
1 สถานี ซึ่งจากค่าเฉล่ีย Bias ท่ีไม่ค านึงเคร่ืองหมายจะพบว่า Bias ของผลิตภัณฑ์น า้ฝนหลัง
ปรับแก้มีคา่ต ่าลงเม่ือเทียบกับผลิตภณัฑ์น า้ฝนก่อนปรับแก้ทัง้ 2 ปี โดยปี พ.ศ. 2553 จะต ่ากว่าปี 
พ.ศ. 2554 
 
5.2  อภปิรายผลการวิจัย 
 การเปรียบเทียบข้อมลูปริมาณฝนรายวนัจากผลิตภณัฑ์น า้ฝนกบัฝนภาคพืน้ดนิ พบวา่ผล
การค านวณ Bias, RMSD และ MAD มีค่าแตกต่างกันไปในแต่ละปีตามปริมาณฝน ซึ่งโดยส่วน
ใหญ่ปริมาณฝนจากผลิตภัณฑ์น า้ฝนมีค่าสูงกว่าฝนภาคพืน้ดิน สอดคล้องกับสถิตย์ จนัทร์ทิพย์ 
(2558) ท่ีพบว่าข้อมูลฝนตรวจวัดด้วยดาวเทียม TRMM และดาวเทียม GSMaP มีแนวโน้มให้ค่า
ปริมาณฝนมากกว่าค่าปริมาณฝนตรวจวัดจริงจากสถานีภาคพืน้ดิน เม่ือเปรียบเทียบแล้วความ
แตกตา่งของปริมาณฝนจะมีค่าสงูในปี พ.ศ. 2554 ซึ่งในปีนีป้ระเทศไทยประสบกับปัญหาน า้ท่วม
ครัง้ใหญ่ และในปี พ.ศ. 2553 ปริมาณฝนจากผลิตภณัฑ์น า้ฝนกับฝนภาคพืน้ดินมีคา่ใกล้เคียงกัน 
เม่ือจ าแนกเป็นรายจงัหวดัพบว่าปี พ.ศ. 2553 ผลค านวณ Bias ท่ีมีคา่ต ่าสดุอยู่ท่ีล าปาง และอยู่ท่ี
แพร่ในปี พ.ศ. 2554 ส่วน RMSD และ MAD มีค่าต ่าสุดอยู่ท่ีเชียงใหม่และล าพูน ตามล าดับ
เช่นเดียวกันทัง้ 2 ปี และเม่ือศึกษาปริมาณฝนสะสมรายเดือนจะพบว่าทัง้ 2 ปี ปริมาณฝน
ภาคพืน้ดินสูงสุดอยู่ในเดือนสิงหาคมเช่นเดียวกัน สอดคล้องกับสุจริต คูณธนกุลวงศ์ และคณะ 
(2550) ท่ีได้อธิบายว่าบริเวณประเทศไทยตอนบนเม่ือเข้าสู่ฤดฝูนปริมาณฝนจะเพิ่มขึน้มาก โดยจะ
มีปริมาณฝนมากท่ีสุดในเดือนสิงหาคมหรือกันยายน ส่วนปริมาณฝนจากผลิตภัณฑ์น า้ฝนในปี 
พ.ศ. 2553 สูงสุดในเดือนสิงหาคม และปี พ.ศ. 2554 สูงสุดในเดือนกันยายน ซึ่งเม่ือค านวณแล้ว
พบว่าทัง้ 2 ปี ข้อมลูมีความน่าเช่ือถือในเดือนมกราคม, กมุภาพนัธ์, พฤศจิกายน และธันวาคม ซึ่ง
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เป็นเดือนท่ีมีปริมาณฝนน้อยหรือฤดหูนาว และเม่ือมุง่ไปท่ี Bias จะพบวา่ปริมาณฝนจากผลิตภณัฑ์
น า้ฝนจะตรวจวดัปริมาณฝนได้สงูกว่าฝนภาคพืน้ดินหลายเดือนโดยปี พ.ศ. 2554 คา่ความตา่งใน
แตล่ะเดือนคอ่นข้างสงูกว่าปี พ.ศ. 2553 อีกทัง้ Bias ท่ีมีคา่ลบจะเกิดขึน้ในช่วงท่ีมีปริมาณฝนน้อย 
ยกเว้นเดือนสิงหาคม และตลุาคม ท าให้เห็นว่าความสมัพันธ์ระหว่างปริมาณฝนจากผลิตภัณฑ์
น า้ฝนและฝนภาคพืน้ดินในปี พ.ศ. 2553 มีความน่าเช่ือถือมากกว่าปี พ.ศ.  2554 ในส่วน                    
การค านวณทางสถิติ POD, FAR และ CSI เพ่ือตรวจสอบคุณภาพของผลิตภัณฑ์น า้ฝน TRMM 
3B42 V.7 พบว่าผลิตภณฑ์น า้ฝนมีคุณภาพดีในช่วง เดือนท่ีมีปริมาณฝนน้อย โดยทัง้  2 ปี 
ผลิตภณัฑ์น า้ฝนมีคณุภาพสงูท่ีสดุในช่วงเดือนธนัวาคม-กมุภาพนัธ์ ในทางกลบักนัจะมีคณุภาพต ่า
ท่ีสุดในช่วงเดือนมิถุนายน-สิงหาคม ซึ่งเป็นช่วงฤดูฝนมีปริมาณฝนมาก จากงานวิจัยของ 
Chokngamwong and  Chiu (2008) จะพบวา่การเปรียบเทียบผลิตภณัฑ์น า้ฝน TRMM 3B42 V.5 
และ V.6 โดยใช้ข้อมลูปริมาณฝน 5 ปี ผลิตภณัฑ์น า้ฝนมีคณุภาพดีในชว่งเดือนมิถนุายน-สิงหาคม 
โดย TRMM 3B42 V.5 มี POD, FAR และ CSI เท่ากับ 0.97, 0.29 และ 0.70 ตามล าดับ และ 
TRMM 3B42 V.6 มีค่าเท่ากับ 0.90, 0.26 และ 0.69 ตามล าดบั ผลท่ีได้พบว่าผลิตภัณฑ์น า้ฝนมี
คุณภาพดีในช่วงเดือนท่ีต่างกับงานวิจัยนี ้แต่ผลค านวณ POD, FAR และ CSI ในช่วงเดือน
มิถุนายน-สิงหาคม แม้ในงานวิจยันีจ้ะเป็นช่วงท่ีผลิตภัณฑ์น า้ฝนมีคุณภาพต ่าท่ีสุด โดย TRMM 
3B42 V.7 มีคา่ POD, FAR และ CSI เทา่กบั 0.86, 0.34 และ 0.59 ตามล าดบัในปี พ.ศ. 2553 และ
ในปีพ.ศ. 2554 เท่ากบั 0.81, 0.35 และ 0.56 ตามล าดบั ก็ถือว่าผลิตภณัฑ์น า้ฝนมีคณุภาพดีเม่ือ
เปรียบเทียบกนั เพราะผลค านวณมีความแตกตา่งกนัน้อย แสดงให้เห็นว่าผลิตภณัฑ์น า้ฝน TRMM 
3B42 V.7 มีการพฒันาอลักอริทมึให้มีประสิทธิภาพมากยิ่งขึน้ ซึง่ถือวา่สามารถน าผลิตภณัฑ์น า้ฝน
นีไ้ปประยกุต์ใช้ได้ เพราะผลค านวณในชว่งเดือนท่ีผลิตภณัฑ์น า้ฝนมีคณุภาพต ่าท่ีสดุก็ไม่ได้แย่เม่ือ
เทียบกบัคา่ท่ีได้ก าหนดไว้วา่ผลิตภณัฑ์น า้ฝนท่ีมีคณุภาพสงูจะมี POD = 1, FAR = 0 และ CSI = 1  
 ส าหรับการเปรียบเทียบวิธีการประมาณคา่เชิงพืน้ท่ีของ Bias ท่ีดีท่ีสดุ พบว่าวิธี Kriging 
ดีท่ีสุด สอดคล้องกับงานวิจยัของสญัชยั เอ่ียมประเสริฐ (2554) ท่ีศึกษาเก่ียวกับการเปรียบเทียบ
วิธีการประมาณค่าปริมาณน า้ฝนรายวนั ด้วยระบบสารสนเทศภูมิศาสตร์บริเวณพืน้ท่ีราบลุ่มน า้
เจ้าพระยา โดยใช้วิธีการประมาณคา่ พบวา่วิธี Kriging มี Mean Absolute Error (MAE) น้อยท่ีสดุ 
ซึ่งถ้าจ านวนครัง้ในการสุม่เลือกจดุตรวจตอบแตกตา่งกนัไป อาจจะได้ผลลพัธ์เป็นการประมาณคา่
เชิงพืน้ท่ีวิธีอ่ืนท่ีไม่ใช่วิธี Kriging โดยการสุ่มเลือกหลายๆ ครัง้จะท าให้ได้ผลลพัธ์ท่ีน่าเช่ือถือมาก
ยิ่งขึน้ 
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การปรับแก้คา่ฝนจาก Bias ในเดือนกนัยายนระหว่างผลิตภณัฑ์น า้ฝน TRMM 3B42 V.7 
กบัฝนภาคพืน้ดนิ พบวา่ในปี พ.ศ. 2553 ผลิตภณัฑ์น า้ฝนทัง้ก่อนปรับแก้และหลงัปรับแก้ มีปริมาณ
ฝนท่ีสงูและต ่าอยู่บริเวณเดียวกนั ส่วนปี พ.ศ. 2554 ปริมาณฝนท่ีสงูของหลงัปรับแก้มีเพิ่มมากขึน้
หลายบริเวณ และปริมาณฝนท่ีต ่ายงัอยู่ในบริเวณเดียวกัน เม่ือเปรียบเทียบ Bias ของผลิตภัณฑ์
น า้ฝนระหว่างก่อนปรับแก้และหลังปรับแก้กับต าแหน่งสถานีวัดน า้ฝนท่ีใช้เป็นจุดตรวจสอบ 21 
สถานี จะพบวา่ทัง้ 2 ปี ยงัมีบางสถานีท่ี Bias ยงัเทา่เดมิ และมีอีกหลายสถานีท่ี Bias เปล่ียนแปลง 
ซึ่งมีทัง้เพิ่มขึน้และลดลงแตกต่างกัน โดยจากค่าเฉล่ีย Bias ท่ีไม่ค านึงเคร่ืองหมายจะพบว่า Bias 
ของผลิตภณัฑ์น า้ฝนหลงัปรับแก้มีคา่ต ่าลงเม่ือเทียบกบัผลิตภณัฑ์น า้ฝนก่อนปรับแก้ทัง้ 2 ปี โดยปี 
พ.ศ. 2553 จะต ่ากว่าปี พ.ศ. 2554 แสดงให้เห็นว่าข้อมูลจากปริมาณฝนรายวันในปี พ.ศ. 2553            
มีความน่าเช่ือถือมากกว่า ซึ่งในการจะน าผลิตภัณฑ์น า้ฝนไปประยุกต์ใช้ควรมีการปรับแก้ค่าฝน
ก่อน และควรจะปรับแก้ทกุครัง้เม่ือจะน าไปใช้ โดยเทียบกบัฝนภาคพืน้ดิน เป็นต้น เพ่ือให้ผลลพัธ์มี
ประสิทธิภาพมากย่ิงขึน้ 
 
5.3  ข้อเสนอแนะ 
 1)  งานวิจัยครัง้นีไ้ม่ได้วิเคราะห์ปัจจัยทางกายภาพท่ีส่งผลต่อการเกิดฝน หากมี                  
การวิเคราะห์จะท าให้เข้าใจสาเหตขุองการเกิดฝน และปริมาณฝนท่ีมีในแตล่ะปีได้มากยิ่งขึน้  
 2)  ควรมีการศึกษาปริมาณฝนรายวันท่ีเป็นสาเหตุของการเกิดน า้ท่วม เพ่ือตรวจสอบ
คณุภาพการวดัปริมาณฝนของดาวเทียม TRMM  
 3)  การประมาณค่าเชิงพืน้ท่ียังมีวิธีอ่ืนนอกจากนี ้ ถ้าน ามาเปรียบเทียบด้วยจะท าให้
ได้ผลการศกึษาท่ีหลากหลายยิ่งขึน้ โดยในพืน้ท่ีหนึ่งอาจพบว่าวิธีนัน้ดีท่ีสดุ แตเ่ม่ือน าไปใช้กับอีก
พืน้ท่ีหนึง่ท่ีมีความแตกตา่งกนัวิธีนัน้อาจไมใ่ชว่ิธีท่ีดีท่ีสดุก็ได้ ซึง่ขึน้อยูก่บัแตล่ะพืน้ท่ีด้วย  
 4)  งานวิจยัครัง้ต่อไปควรจะใช้ข้อมูลปริมาณฝน 5 ปี หรือมากกว่า จะท าให้ผลลัพธ์มี
ความน่าเช่ือถือมากยิ่งขึน้ และน าผลิตภัณฑ์น า้ฝนแต่ละเวอร์ชั่นมาเปรียบเทียบกัน เพ่ือให้เห็น
ความแตกตา่ง รวมทัง้มีการปรับแก้คา่ฝนเปรียบเทียบให้เห็นระหวา่งก่อนปรับแก้และหลงัปรับแก้ 
 5)  ผลิตภัณฑ์น า้ฝนท่ีได้จากการประมาณค่านัน้มีหน่วยงานวิจยัหลายแห่งท่ีจดัท าให้ 
เช่น GSMaP และมีการพฒันาอลักอริทึมหลายเวอร์ชัน่ จึงเป็นท่ีน่าสนใจในการศกึษาเปรียบเทียบ
ความถกูต้องของผลิตภณัฑ์เหลา่นีก้บัข้อมลูดาวเทียม TRMM ซึง่อาจเป็นประโยชน์กบัสาธารณชน
ตอ่ไป
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ภาคผนวก  ก  ข้อมูลสถานีวัดน า้ฝนท่ีใช้ในการศึกษาและท่ีถูกตัดออก 
 

ตารางสถานีวดัน า้ฝนท่ีใช้ในการศกึษาซึง่แปลงเป็นองศาทศนิยมแล้ว 
 

ล าดบั จงัหวดั ช่ือสถานี  รหสัสถานี  ละตจิดู ลองจิจดู 
1 แมฮ่อ่งสอน สตอ.แมฮ่อ่งสอน 300201 19.30 97.97 
2 แมฮ่อ่งสอน สตอ.แมส่ะเรียง 300202 18.17 97.93 
3 แมฮ่อ่งสอน อ าเภอขนุยวม 300001 18.83 97.93 
4 แมฮ่อ่งสอน อ าเภอแมล่าน้อย 300003 18.33 97.97 
5 เชียงราย สตอ.เชียงราย 303201 19.96 99.88 
6 เชียงราย สกษ.เชียงราย 303301 19.87 99.78 
7 เชียงราย อ าเภอเชียงของ 303001 20.20 100.42 
3 เชียงราย อ าเภอพาน 303002 19.55 99.75 
9 เชียงราย อ าเภอแมจ่นั 303005 20.10 99.87 
10 เชียงราย อ าเภอเทิง 303007 19.67 100.20 
11 เชียงราย ท่ีท าการไปรษณีย์เชียงแสน 303008 20.22 100.08 
12 เชียงราย สถานีทดลองข้าวพาน 303009 19.53 99.73 
13 เชียงราย สวนสกัก่ิวทพัยัง้ อ.แมจ่นั 303010 20.12 99.87 
14 เชียงราย สวนป่าดอยตงุ อ.แมฟ่้า

หลวง 
303011 20.23 99.93 

15 เชียงราย ศนูย์พฒันาและสงเคราะห์
ชาวเขา อ.แมจ่นั 

303013 20.22 99.77 

16 เชียงราย อ าเภอเวียงชยั 303015 19.92 99.92 
17 เชียงราย อ าเภอป่าแดด 303016 19.52 100.00 
18 พะเยา สตอ.พะเยา 310201 19.16 99.92 
19 พะเยา อ าเภอเชียงค า 310003 19.52 100.30 
20 พะเยา อ าเภอจนุ 310005 19.33 100.13 
21 พะเยา อ าเภอแมใ่จ 310006 19.33 99.83 
22 พะเยา อ าเภอภซูาง 310008 19.61 100.35 
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ตารางสถานีวดัน า้ฝนท่ีใช้ในการศกึษาซึง่แปลงเป็นองศาทศนิยมแล้ว (ตอ่) 
 

ล าดบั จงัหวดั ช่ือสถานี  รหสัสถานี  ละตจิดู ลองจิจดู 
23 พะเยา สถานีวิจยัทดสอบพนัธุ์สตัว์

พะเยา 
310009 19.06 99.94 

24 เชียงใหม ่ สตอ.ดอยอ่างขาง 327202 19.93 99.05 
25 เชียงใหม ่ ศนูย์อตุนุิยมวิทยาภาคเหนือ 327501 18.77 98.97 
26 เชียงใหม ่ อ าเภอฝาง 327001 19.92 99.23 
27 เชียงใหม ่ อ าเภอจอมทอง 327003 18.42 98.67 
28 เชียงใหม ่ อ าเภออมก๋อย           327008 17.80 98.37 
29 เชียงใหม ่ อ าเภอสะเมิง 327009 18.82 98.77 
30 เชียงใหม ่ อ าเภอสารภี 327011 18.72 99.05 
31 เชียงใหม ่ อ าเภอสนัทราย 327012 18.85 99.05 
32 เชียงใหม ่ อ าเภอเชียงดาว 327016 19.37 98.98 
33 เชียงใหม ่ สถานีทดลองพืชสวนฝาง 327019 19.93 99.15 
34 เชียงใหม ่ อทุยานแหง่ชาติดอยสเุทพ-

ปยุ อ.เมือง 
327020 18.78 98.93 

35 เชียงใหม ่ พระต าหนกัภพูิงค์ราชนิเวศน์ 
อ.เมือง 

327021 18.78 98.90 

36 เชียงใหม ่ นิคมสร้างตนเองเข่ือนภมูิพล 
อ.ดอยเตา่ 

327022 17.93 98.68 

37 เชียงใหม ่ ศนูย์วิจยัข้าวเชียงใหม ่อ.สนั
ป่าตอง 

327024 18.60 98.89 

38 เชียงใหม ่ สถานีวิจยัลุม่น า้ดอยเชียง
ดาว 

327026 19.35 98.77 

39 เชียงใหม ่ สถานีทดลองปลกูพรรณไม้
บอ่แก้ว อ.ฮอด 

327027 18.15 98.40 

40 ล าปาง สตอ.ล าปาง 328201 18.28 99.51 
41 ล าปาง สอต.เถิน 328202 17.64 99.24 
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ตารางสถานีวดัน า้ฝนท่ีใช้ในการศกึษาซึง่แปลงเป็นองศาทศนิยมแล้ว (ตอ่) 
 

ล าดบั จงัหวดั ช่ือสถานี  รหสัสถานี  ละตจิดู ลองจิจดู 
42 ล าปาง สกษ.ล าปาง 328301 18.32 99.28 
43 ล าปาง อ าเภอแมท่ะ 328002 18.13 99.52 
44 ล าปาง อ าเภอเถิน 328005 17.58 99.27 
45 ล าปาง อ าเภอเกาะคา 328006 18.18 99.40 
46 ล าปาง อ าเภอสบปราบ 328007 17.82 99.35 
47 ล าปาง อ าเภอวงัเหนือ 328008 19.15 99.62 
48 ล าปาง อ าเภอแมพ่ริก 328009 17.45 99.12 
49 ล าปาง สวนป่าทุง่เกวียน อ.ห้างฉตัร 328011 18.38 99.22 
50 ล าปาง สวนป่าแมม่าย อ.เมือง 328012 18.52 99.67 
51 ล าปาง สวนป่าแมเ่มาะ อ.เมือง 328013 18.45 99.70 
52 ล าปาง สวนป่าแมจ่าง อ.แมท่ะ 328014 18.28 99.73 
53 ล าปาง สวนป่าแมท่รายค า อ.เมือง 328015 18.50 99.53 
54 ล าพนู สตอ.ล าพนู 329201 18.57 99.03 
55 ล าพนู อ าเภอบ้านโฮง่ 329005 18.32 98.83 
56 ล าพนู โรงเรียนบ้านก้อจดัสรร อ.ลี ้ 329006 17.63 98.78 
57 แพร่ สตอ.แพร่ 330201 18.17 100.17 
58 แพร่ อ าเภอร้องกวาง 330002 18.33 100.33 
59 แพร่ อ าเภอเดน่ชยั 330004 17.98 100.05 
60 แพร่ อ าเภอสอง 330005 18.47 100.18 
61 แพร่ สวนป่าขนุแมค่ ามี อ.ร้อง

กวาง 
330008 18.38 100.37 

62 นา่น สตอ.นา่น 331201 18.78 100.78 
63 นา่น สกษ.นา่น 331301 18.87 100.75 
64 นา่น สอท.ทา่วงัผา 331401 19.11 100.80 
65 นา่น สอท.ทุง่ช้าง 331402 19.41 100.89 
66 นา่น อ าเภอนาน้อย 331002 18.33 100.72 
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ตารางสถานีวดัน า้ฝนท่ีใช้ในการศกึษาซึง่แปลงเป็นองศาทศนิยมแล้ว (ตอ่) 
 

ล าดบั จงัหวดั ช่ือสถานี  รหสัสถานี  ละตจิดู ลองจิจดู 
67 นา่น อ าเภอปัว 331003 19.18 100.92 
68 นา่น อ าเภอเวียงสา 331004 18.58 100.75 
69 นา่น อ าเภอแมจ่ริม 331006 18.70 101.00 
70 นา่น อ าเภอสองแคว 331009 19.35 100.75 
71 นา่น อ าเภอบ้านหลวง 331010 18.85 100.45 
72 อตุรดติถ์ สตอ.อตุรดิตถ์ 351201 17.62 100.10 
73 อตุรดติถ์ สนง.เกษตร อ.พิชยั 351001 17.23 100.10 
74 อตุรดติถ์ สนง.เกษตร อ.ทา่ปลา 351004 17.65 100.38 
75 อตุรดติถ์ อ าเภอบ้านโคก 351007 18.02 101.07 
76 อตุรดติถ์ อ าเภอทองแสนขนั 351008 17.47 100.37 
77 อตุรดติถ์ นิคมสร้างตนเองล าน า้นา่น 

อ.ทา่ปลา 
351009 17.75 100.28 

78 อตุรดติถ์ นิคมสหกรณ์ฟากทา่ 351010 17.90 100.82 
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ตารางสถานีวดัน า้ฝนท่ีถกูตดัออกซึง่แปลงเป็นองศาทศนิยมแล้ว 
 

ล าดบั จงัหวดั ช่ือสถานี  รหสัสถานี  ละตจิดู ลองจิจดู 
1 แมฮ่อ่งสอน สถานีทดลองข้าวไร่และ

ธญัพืชเมืองหนาว ปางมะผ้า 
300004 19.53 98.22 

2 เชียงราย สวนป่าดอยช้าง อ.เมือง 303012 19.80 99.68 
3 เชียงใหม ่ อ าเภอสนัป่าตอง 327014 18.62 98.90 
4 แพร่ อ าเภอลอง 330001 18.07 99.83 
5 แพร่ อ าเภอสงูเมน่ 330003 18.05 100.12 
6 แพร่ อ าเภอวงัชิน้ 330006 17.90 99.60 
7 นา่น อ าเภอเชียงกลาง 331005 19.28 100.88 
8 นา่น อทุยานแหง่ชาติดอยภคูา 

อ.ปัว 
331008 19.18 100.98 

9 อตุรดติถ์ ส านกังานเกษตร อ.น า้ปาด 351003 17.67 100.68 
10 อตุรดติถ์ อทุยานแหง่ชาตภิสูอยดาว 

ต.ห้วยมุน่ 
351012 17.75 100.92 
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ภาคผนวก  ข  การสุ่มเลือกจุดตรวจสอบโดยใช้ Python ในโปรแกรมทางสารสนเทศ 
                   ภูมิศาสตร์ 
 

โค้ด SelectRandomByPercent นีจ้ะค านวณจากจ านวนจุดตรวจสอบท่ีระบุในรูปแบบ
ร้อยละตามท่ีต้องการสุ่มเลือก โดยถ้าระบุร้อยละท่ีมากกว่า 100 หรือระบุร้อยละท่ีน้อยกว่า 0 
โปรแกรมจะแจ้งเตือนและให้กลบัไประบใุหมอี่กครัง้ 
 

 
 
หมายเหตุ: โค้ดนีไ้ด้มาจากเว็บไซต์ http://gis.stackexchange.com/questions/78251/how-to-  
                  randomly-subset-x-of-selected-points 
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ภาคผนวก  ค  ภาพการบรรยายการประชุมวิชาการ “ทรัพยากรธรรมชาต ิสารสนเทศ   
                   ภูมศิาสตร์ และส่ิงแวดล้อม” ครัง้ที่ 1 วันท่ี 3 พฤศจิกายน 2559 ณ คณะ 
                   เกษตรศาสตร์ ทรัพยากรธรรมชาต ิและส่ิงแวดล้อม 
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การเปรียบเทยีบปริมาณน า้ฝนรายวันระหว่างผลิตภัณฑ์น า้ฝนจากข้อมูล
ดาวเทยีมกับข้อมูลน า้ฝนภาคพืน้ดนิ พืน้ที่ภาคเหนือของประเทศไทย 

Comparative study of daily rainfall between rainfall products derived from 
satellite data and ground-based rainfall data over the Northern Thailand 

 
อภิษฐา   ยอดยิ่ง1*, นฐัพล   มหาวิค1  

Aphittha   Yodying1*, Nattapon   Mahavik1 
 

บทคัดย่อ 
การศึกษาครัง้นีมุ้่งวิเคราะห์การเปรียบเทียบปริมาณน า้ฝนรายวันระหว่างผลิตภัณฑ์

น า้ฝนจากข้อมูลดาวเทียม TRMM กับข้อมูลน า้ฝนภาคพืน้ดินจ านวน 78 สถานีของกรม
อตุนุิยมวิทยา พืน้ท่ีภาคเหนือของประเทศไทย ในปี พ.ศ. 2553 และ 2554 โดยใช้วิธีการทางสถิติ 
ไ ด้ แก่  Bias, Root Mean Square Difference (RMSD) , Mean Absolute Deviation (MAD) , 
Probability of Detection (POD), False Alarm Rate (FAR) และ Critical Success Index (CSI) 
ผลการศึกษาพบว่า ปริมาณน า้ฝนท่ีตรวจวัดด้วยดาวเทียมมีค่ามากกว่าฝนภาคพืน้ดินเป็นส่วน
ใหญ่ ซึ่งจะตา่งกนัตามปริมาณและความแรงของน า้ฝนท่ีเกิดขึน้ในแต่ละปี ในปีท่ีมีปริมาณน า้ฝน
มาก น า้ฝนท่ีตรวจวัดด้วยดาวเทียมจะมีค่ามากกว่าฝนภาคพืน้ดิน นอกจากนีพ้บว่าดาวเที ยม 
TRMM 3B42 V.7 ยงัมีความบกพร่องในการตรวจวดัปริมาณน า้ฝนขณะท่ีฝนตกหนกัในชว่งฤดฝูน  
ค าส าคัญ: ปริมาณน า้ฝน, ผลิตภณัฑ์น า้ฝน, TRMM 

 
Abstract 

This study aimed to analyze the comparison of daily rainfall between rainfall 
products derived from TRMM satellite data and ground-based rainfall over the 78 stations 
from Thai Meteorological Department over the Northern Thailand in year of 2010 and 2011. 
A set of statistics has been used in the evaluation of the rainfall product performance. 
Those statistics are Bias, Root Mean Square Difference (RMSD), Mean Absolute Deviation  

                                                                    
1 ภาควิชาทรัพยากรธรรมชาติและสิง่แวดล้อม คณะเกษตรศาสตร์ฯ มหาวิทยาลยันเรศวร จงัหวดัพิษณโุลก  
  65000                                                                
*Corresponding author : E-mail: aphit_yodying@hotmail.com 
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(MAD), Probability of Detection (POD), False Alarm Rate (FAR) and Critical Success Index 
( CSI) .  The study results indicated that the satellite- based rainfall mostly tends to 
overestimate the ground-based rainfall, which seem to vary according to the amount and 
intensity of rainfall in each year.  In a wet year, the satellite-based rainfall is greater than 
the ground-based rainfall. Moreover, it was found that TRMM 3B42 V.7 may underestimate 
of heavy rainfall events during rainy season.  
Keywords: Rainfall, Rainfall products, TRMM 
 
บทน า 

ปริมาณน า้ฝน เป็นข้อมูลทางอุตนุิยมวิทยาท่ีมีความส าคญั โดยน า้ฝนเป็นปัจจยัส าคญั
ในการด ารงชีวิตของมนษุย์ และข้อมลูปริมาณน า้ฝนยงัจ าเป็นตอ่การจดัการแหลง่น า้ การพยากรณ์
น า้ และการปอ้งกนัภยัพิบตัิ ส าหรับการตรวจวดัปริมาณน า้ฝนภาคพืน้ดินของกรมอตุนุิยมวิทยาใน
ประเทศไทย เป็นการตรวจวัดความสูงของน า้ฝนท่ีตกลงบนพืน้ท่ีด้วยเคร่ืองมือวัดปริมาณน า้ฝน            
ซึ่งข้อมลูท่ีวดัได้จะเป็นปริมาณน า้ฝนท่ีตกลงสู่พืน้ดินโดยตรง และเป็นข้อมลูเชิงจดุไม่สามารถเป็น
ตวัแทนบริเวณท่ีอยู่ไกลจากสถานีตรวจวดัได้ ท าให้ไม่ทราบการกระจายตวัของฝนได้อย่างแ ท้จริง 
ภาคเหนือมีลักษณะภูมิประเทศส่วนใหญ่เป็นเทือกเขาสูง ซึ่งเป็นข้อจ ากัดในการติดตัง้สถานีวัด
น า้ฝนจึงท าให้มีสถานีตรวจวัดน า้ฝนค่อนข้างน้อย และด้วยคุณลักษณะของดาวเทียมมี                    
ความครอบคลุมเชิงพืน้ท่ี จึงน า Tropical Rainfall Measuring Mission (TRMM) ซึ่งเป็นหนึ่งใน
ภารกิจท่ีมีประโยชน์เก่ียวกบัข้อมลูปริมาณน า้ฝนในประเทศเขตร้อนมาใช้  

ประเทศไทยอยู่ในเขตร้อนชืน้ใกล้เส้นศนูย์สตูรและอยู่ภายใต้อิทธิพลของลมมรสมุ ท าให้
มีฝนตกชุก ฤดูฝนยาวนาน มีความอุดมสมบูรณ์ในเร่ืองน า้ จะเข้าสู่ฤดูฝนประมาณกลางเดือน
พฤษภาคมจนถึงประมาณกลางเดือนตลุาคม โดยบริเวณประเทศไทยตอนบนปกติในฤดหูนาวจะ
แห้งแล้งและมีฝนน้อย เม่ือเข้าสูฤ่ดรู้อนปริมาณฝนจะเพิ่มขึน้บ้าง พร้อมทัง้มีพายฝุนฟ้าคะนอง และ
เม่ือเข้าสู่ฤดูฝนปริมาณฝนจะเพิ่มมากขึน้ โดยจะมีปริมาณฝนมากท่ีสุดในเดือนสิงหาคมหรือ
กนัยายน (สจุริต และคณะ, 2550) ข้อมลูปริมาณน า้ฝนภาคพืน้ดินจะเป็นปริมาณน า้ฝนท่ีตกลงสู่
พืน้ดินโดยตรง ท าให้คา่ท่ีได้มีความถกูต้องคอ่นข้างสงู แตป่ริมาณน า้ฝนท่ีได้เป็นข้อมลูของบริเวณ
ท่ีท าการตรวจวดัเท่านัน้ จะน าไปใช้ในบริเวณท่ีไกลออกไปจากสถานีวัดน า้ฝนไมไ่ด้ (สญัชยั, 2554) 
ดาวเทียมมีคุณลักษณะท่ีครอบคลุมพืน้ท่ีในบริเวณกว้าง การท่ีจะศึกษาพายุฝนและสภาพ
ภูมิอากาศในเขตร้อนนัน้ ท าให้เกิดความร่วมมือกันระหว่าง National Aeronautics Space 
Administration (NASA)  และ Japan Aerospace Exploration Agency (JAXA)  เ ป็นท่ีมาของ 
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Tropical Rainfall Measuring Mission (TRMM) (ศรินทร์ทิพย์, 2557) Chokngamwong and Chiu 
(2008) ศกึษาปริมาณน า้ฝนรายวนัของประเทศไทยและเปรียบเทียบด้วยผลิตภณัฑ์ TRMM พบว่า
จะเข้าสู่ฤดฝูนในเดือนพฤษภาคม จากนัน้ฝนจะเคล่ือนตวัจากตะวนัออกเฉียงใต้ไปตะวนัตกเ ฉียง
เหนือ ปริมาณน า้ฝนสูงสุดเกิดขึน้ในเดือนสิงหาคมในภาคเหนือและภาคตะวันออกเฉียงเหนือ           
เดือนกันยายนในภาคกลางและตะวันออก และเดือนพฤศจิกายนในภาคใต้ ในการเปรียบเทียบ
ปริมาณน า้ฝนจาก TRMM V.5 และ V.6 กับข้อมูลปริมาณน า้ฝนภาคพืน้ดิน พบว่า V.6 มีค่า
ใกล้เคียงกับข้อมูลปริมาณน า้ฝนภาคพืน้ดินมากกว่า V.5 และพบอีกว่าผลิตภัณฑ์น า้ฝนจาก
ดาวเทียมทัง้สองเวอร์ชัน่มีความบกพร่องในการตรวจวดัขณะมีฝนตกหนกั สถิตย์ (2558) น าข้อมลู
ฝนตรวจวดัด้วยดาวเทียมมาประยุกต์ใช้ เพ่ือเพิ่มประสิทธิภาพการท างานของระบบพยากรณ์น า้
ท่วมในลุ่มน า้ลุ่มน า้ ชี-มูล พบว่า TRMM ให้ค่าปริมาณน า้ฝนมากกว่า GSMaP และข้อมูลฝน
ตรวจวดัด้วยดาวเทียมทัง้ 2 ชดุมีแนวโน้มให้คา่ปริมาณน า้ฝนมากกวา่คา่ปริมาณน า้ฝนตรวจวดัจริง
จากสถานีภาคพืน้ดนิ การน าข้อมลูไปใช้จงึต้องมีความระมดัระวงัในการปรับแก้คา่  

การศึกษาวิจัยครัง้นีจ้ึงมีวัตถุประสงค์เพ่ือเปรียบเทียบปริมาณน า้ฝนรายวันระหว่าง
ผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียม TRMM 3B42 V.7 กับข้อมูลปริมาณน า้ฝนภาคพืน้ดินของ 
กรมอตุนุิยมวิทยา พืน้ท่ีภาคเหนือของประเทศไทย เพ่ือให้ทราบถึงความแตกตา่งของปริมาณน า้ฝน            
ซึ่งอาจเป็นแนวทางในการตดัสินใจส าหรับการจะน าผลิตภณัฑ์น า้ฝนไปใช้ในงานด้านการเกษตร 
และชลประทาน เป็นต้น 
 
วิธีการศึกษา 

การศึกษาครัง้นีไ้ด้เลือกศึกษาการเปรียบเทียบปริมาณน า้ฝนรายวนัระหว่างผลิตภัณฑ์
น า้ฝนจากข้อมูลดาวเทียมกับข้อมูลน า้ฝนภาคพืน้ดิน ในพืน้ท่ีภาคเหนือ ประกอบด้วย 9 จงัหวดั 
ได้แก่ เชียงราย น่าน พะเยา เชียงใหม่ แม่ฮ่องสอน แพร่ ล าปาง ล าพูน และอุตรดิตถ์ มีพืน้ท่ี
ประมาณ 93,691 ตารางกิโลเมตร โดยร้อยละ 70 ของพืน้ท่ีเป็นเทือกเขา มีความสูง 500-2,000 
เมตรจากระดบัน า้ทะเล ประกอบไปด้วยป่าไม้ซึ่งเป็นแหล่ง ต้นน า้ล าธาร มีปริมาณน า้ฝนเฉล่ีย 
1,230 มิลลิเมตร/ปี   

ดงัแสดงในภาพท่ี 1 นัน้ได้ท าการตรวจสอบและคดัเลือกข้อมลูจากปริมาณน า้ฝนรายวนั
ภาคพืน้ดินท่ีได้รับความอนุเคราะห์จากศูนย์อุตุนิยมวิทยาภาคเหนือ เพ่ือตดัสถานีวัดน า้ฝนท่ีมี
ความผิดปกตอิอก โดยท่ีถกูตดัออกมี 10 สถานี และท่ีใช้ในการศกึษามี 78 สถานี จะพบวา่ต าแหนง่
สถานีวดัน า้ฝนท่ีใช้ในการศึกษาส่วนใหญ่มีการกระจายตวัอยู่ในบริเวณท่ีไม่ใช่เทือกเขาสงู และมี
ความหนาแน่นคอ่นข้างน้อย เชียงใหมมี่สถานีวดัน า้ฝนมากท่ีสดุจ านวน 16 สถานี และน้อยท่ีสดุ 3 
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สถานีในล าพูน เป็นท่ีน่าสงัเกตว่าไม่มีสถานีวดัน า้ฝนครอบคลมุพืน้ท่ีกว้างในบางส่วนของจงัหวดั
ของแตล่ะจงัหวดั เช่น ตอนเหนือของล าปาง และด้านทิศตะวนัออกของพะเยา ซึ่งครอบคลมุพืน้ท่ี
อุทยานแห่งชาติดอยภูนาง และบริเวณเทือกเขาสูงหรือพืน้ท่ีป่าพบว่าไม่มีสถานีวัดน า้ฝน 
เน่ืองมาจากปัญหากระแสไฟฟ้าท่ีเข้าไม่ถึงและการดูแลรักษาท่ียากล าบาก ซึ่งการประยุกต์ใช้
ข้อมลูปริมาณน า้ฝนท่ีตรวจวดัด้วยดาวเทียมในบริเวณท่ีไม่มีสถานีวดัน า้ฝน จะท าให้ทราบปริมาณ
น า้ฝนบริเวณนัน้ๆ ได้ 

 

 
ภาพท่ี 1 แผนท่ีต าแหนง่สถานีวดัน า้ฝนในพืน้ท่ี 9 จงัหวดัภาคเหนือ ท่ีใช้ในการศกึษาและท่ีถกูตดั 
               ออก 
 

ต าแหน่งสถานีวัดน า้ฝนใช้ข้อมูลค่าพิกัดสถานีวัดน า้ฝนในพืน้ท่ี 9 จังหวัดภาคเหนือ                 
ซึ่งได้รับความอนเุคราะห์จากกรมอตุนุิยมวิทยา เป็นข้อมลูท่ีมีการเก็บรวบรวมไว้ในรูปแบบเอกสาร
จึงต้องมีการน าเข้าคา่พิกดัจากเอกสารเข้าสู่โปรแกรม Microsoft Excel เพ่ือน ามาแปลงเป็นข้อมลู
ท่ีสามารถใช้วิเคราะห์ได้ใน ระบบสารสนเทศภูมิศาสตร์ หรือ GIS ท่ีเป็นรูปแบบของ Point ก่อนจะ
น ามาสร้างเป็นแผนท่ี  
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ตารางท่ี 1 ข้อมลูและแหลง่ท่ีมา 

ข้อมูล ที่มา ช่วงปี พ.ศ. 
1. ปริมาณน า้ฝนรายวนัภาคพืน้ดนิ 
2. พิกดัสถานีวดัน า้ฝน 
3. ผลิตภณัฑ์น า้ฝนจากข้อมลู
ดาวเทียม TRMM 3B42 V.7 

ศนูย์อตุนุิยมวิทยาภาคเหนือ 
กรมอตุนุิยมวิทยา 

http://disc.sci.gsfc.nasa.gov/ 

2553-2554 
2553-2554 
2553-2554 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ภาพท่ี 2 ขัน้ตอนการเปรียบเทียบข้อมลูปริมาณน า้ฝนจากดาวเทียมกบัข้อมลูปริมาณน า้ฝน 
                   ภาคพืน้ดิน 
 

ดาวน์โหลดผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียม TRMM 3B42 V.7 จากนัน้สกัดข้อมูล
ปริมาณน า้ฝนรายวันจากผลิตภัณฑ์น า้ฝน ณ ต าแหน่งพิกัดสถานีวัดน า้ฝนท่ีใช้ในการศึกษา              
เพ่ือเปรียบเทียบข้อมูลปริมาณน า้ฝนจากดาวเทียมกับข้อมูลปริมาณน า้ฝนภาคพืน้ดินด้วยวิธีการ
ทางสถิต ิ3 สตูร ได้แก่ Bias, RMSD และ MAD เพ่ือเปรียบเทียบความนา่เช่ือถือของข้อมลู ดงันี ้ 

ข้อมลูปริมาณน า้ฝนรายวนัภาคพืน้ดิน
ของกรมอตุนุิยมวิทยา 

ข้อมลูปริมาณน า้ฝนรายวนัภาคพืน้ดิน
ที่คดัเลอืกแล้ว 

อภิปรายผลการศกึษา 

ข้อมลูปริมาณน า้ฝนรายวนัจากดาวเทยีม 

ตรวจสอบและคดัเลอืกข้อมลู 

เปรียบเทียบด้วยวิธีการทางสถิติ ได้แก่ 
1. Bias     4. Probability of Detection (POD)                                                                               
2. Root Mean Square Difference (RMSD) 5. False Alarm Rate (FAR)                                                    
3. Mean Absolute Deviation (MAD)  6. Critical Success Index (CSI) 

ผลติภณัฑ์น า้ฝนจากดาวเทียม 

สกดัข้อมลู ณ ต าแหนง่พิกดัสถานีวดั
น า้ฝน 
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Bias =                  , RMSD =                         และ  MAD   = 
 

xi คือ คา่ปริมาณน า้ฝนจากดาวเทียม (มิลลิเมตร), TGi คือ คา่ปริมาณน า้ฝนภาคพืน้ดนิ (มิลลิเมตร) 
และ n คือ จ านวนตวัอย่าง และเปรียบเทียบอีก 3 สตูร ได้แก่ POD, FAR, CSI เพ่ือวดัคณุภาพของ
ผลิตภณัฑ์น า้ฝน ดงันี ้POD   =   A/(A+B) ,  FAR   =   C/(A+C)  และ  CSI   =   A/(A+B+C) 
A คือ ฝนรายวนัจากดาวเทียมท่ีประมาณการว่ามีฝนถูกต้อง , B คือ กรมอตุนุิยมวิทยาระบวุ่ามีฝน 
แต่ดาวเทียมระบุว่าไม่มีฝน และ C คือ ดาวเทียมประมาณการไม่ถูกต้อง ระบุว่ามีฝน แต่ไม่มีฝน
เกิดขึน้ 
 
ผลการศึกษา 

จากการค านวณทางสถิติเพ่ือเปรียบเทียบความน่าเช่ือถือของข้อมลู แยกเป็นรายจงัหวดั
โดยใช้ปริมาณน า้ฝนรายวนั พบว่าปี พ.ศ. 2553 Bias, RMSD และ MAD มีค่า 0.07, 10.89 และ 
4.41 มิลลิเมตร ตามล าดับ เป็นค่าท่ีน้อยท่ีสุด และมีค่า 0.41, 14.24 และ 6.08 มิลลิเมตร 
ตามล าดบั เป็นคา่ท่ีมากท่ีสดุ ดงัตารางท่ี 2 โดยคา่ท่ีน้อยท่ีสดุหมายถึงปริมาณน า้ฝนท่ีตรวจวดัด้วย
ดาวเทียมกบัฝนภาคพืน้ดินมีความคลาดเคล่ือนกนัน้อยในล าปาง, เชียงใหม ่และล าพนู ตามล าดบั 
ตรงกนัข้ามกบัคา่ท่ีมากท่ีสดุจะหมายถึงมีความคลาดเคล่ือนกนัมากในล าพนู, เชียงราย และพะเยา 
ตามล าดบั เช่นเดียวกับปี พ.ศ. 2554 ดงัตารางท่ี 3 จะพบว่า Bias, RMSD และ MAD มีค่า 0.18, 
12.22 และ 5.71 มิลลิเมตร ตามล าดบั เป็นคา่ท่ีน้อยท่ีสดุ แสดงว่ามีความคลาดเคล่ือนกนัน้อยใน
แพร่, เชียงใหม่ และล าพนู ส่วนคา่ท่ีมากท่ีสดุเท่ากบั 1.14, 15.22 และ 6.98 มิลลิเมตร ตามล าดบั 
แสดงวา่มีความคลาดเคล่ือนกนัมากในล าพนู และนา่น (มีคา่ RMSD กบั MAD มากท่ีสดุ) 
 

ตารางท่ี 2 Bias, RMSD และ MAD ของ 9 จงัหวดัภาคเหนือ ปี พ.ศ. 2553 (มิลลิเมตร) 
  รวม แมฮ่่องสอน เชียงราย พะเยา เชียงใหม ่ ล าปาง ล าพนู แพร่ น่าน อตุรดติถ์ 

Bias 
RMSD 
MAD 

0.22 
12.19 
5.19 

0.36 
11.22 
4.75 

0.12 
14.24 
6.05 

0.36 
13.58 
6.08 

0.28 
10.89 
4.84 

0.07 
11.30 
4.78 

0.41 
10.94 
4.41 

0.18 
11.13 
4.42 

0.20 
12.85 
5.57 

0.34 
12.85 
5.06 

 
ตารางท่ี 3 Bias, RMSD และ MAD ของ 9 จงัหวดัภาคเหนือ ปี พ.ศ. 2554 (มิลลิเมตร) 

  รวม แมฮ่่องสอน เชียงราย พะเยา เชียงใหม ่ ล าปาง ล าพนู แพร่ น่าน อตุรดติถ์ 

Bias 
RMSD 
MAD 

0.48 
13.63 
6.24 

0.20 
13.09 
6.29 

0.27 
13.70 
6.19 

0.23 
14.84 
6.85 

0.35 
12.22 
5.80 

0.89 
13.10 
5.94 

1.14 
12.39 
5.71 

0.18 
14.97 
6.41 

0.23 
15.22 
6.98 

1.03 
14.37 
6.48 
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เม่ือค านวณโดยใช้ปริมาณน า้ฝนสะสมรายเดือนดงัตารางท่ี 4 พบว่าปี พ.ศ. 2553 Bias, 
RMSD และ MAD มีคา่ -0.19, 7.77 และ 2.18 มิลลิเมตร ตามล าดบั เป็นคา่ท่ีน้อยท่ีสดุ แสดงว่ามี
ความคลาดเคล่ือนกนัน้อยในเดือนมกราคม, พฤศจิกายน และกมุภาพนัธ์ ตามล าดบั และมีคา่มาก
ท่ีสุดเท่ากับ 29.90, 116.34 และ 91.33 ตามล าดบั แสดงว่ามีความคลาดเคล่ือนกันมากในเดือน
กรกฎาคม และสิงหาคม (มีคา่ RMSD กบั MAD มากท่ีสดุ) โดยจะสงัเกตเห็นว่า Bias มีทัง้คา่บวก
และลบ ซึ่งคา่ท่ีติดลบหมายถึงปริมาณน า้ฝนท่ีตรวจวดัด้วยดาวเทียมมีค่าน้อยกว่าฝนภาคพืน้ดิน
ได้แก่ มกราคม, กุมภาพันธ์, มีนาคม, สิงหาคม, พฤศจิกายน และธันวาคม เช่นเดียวกับปี พ.ศ. 
2554 Bias, RMSD และ MAD มีค่าน้อยท่ีสุดเท่ากับ -0.91, 3.49 และ 1.41 มิลลิเมตร ตามล าดบั 
แสดงวา่มีความคลาดเคล่ือนกนัน้อยในเดือนธันวาคมทัง้หมด และมีคา่ 59.38, 110.49 และ 89.35 
มิลลิเมตร ตามล าดบั เป็นค่าท่ีมากท่ีสุด แสดงว่ามีความคลาดเคล่ือนกันมากในเดือนกันยายน
ทัง้หมด โดย Bias ท่ีมีคา่ตดิลบ ได้แก่ มกราคม, สิงหาคม, ตลุาคม, พฤศจิกายน และธนัวาคม 

 
ตารางท่ี 4 Bias, RMSD และ MAD เฉล่ียทัง้ 78 สถานี ในปี พ.ศ. 2553 และ 2554 (มิลลิเมตร) 

เดือน Bias RMSD MAD 
2553 2554 2553 2554 2553 2554 

มกราคม -0.19 -4.15 22.27 10.44 17.81 6.76 
กุมภาพันธ์ -2.00 11.24 14.03 16.87 2.18 11.52 
มีนาคม -1.10 3.11 17.30 33.18 11.65 23.61 
เมษายน 11.14 32.09 25.38 59.39 18.96 48.12 
พฤษภาคม 15.37 20.60 52.70 75.48 40.33 59.42 
มิถุนายน 11.19 49.53 55.83 82.88 44.63 65.54 
กรกฎาคม 29.90 33.90 91.78 90.67 74.39 74.70 
สิงหาคม -21.45 -2.59 116.34 104.79 91.33 87.99 
กันยายน 28.76 59.38 85.46 110.49 67.73 89.35 
ตุลาคม 18.91 -24.36 55.03 61.74 43.82 46.38 

พฤศจิกายน -1.16 -1.00 7.77 10.88 1.18 7.21 
ธันวาคม -8.96 -0.91 18.97 3.49 12.94 1.41 

ดงัแสดงในภาพท่ี 3 พบวา่คา่กระจายตวัเชิงพืน้ท่ีของ Bias มีทัง้คา่ลบและบวก สว่นใหญ่
จะพบว่าเป็นค่าบวกโดยมีจ านวน 50 และ 55 สถานีในปี พ.ศ. 2553 และ 2554 ตามล าดบั ในปี 
พ.ศ. 2553 พบว่า Bias ค่าลบมีค่าเข้าใกล้ศูนย์อยู่ในช่วง 0-200 มิลลิเมตร จ านวน 16 สถานี                    
ซึ่งมากกว่าปี พ.ศ. 2554 แสดงถึงปริมาณฝนจากดาวเทียมมีค่าน้อยกว่าฝนภาคพืน้ดิน และยัง
พบวา่ปี พ.ศ. 2554 มี Bias คา่บวกท่ีมากกวา่ 600 มิลลิเมตรถึง 10 สถานี โดยอยูใ่นเขตลุม่น า้วงั 
ของจงัหวดัล าปาง และลุม่น า้สาขาของล าน า้นา่นในจงัหวดัอตุรดติถ์ 
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ส าหรับการค านวณทางสถิติเพ่ือวดัคณุภาพผลิตภัณฑ์น า้ฝนจะแยกเป็นช่วงเดือน โดย
ผลิตภัณฑ์น า้ฝนท่ีมีคณุภาพดีจะมี POD = 1, FAR = 0 และ CSI = 1 จากการค านวณทัง้ 3 สูตร 
ดังตารางท่ี 5 พบว่าปี พ.ศ. 2553 ผลิตภัณฑ์น า้ฝนมีคุณภาพดีท่ีสุดในช่วงเดือนธันวาคม -
กมุภาพนัธ์ ซึง่เป็นชว่งเดียวกบัปี พ.ศ. 2554 โดย FAR และ CSI ของทัง้ 2 ปี แทบไมต่า่งกนั และไม่
คอ่ยมีคณุภาพในชว่งเดือนมิถนุายน-สิงหาคมเช่นเดียวกนัอีก แตปี่ พ.ศ. 2553 ตามคา่ POD จะอยู่
ชว่งเดือนกนัยายน-พฤศจิกายน  

 
อภปิรายผลการศึกษา 

การเปรียบเทียบข้อมลูปริมาณน า้ฝนจากดาวเทียมกบัฝนภาคพืน้ดินแยกเป็นรายจงัหวดั 
โดยใช้ปริมาณน า้ฝนรายวนัพบวา่ปี พ.ศ. 2553 Bias, RMSD และ MAD เม่ือเทียบกบัปี พ.ศ. 2554 
แสดงให้เห็นว่าปี พ.ศ. 2553 ข้อมลูมีความน่าเช่ือถือมากกว่า แต ่Bias ท่ีมีคา่น้อยท่ีสดุอยู่ท่ีล าปาง
ในปี พ.ศ. 2553 และอยูท่ี่แพร่ในปี พ.ศ. 2554 สว่น RMSD และ MAD มีคา่น้อยท่ีสดุอยู่ท่ีเชียงใหม่ 
และล าพนู ตามล าดบัเชน่เดียวกนั และเม่ือใช้ปริมาณน า้ฝนสะสมรายเดือนโดยน าทัง้ 3 สตูรเดมิมา
ค านวณจะพบว่าทัง้ 2 ปี ข้อมูลมีความน่าเช่ือถือในเดือนมกราคม, กุมภาพนัธ์, พฤศจิกายน และ
ธันวาคม ซึ่งเป็นเดือนท่ีไม่ค่อยมีฝนอยู่แล้ว และเม่ือมุ่งไปท่ีค่า Bias พบ ว่าฝนท่ีตรวจวัดด้วย
ดาวเทียม TRMM 3B42 V.7 ตรวจวดัปริมาณน า้ฝนได้สงูกว่าฝนภาคพืน้ดนิหลายเดือน โดยปี พ.ศ. 
2554 คา่ความตา่งในแต่ละเดือนค่อนข้างสงูกว่าปี พ.ศ. 2553 อีกทัง้ Bias ท่ีมีคา่ติดลบจะเกิดขึน้
ในชว่งท่ีไมใ่ชฤ่ดฝูน ยกเว้นเดือนสิงหาคม และตลุาคม เชน่เดียวกบัการค านวณเฉพาะคา่ Bias โดย
ใช้ปริมาณน า้ฝนสะสมรายปี ท าให้พบว่าปริมาณน า้ฝนท่ีตรวจวดัด้วยดาวเทียมมีค่ามากกว่าฝน
ภาคพืน้ดนิ ในสว่นการค านวณทางสถิตเิพ่ือวดัคณุภาพผลิตภณัฑ์น า้ฝนจะพบวา่ทัง้ 2 ปี ผลิตภณัฑ์
น า้ฝนมีคณุภาพดีท่ีสดุในชว่งเดือนธนัวาคม-กมุภาพนัธ์ ซึง่ชว่งนีไ้มค่อ่ยมีฝนอยูแ่ล้ว ในทางกลบักนั
จะไม่ค่อยมีคุณภาพในช่วงเดือนมิถุนายน-สิงหาคม ซึ่งเป็นช่วงฤดูฝนมีปริมาณน า้ฝนมาก จาก
งานวิจยัของ Chokngamwong and Chiu (2008) จะพบวา่การเปรียบเทียบ TRMM 3B42 V.5 และ 
V.6 โดยใช้ข้อมูลปริมาณน า้ฝน 5 ปี ผลิตภัณฑ์น า้ฝนมีคณุภาพดีในช่วงเดือนมิถุนายน-สิงหาคม 
ผลท่ีได้พบว่าผลิตภัณฑ์น า้ฝนมีคุณภาพดีในช่วงเดือนท่ีต่างกับงานวิจัยนี ้แต่ผลค านวณ  POD, 
FAR และ CSI ในชว่งเดือนมิถนุายน-สิงหาคม แม้ในงานวิจยันีจ้ะเป็นชว่งท่ีผลิตภณัฑ์น า้ฝนไม่ค่อย
มีคณุภาพ แต่ก็ถือว่าผลิตภัณฑ์น า้ฝนมีคณุภาพดีเม่ือเปรียบเทียบกัน ท าให้เห็นว่า TRMM 3B42 
V.7 มีการพฒันาอลักอริทึมให้มีประสิทธิภาพมากยิ่งขึน้ ซึ่งในงานวิจยัครัง้ต่อไปควรจะใช้ข้อมูล
ปริมาณน า้ฝน 5 ปี เป็นอย่างน้อยจะท าให้ผลลพัธ์มีความน่าเช่ือถือมากยิ่งขึน้ และน าผลิตภัณฑ์
น า้ฝนแตล่ะเวอร์ชัน่มาเปรียบเทียบกนัเพ่ือให้เห็นความแตกตา่ง 
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ภาพท่ี 3 แผนท่ี Bias จากปริมาณน า้ฝนสะสมรายปี (มิลลิเมตร) ในพืน้ท่ี 9 จงัหวดัภาคเหนือ (a)  
                พ.ศ. 2553 และ (b) พ.ศ. 2554 
 

ตารางท่ี 5 POD, FAR และ CSI ของ TRMM 3B42 V.7 
พ.ศ. 2553  รวม ธ.ค.-ก.พ.  มี.ค.-พ.ค. มิ.ย.-ส.ค. ก.ย.-พ.ย. 

POD 
FAR 
CSI 

0.90 
0.19 
0.75 

0.95 
0.04 
0.92 

0.91 
0.19 
0.76 

0.86 
0.34 
0.59 

0.88 
0.20 
0.74 

พ.ศ. 2554  รวม ธ.ค.-ก.พ.  มี.ค.-พ.ค. มิ.ย.-ส.ค. ก.ย.-พ.ย. 
POD 
FAR 
CSI 

0.88 
0.22 
0.71 

0.97 
0.04 
0.93 

0.86 
0.30 
0.63 

0.81 
0.35 
0.56 

0.87 
0.18 
0.74 

 
สรุปผลการศึกษาและข้อเสนอแนะ 

จากการวิเคราะห์การเปรียบเทียบข้อมูลผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียมกับข้อมูล
น า้ฝนภาคพืน้ดนิ พบวา่ผลการค านวณ Bias, RMSD และ MAD มีคา่แตกตา่งกนัไปในแตล่ะปีตาม
ปริมาณน า้ฝน ซึ่งโดยส่วนใหญ่ปริมาณน า้ฝนท่ีตรวจวดัด้วยดาวเทียมมีค่ามากกว่าฝนภาคพืน้ดิน 
เม่ือเปรียบเทียบแล้วความแตกตา่งของปริมาณน า้ฝนจะมีคา่มากในปี พ.ศ. 2554 ซึง่ในปีนีป้ระเทศ
ไทยประสบกบัปัญหาน า้ทว่มครัง้ใหญ่ และในปี พ.ศ. 2553 ปริมาณน า้ฝนท่ีตรวจวดัด้วยดาวเทียม
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กับฝนภาคพืน้ดินมีค่าใกล้เคียงกัน ส่วนผลการค านวณ  POD, FAR และ CSI จะพบว่าผลิตภณฑ์
น า้ฝนมีคณุภาพดีในช่วงท่ีไม่ใช่ฤดฝูน ซึ่งไม่ค่อยมีฝนเกิดขึน้อยู่แล้ว งานวิจยัครัง้นีไ้ม่ได้วิเคราะห์
ปัจจยัทางกายภาพท่ีส่งผลตอ่การเกิดฝน หากมีการวิเคราะห์จะท าให้เข้าใจสาเหตขุองการเกิดฝน
และปริมาณน า้ฝนท่ีมีในแต่ละปีได้มากยิ่งขึน้ นอกจากนัน้ควรมีการศึกษาปริมาณน า้ฝนรายวนัท่ี
เป็นสาเหตขุองการเกิดน า้ทว่ม เพ่ือตรวจสอบคณุภาพการวดัปริมาณน า้ฝนของดาวเทียม TRMM 

 
กิตตกิรรมประกาศ 
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จากข้อมูลดาวเทียม TRMM อันเป็นประโยชน์ต่องานวิทยานิพนธ์ระดับปริญญาตรี หลักสูตร
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กศ.ม., สถาบนับณัฑิตพฒันบริหารศาสตร์, กรุงเทพมหานคร. 

สุจริต คณูธนกุลวงศ์, วิรัช ฉัตรดรงค์ และอรอนงค์ วรรณราช. (2550). การประเมินและพยากรณ์
น า้ฝนจากข้อมูลระยะไกล. หน่วยปฏิบัติการวิจัยระบบการจัดการแหล่งน า้ คณะ

วิศวกรรมศาสตร์ จุฬาลงกรณ์มหาวิทยาลัย, 1-64. 
Chokngamwong, R.  and Chiu, S.  L.  (2008) .  Thailand daily rainfall and comparison with 

TRMM products. Journal of Hydrometeorology, 9, 256-266. 
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ผลงานตีพมิพ์ 
อภิษฐา ยอดยิ่ง และนัฐพล มหาวิค. (2559). การเปรียบเทียบปริมาณน า้ฝนรายวัน            

ระหว่างผลิตภัณฑ์น า้ฝนจากข้อมูลดาวเทียมกับข้อมูลน า้ฝนภาคพืน้ดิน พืน้ท่ีภาคเหนือของ
ประเทศไทย. ประชุมวิชาการทรัพยากรธรรมชาติ สารสนเทศภูมิศาสตร์ และสิ่งแวดล้อมนเรศวร 
ครัง้ท่ี 1 (3 พฤศจิกายน พ.ศ. 2559), หน้า 25-32. 
 
กิจกรรมที่เข้าร่วม 

1)  เข้าร่วมอบรมการประยุกต์ใช้ข้อมูลอุตุนิยมวิทยา ข้อมูลพยากรณ์อากาศเชิงตวัเลข 
และข้อมูลส ารวจระยะไกล เพ่ือเฝ้าระวังติดตามและการเตือนภัยน า้ท่วม ระหว่างวันท่ี 25-26 
สิงหาคม 2559 ณ คณะวิศวกรรมศาสตร์ มหาวิทยาลยันเรศวร 

2)  เข้าร่วมอบรมหลกัสตูรภาษาองักฤษ Grammar Overview ประจ าเดือนกนัยายน 2559 
ณ สถานพฒันาวิชาการด้านภาษา มหาวิทยาลยันเรศวร 

3)   เ ข้ า ร่ วมอบรมหลักสูตรภาษาอังกฤษ Cambridge English Placement Test 
Preparation, Listening Skill Practice for Test Preparation และ Leisure Reading ประจ าเดือน
ตลุาคม 2559 ณ สถานพฒันาวิชาการด้านภาษา มหาวิทยาลยันเรศวร 

ประวัตผู้ิวิจัย 
 

ช่ือ – ช่ือสกุล อภิษฐา   ยอดยิ่ง  
วัน  เดือน  ปี เกิด 8  ธนัวาคม  2537 
ท่ีอยู่ปัจจุบัน 24  หมู ่7  ต าบล บ้านปิน  อ าเภอ  

ดอกค าใต้  จงัหวดั พะเยา 56120  
ประวัตกิารศึกษา  

 พ.ศ. 2556-ปัจจบุนั วท.บ. (ภมูิศาสตร์)  มหาวิทยาลยันเรศวร  เกรดเฉล่ีย 3.22 
 พ.ศ. 2550-2555 ระดบัมธัยมศกึษา (วิทย์-คณิต)  โรงเรียนพะเยาพิทยาคม  ต าบล 

ทา่วงัทอง  อ าเภอ เมือง จงัหวดั พะเยา  56000  เกรดเฉล่ีย 3.50 
 พ.ศ. 2544-2549 ระดบัประถมศกึษา  โรงเรียนอนบุาลพะเยา  ต าบล เวียง  อ าเภอ 

เมือง  จงัหวดั พะเยา  56000   
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กิจกรรมที่เข้าร่วม (ต่อ) 
4)  เข้าร่วมบรรยายการประชุมวิชาการ “ทรัพยากรธรรมชาติ สารสนเทศภูมิศาสตร์ และ

สิ่งแวดล้อม” ครัง้ท่ี 1 ในวนัท่ี 3 พฤศจิกายน 2559 ณ คณะเกษตรศาสตร์ ทรัพยากรธรรมชาติ และ
สิ่งแวดล้อม มหาวิทยาลยันเรศวร 

5)  เป็นผู้ ช่วยสอนภาคปฏิบตัิการในรายวิชาโฟโตแกรมเมตรี  (104331) ของ ดร.นัฐพล 
มหาวิค ประจ าภาคการศึกษาท่ี 1 ปีการศึกษา 2559 ระหว่างวนัท่ี 29-30 ตลุาคม 2559 ณ คณะ
เกษตรศาสตร์ ทรัพยากรธรรมชาติ และสิ่งแวดล้อม มหาวิทยาลยันเรศวร 
 
รางวัลที่ได้รับ 
 เกียรติบตัรผู้ มีผลการการเรียนดี สาขาวิชาภูมิศาสตร์ ในวนัท่ี 8 กนัยายน 2559 ณ อาคาร
ขวญัเมือง มหาวิทยาลยันเรศวร 
 
 
 
 
 

 


